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About Digi XBee Industrial Gateway

Digi XBee® Industrial Gateway provides a rugged, programmable gateway solution to connect
networks of XBee-enabled devices to IP networks in industrial environments, which potentially have
more extreme conditions, such as wide temperature and humidity variations.
With a simple, open-source Python™ development environment, this gateway enables custom
applications to run locally while interfacing across existing Ethernet and cellular networks for WAN
connectivity to cloud-based software applications. Automatic WAN failover functionality ensures
mission-critical data always reaches its destination. XBee Industrial Gateway Ethernet and Cellular
(GSM\LTE) models are available.
The XBee Industrial Gateway contains the XBee ZigBee product.
You can manage XBee Industrial Gateway products remotely via Digi Remote Manager®. Remote
Manager allows users to remotely manage thousands of deployed devices, supporting features like
remote firmware upgrades and event alarms.

XBee Industrial Gateway Cellular model XBee Industrial Gateway Ethernet
model

This guide describes how to get started with your XBee Industrial Gateway. This guide is intended for
a developer or programmer. It covers the following information:

n Hardware

n Get started

n Set up your XBee Industrial Gateway

n Administration and maintenance tasks

n About programming

n Program XBee Industrial Gateway using Python

Digi XBee Industrial Gateway 9
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n Configure XBee Industrial Gateway

n Configure XBee network settings

n Learn more about XBee Industrial Gateway

n Troubleshoot your XBee Industrial Gateway

Regulatory information and certifications

RF exposure statement
In order to comply with RF exposure limits established in the ANSI C95.1 standards, for all models
except XGI-20CZ7-EU7-W0 the distance between the antenna or antennas and the user should not be
less than 20 cm. For the model XGI-20CZ7-EU7-W0 the distance should not be less than 23 cm.

FCC certifications and regulatory information (USA only)
FCC Part 15 Class B
Radio Frequency Interface (RFI) (FCC 15.105)
This device has been tested and found to comply with the limits for Class B digital devices pursuant to
Part 15 Subpart B, of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential environment. This equipment generates, uses, and can
radiate radio frequency energy, and if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try and correct the interference by one or more of the following
measures:

n Reorient or relocate the receiving antenna.

n Increase the separation between the equipment and receiver.

n Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

n Consult the dealer or an experienced radio/TV technician for help.

Labeling Requirements (FCC 15.19)
This device complies with Part 15 of FCC rules. Operation is subject to the following two conditions: (1)
this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.
If the FCC ID is not visible when installed inside another device, then the outside of the device into
which the module is installed must also display a label referring to the enclosed module FCC ID.
Modifications (FCC 15.21)
Changes or modifications to this equipment not expressly approved by Digi may void the user’s
authority to operate this equipment.

Declaration of Conformity (DoC)
Digi has issued Declarations of Conformity for the XBee Industrial Gateway concerning emissions,
EMC, and safety. For more information, see www.digi.com/resources/certifications.
Important note

http://www.digi.com/resources/certifications
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Digi customers assume full responsibility for learning and meeting the required guidelines for each
country in their distribution market. Refer to the radio regulatory agency in the desired countries of
operation for more information.

CE mark (Europe)
The XBee Industrial Gateway is certified for use in several European countries. For information, visit
www.digi.com/resources/certifications.
If the XBee Industrial Gateway is incorporated into a product, the manufacturer must ensure
compliance of the final product with articles 3.1a and 3.1b of the RE Directive (Radio Equipment
Directive). A Declaration of Conformity must be issued for each of these standards and kept on file as
described in the RE Directive.
Furthermore, the manufacturer must maintain a copy of the XBee Industrial Gateway user manual
documentation and ensure the final product does not exceed the specified power ratings, antenna
specifications, and/or installation requirements as specified in the user manual. If any of these
specifications are exceeded in the final product, a submission must be made to a notified body for
compliance testing to all required standards.
OEM labeling requirements
The CE marking must be affixed to a visible location on the OEM product.
CE labeling requirements

The CE mark shall consist of the initials “CE” taking the following form:
n If the CE marking is reduced or enlarged, the proportions given in the above graduated

drawing must be respected.

n The CE marking must have a height of at least 5 mm except where this is not possible on
account of the nature of the apparatus.

n The CE marking must be affixed visibly, legibly, and indelibly.

Industry Canada (IC) certifications
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of

http://www.digi.com/resources/certifications
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Communications.
This device complies with Industry Canada’s licence-exempt RSSs. Operation is subject to the
following two conditions:
(1) This device may not cause interference; and
(2) This device must accept any interference, including interference that may cause undesired
operation of the device.
Le présent appareil numerique n’emet pas de bruits radioelectriques depassant les limites applicables
aux appareils numeriques de la class B prescrites dans le Reglement sur le brouillage radioelectrique
edicte par le ministere des Communications du Canada.
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts
de licence. L'exploitation est autorisée aux deux conditions suivantes:
(1) l'appareil ne doit pas produire de brouillage, et
(2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage
est susceptible d'en compromettre le fonctionnement.

Safety instructions

Safety instructions

XBee adapter, gateways, and routers
n The XBee Adapter, Gateway, or Router products cannot be guaranteed operation due to the

radio link and so should not be used for interlocks in safety critical devices such as machines or
automotive applications.

n The XBee Adapter, Gateway, or Router products have not been approved for use in (this list is
not exhaustive):

l medical devices

l nuclear applications

l explosive or flammable atmospheres

n There are no user serviceable components inside the XBee Adapter, Gateway, or Router
product. Do not remove the product covers or modify the Gateway or Router in any way.
Modifications may exclude the product from any warranty and can cause the gateway or router
to operate outside of regulatory compliance for a given country, leading to the possible illegal
operation of the product.

n Use industry standard ESD protection when handling the XBee Adapter, Gateway, or Router
product.

n Take care while handling to avoid electrical damage to the PCB and components.

n Do not expose the XBee Adapter, Gateway, or Router products to water or moisture.

n Use this product with the antennas specified in the XBee Adapter, Gateway, or Router product
user guides.
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n The end user must be told how to remove power from the XBee Adapter, Gateway, or Router
product or to locate the antennas 20 cm from humans or animals.

Инструкции за безопасност

XBee адаптер, шлюзове и рутери
n Продуктите XBee Adapter, Gateway или Router не могат да бъдат гарантирани за работа

поради радиовръзката и затова не трябва да се използват за блокировки в устройства,
които са важни за безопасността, като машини или автомобилни приложения.

n Продуктите XBee Adapter, Gateway или Router не са одобрени за използване в (този
списък не е изчерпателен):

l медицински изделия

l ядрени приложения

l експлозивна или запалима атмосфера

n Впродукта XBee Adapter, Gateway или Router няма компоненти, които могат да бъдат
обслужвани от потребителя. Не сваляйте капаците на продукта и не модифицирайте по
никакъв начиншлюза или рутера. Модификациите могат да изключат продукта от
гаранция и могат да доведат до работа нашлюза или рутера извън регулаторното
съответствие за дадена държава, което води до възможна незаконна работа на продукта.

n Използвайте стандартна ESD защита, когато работите с XBee адаптер, шлюз или рутер.

n Внимавайте, докато боравите, за да избегнете електрически повреди на печатната
платка и компонентите.

n Не излагайте продуктите XBee Adapter, Gateway или Router на вода или влага.

n Използвайте този продукт с антените, посочени в ръководствата за потребителя на XBee
Adapter, Gateway или Router.

n Крайният потребител трябва да бъде казано как да премахне захранването от XBee
Adapter, Gateway или Router продукта или да разположи антените на 20 смот хора или
животни.

Sigurnosne upute

XBee adapter, pristupnici i usmjerivači
n Ne može se jamčiti rad proizvoda XBee Adapter, Gateway ili Router zbog radio veze i stoga se

ne bi trebali koristiti za blokade u sigurnosnim kritičnim uređajima kao što su strojevi ili
automobilske aplikacije.
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n XBee Adapter, Gateway ili Router proizvodi nisu odobreni za upotrebu u (ovaj popis nije
konačan):

l medicinskih uređaja

l nuklearne primjene

l eksplozivne ili zapaljive atmosfere

n Unutar proizvoda XBee Adapter, Gateway ili Router nema komponenti koje može servisirati
korisnik. Nemojte skidati poklopce proizvoda niti na bilo koji način mijenjati pristupnik ili
usmjerivač. Izmjene mogu isključiti proizvod iz bilo kakvog jamstva i mogu uzrokovati rad
pristupnika ili usmjerivača izvan usklađenosti s propisima za određenu zemlju, što može
dovesti do mogućeg nezakonitog rada proizvoda.

n Koristite standardnu ESD zaštitu pri rukovanju proizvodom XBee Adapter, Gateway ili Router.

n Budite oprezni tijekom rukovanja kako biste izbjegli električna oštećenja PCB-a i komponenti.

n Ne izlažite XBee Adapter, Gateway ili Router proizvode vodi ili vlazi.

n Koristite ovaj proizvod s antenama navedenim u korisničkim vodičima proizvoda XBee Adapter,
Gateway ili Router.

n Krajnjem korisniku se mora reći kako da isključi napajanje iz XBee adaptera, Gatewaya ili
Routera proizvoda ili da locira antene 20 cm od ljudi ili životinja.

Bezpečnostní instrukce

XBee adaptér, brány a routery
n U produktů XBee Adapter, Gateway nebo Router nelze zaručit provoz kvůli rádiovému spojení,

a proto by neměly být používány pro blokování v zařízeních kritických z hlediska bezpečnosti,
jako jsou stroje nebo automobilové aplikace.

n Produkty XBee Adapter, Gateway nebo Router nebyly schváleny pro použití v (tento seznam
není vyčerpávající):

l zdravotnické prostředky

l jaderné aplikace

l výbušné nebo hořlavé atmosféry

n Uvnitř produktu XBee Adapter, Gateway nebo Router nejsou žádné uživatelsky opravitelné
součásti. Neodstraňujte kryty produktu ani žádným způsobem neupravujte bránu nebo
směrovač. Úpravy mohou vyjmout produkt z jakékoli záruky a mohou způsobit, že brána nebo
router bude fungovat mimo zákonnou shodu pro danou zemi, což povede k možnému
nezákonnému provozu produktu.

n Při manipulaci s produktem XBee Adapter, Gateway nebo Router používejte standardní
ochranu ESD.
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n Při manipulaci buďte opatrní, aby nedošlo k elektrickému poškození desky plošných spojů a
součástí.

n Nevystavujte produkty XBee Adapter, Gateway nebo Router vodě nebo vlhkosti.

n Používejte tento produkt s anténami uvedenými v uživatelské příručce produktu XBee Adapter,
Gateway nebo Router.

n Koncový uživatel musí být informován, jak odpojit napájení XBee adaptéru, brány nebo routeru
nebo jak umístit antény 20 cm od lidí nebo zvířat.

Sikkerhedsinstruktioner

XBee-adapter, gateways og routere
n XBee Adapter-, Gateway- eller Router-produkterne kan ikke garanteres drift på grund af

radioforbindelsen og bør derfor ikke bruges til aflåsninger i sikkerhedskritiske enheder såsom
maskiner eller bilapplikationer.

n XBee Adapter, Gateway eller Router-produkter er ikke blevet godkendt til brug i (denne liste er
ikke udtømmende):

l medicinsk udstyr

l nukleare applikationer

l eksplosive eller brandfarlige atmosfærer

n Der er ingen komponenter, der kan repareres af brugeren, inde i XBee Adapter-, Gateway- eller
Router-produktet. Fjern ikke produktdækslerne, og modificer ikke gatewayen eller routeren på
nogen måde. Ændringer kan udelukke produktet fra enhver garanti og kan få gatewayen eller
routeren til at fungere uden for lovgivningsoverholdelse for et givet land, hvilket kan føre til en
mulig ulovlig drift af produktet.

n Brug industristandard ESD-beskyttelse, når du håndterer XBee Adapter-, Gateway- eller
Router-produktet.

n Vær forsigtig under håndteringen for at undgå elektrisk beskadigelse af printet og
komponenterne.

n Udsæt ikke XBee Adapter, Gateway eller Router-produkter for vand eller fugt.

n Brug dette produkt med de antenner, der er specificeret i brugervejledningerne til XBee
Adapter, Gateway eller Router.

n Slutbrugeren skal fortælles, hvordan man fjerner strømmen fra XBee Adapter-, Gateway- eller
Router-produktet eller placerer antennerne 20 cm fra mennesker eller dyr.



About Digi XBee Industrial Gateway Safety instructions

Digi XBee Industrial Gateway 16

Veiligheidsinstructies

XBee-adapter, gateways en routers
n De werking van de XBee-adapter-, gateway- of routerproducten kan niet worden

gegarandeerd vanwege de radioverbinding en mogen daarom niet worden gebruikt voor
vergrendelingen in veiligheidskritieke apparaten zoals machines of autotoepassingen.

n De XBee Adapter-, Gateway- of Router-producten zijn niet goedgekeurd voor gebruik in (deze
lijst is niet uitputtend):

l medische apparaten

l nucleaire toepassingen

l explosieve of ontvlambare atmosferen

n Er zijn geen door de gebruiker te onderhouden componenten in het XBee Adapter-, Gateway- of
Routerproduct. Verwijder de productkappen niet en wijzig de gateway of router op geen
enkele manier. Wijzigingen kunnen het product uitsluiten van elke garantie en kunnen ertoe
leiden dat de gateway of router buiten de regelgeving voor een bepaald land werkt, wat kan
leiden tot de mogelijke illegale werking van het product.

n Gebruik industriestandaard ESD-bescherming bij het hanteren van het XBee Adapter-,
Gateway- of Routerproduct.

n Wees voorzichtig bij het hanteren om elektrische schade aan de printplaat en componenten te
voorkomen.

n Stel de XBee Adapter-, Gateway- of Routerproducten niet bloot aan water of vocht.

n Gebruik dit product met de antennes die zijn gespecificeerd in de gebruikershandleidingen van
de XBee Adapter, Gateway of Router.

n De eindgebruiker moet worden verteld hoe de voeding van de XBee Adapter, Gateway of
Router moet worden uitgeschakeld of hoe de antennes op 20 cm van mensen of dieren moeten
worden geplaatst.

Ohutusjuhised

XBee adapter, lüüsid ja ruuterid
n XBee adapteri, lüüsi või ruuteri toodete toimimist ei saa raadiolingi tõttu tagada ja seetõttu ei

tohiks neid kasutada ohutuse seisukohalt oluliste seadmete (nt masinad või autorakendused)
blokeerimiseks.
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n XBee adapteri, lüüsi või ruuteri tooteid ei ole heaks kiidetud kasutamiseks järgmistes riikides
(see loend ei ole ammendav):

l meditsiiniseadmed

l tuumarakendused

l plahvatusohtlik või tuleohtlik keskkond

n XBee adapteris, lüüsis või ruuteris ei ole kasutaja poolt hooldatavaid komponente. Ärge
eemaldage toote katet ega muutke lüüsi ega ruuterit mingil viisil. Muudatused võivad toote
garantiist välja jätta ja põhjustada lüüsi või ruuteri toimimise väljaspool antud riigi regulatiivset
vastavust, mis võib viia toote ebaseadusliku kasutamiseni.

n Kasutage XBee adapteri, lüüsi või ruuteri toote käsitsemisel tööstusharu standardset ESD-
kaitset.

n Olge käsitsemisel ettevaatlik, et vältida PCB ja komponentide elektrikahjustusi.

n Ärge jätke XBee adapteri, lüüsi või ruuteri tooteid vee või niiskuse kätte.

n Kasutage seda toodet XBee adapteri, lüüsi või ruuteri toote kasutusjuhendis kirjeldatud
antennidega.

n Lõppkasutajale tuleb öelda, kuidas eemaldada XBee adapteri, lüüsi või ruuteri toide või leida
antennid inimestest või loomadest 20 cm kaugusel.

Turvallisuusohjeet

XBee-sovitin, yhdyskäytävät ja reitittimet
n XBee-sovitin-, yhdyskäytävä- tai reititintuotteiden toimintaa ei voida taata radiolinkin vuoksi,

joten niitä ei tule käyttää turvallisuuden kannalta kriittisten laitteiden, kuten koneiden tai
autosovelluksien, lukitsemiseen.

n XBee-sovitin-, yhdyskäytävä- tai reititintuotteita ei ole hyväksytty käytettäväksi (tämä luettelo
ei ole tyhjentävä):

l lääketieteelliset laitteet

l ydinvoimasovellukset

l räjähdysvaarallisiin tai syttyviin tiloihin

n XBee-sovittimen, yhdyskäytävän tai reitittimen sisällä ei ole käyttäjän huollettavia osia. Älä
poista tuotteen kansia tai muokkaa yhdyskäytävää tai reititintä millään tavalla. Muutokset
voivat sulkea tuotteen takuun ulkopuolelle ja saada yhdyskäytävän tai reitittimen toimimaan
tietyn maan säännöstenmukaisuuden ulkopuolella, mikä voi johtaa tuotteen laittomaan
käyttöön.

n Käytä alan standardia ESD-suojausta käsitellessäsi XBee-sovitinta, yhdyskäytävää tai
reititintuotetta.

n Ole varovainen käsitellessäsi, jotta vältät piirilevyn ja komponenttien sähkövauriot.
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n Älä altista XBee-sovitin-, yhdyskäytävä- tai reititintuotteita vedelle tai kosteudelle.

n Käytä tätä tuotetta XBee-sovittimen, yhdyskäytävän tai reitittimen tuotteen käyttöoppaissa
määritettyjen antennien kanssa.

n Loppukäyttäjälle on kerrottava, kuinka XBee-sovittimen, yhdyskäytävän tai reitittimen virta
katkaistaan tai antennit sijoitetaan 20 cm:n etäisyydelle ihmisistä tai eläimistä.

Consignes de sécurité

Adaptateur XBee, passerelles et routeurs
n Le fonctionnement des produits XBee Adapter, Gateway ou Router ne peut pas être garanti en

raison de la liaison radio et ne doit donc pas être utilisé pour les verrouillages dans des
dispositifs critiques pour la sécurité tels que des machines ou des applications automobiles.

n Les produits XBee Adapter, Gateway ou Router n'ont pas été approuvés pour une utilisation
dans (cette liste n'est pas exhaustive) :

l dispositifs médicaux

l applications nucléaires

l atmosphères explosives ou inflammables

n Il n'y a aucun composant réparable par l'utilisateur à l'intérieur du produit XBee Adapter,
Gateway ou Router. Ne retirez pas les capots du produit et ne modifiez en aucune façon la
passerelle ou le routeur. Les modifications peuvent exclure le produit de toute garantie et
peuvent entraîner le fonctionnement de la passerelle ou du routeur en dehors de la conformité
réglementaire pour un pays donné, conduisant à un éventuel fonctionnement illégal du produit.

n Utilisez la protection ESD standard de l'industrie lors de la manipulation de l'adaptateur, de la
passerelle ou du routeur XBee.

n Soyez prudent lors de la manipulation afin d'éviter des dommages électriques au circuit
imprimé et aux composants.

n N'exposez pas les produits XBee Adapter, Gateway ou Router à l'eau ou à l'humidité.

n Utilisez ce produit avec les antennes spécifiées dans les guides d'utilisation des adaptateurs,
passerelles ou routeurs XBee.

n L'utilisateur final doit savoir comment couper l'alimentation de l'adaptateur, de la passerelle
ou du routeur XBee ou comment placer les antennes à 20 cm des humains ou des animaux.

Sicherheitshinweise

XBee-Adapter, Gateways und Router
n Der Betrieb der XBee Adapter-, Gateway- oder Router-Produkte kann aufgrund der

Funkverbindung nicht garantiert werden und sollte daher nicht für Verriegelungen in
sicherheitskritischen Geräten wie Maschinen oder Automobilanwendungen verwendet werden.
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n Die XBee Adapter-, Gateway- oder Router-Produkte wurden nicht für die Verwendung
zugelassen in (diese Liste ist nicht vollständig):

l Medizinprodukte

l nukleare Anwendungen

l explosive oder brennbare Atmosphären

n Es gibt keine vom Benutzer zu wartenden Komponenten innerhalb des XBee Adapter-,
Gateway- oder Router-Produkts. Entfernen Sie nicht die Produktabdeckungen und modifizieren
Sie das Gateway oder den Router nicht in irgendeiner Weise. Modifikationen können das
Produkt von jeglicher Garantie ausschließen und dazu führen, dass das Gateway oder der
Router außerhalb der gesetzlichen Vorschriften für ein bestimmtes Land betrieben wird, was
zu einem möglicherweise illegalen Betrieb des Produkts führen kann.

n Verwenden Sie bei der Handhabung des XBee Adapter-, Gateway- oder Router-Produkts ESD-
Schutz nach Industriestandard.

n Seien Sie vorsichtig bei der Handhabung, um elektrische Schäden an der Leiterplatte und den
Komponenten zu vermeiden.

n Setzen Sie die Produkte XBee Adapter, Gateway oder Router weder Wasser noch Feuchtigkeit
aus.

n Verwenden Sie dieses Produkt mit den Antennen, die in den Produktbenutzerhandbüchern für
XBee-Adapter, -Gateways oder -Router angegeben sind.

n Dem Endbenutzer muss mitgeteilt werden, wie er die Stromversorgung des XBee-Adapters,
Gateways oder Router-Produkts unterbricht oder die Antennen 20 cm von Menschen oder
Tieren entfernt aufstellt.

Οδηγίες ασφαλείας

ΠροσαρμογέαςXBee, πύλεςκαι δρομολογητές
n Τα προϊόντα XBee Adapter, Gateway ή Router δεν είναι εγγυημένα για τη λειτουργία τους λόγω

της ραδιοζεύξης και επομένως δεν πρέπει να χρησιμοποιούνται για ασφάλειες σε κρίσιμες για την
ασφάλεια συσκευές, όπως μηχανήματα ή εφαρμογές αυτοκινήτου.

n Τα προϊόντα XBee Adapter, Gateway ή Router δεν έχουν εγκριθεί για χρήση σε (αυτή η λίστα δεν
είναι εξαντλητική):

l ιατροτεχνολογικά προϊόντα

l πυρηνικές εφαρμογές

l εκρηκτικές ή εύφλεκτες ατμόσφαιρες
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n Δεν υπάρχουν εξαρτήματα που να μπορούν να επισκευαστούν από το χρήστη μέσαστο προϊόν
XBee Adapter, Gateway ή Router. Μηναφαιρείτε τα καλύμματα του προϊόντος και μην
τροποποιείτε την πύλη ή το δρομολογητή με κανέναν τρόπο. Οι τροποποιήσεις ενδέχεται να
αποκλείουν το προϊόν από οποιαδήποτε εγγύηση και μπορεί να προκαλέσουν τη λειτουργία της
πύλης ή του δρομολογητή εκτός της συμμόρφωσης με τους κανονισμούς για μια δεδομένη χώρα,
οδηγώντας σε πιθανή παράνομη λειτουργία του προϊόντος.

n Χρησιμοποιήστε βιομηχανική προστασία ESD όταν χειρίζεστε το προϊόν XBee Adapter, Gateway
ή Router.

n Προσέχετε κατά το χειρισμό για να αποφύγετε ηλεκτρική βλάβη στο PCB και στα εξαρτήματα.

n Μην εκθέτετε τα προϊόντα XBee Adapter, Gateway ή Router σε νερό ή υγρασία.

n Χρησιμοποιήστε αυτό το προϊόν με τις κεραίες που καθορίζονται στους οδηγούς χρήσης του
XBee Adapter, Gateway ή Router.

n Πρέπει να ενημερωθεί ο τελικός χρήστης πώς νααφαιρέσει το ρεύμα από τον προσαρμογέα
XBee, το Gateway ή το προϊόν του δρομολογητή ή να εντοπίσει τις κεραίες σε απόσταση 20 cm
από ανθρώπους ή ζώα.

Biztonsági utasítások

XBee adapter, átjárók és útválasztók
n Az XBee Adapter, Gateway vagy Router termékek működése nem garantálható a

rádiókapcsolat miatt, ezért nem használhatók biztonsági szempontból kritikus eszközök,
például gépek vagy autóipari alkalmazások reteszelésére.

n Az XBee Adapter, Gateway vagy Router termékek nem engedélyezettek a következő
országokban való használatra (ez a lista nem teljes):

l orvosi eszközök

l nukleáris alkalmazások

l robbanásveszélyes vagy gyúlékony légkör

n Az XBee Adapter, Gateway vagy Router termékben nincsenek felhasználó által javítható
alkatrészek. Ne távolítsa el a termék fedelét, és semmilyen módon ne módosítsa az átjárót
vagy az útválasztót. A módosítások kizárhatják a termékre a jótállást, és az átjáró vagy az
útválasztó az adott ország szabályozási megfelelőségén kívüli működését okozhatják, ami a
termék esetleges illegális működéséhez vezethet.

n Az XBee Adapter, Gateway vagy Router termékek kezelésekor használjon ipari szabvány ESD
védelmet.

n A kezelés során ügyeljen arra, hogy elkerülje a PCB és az alkatrészek elektromos károsodását.

n Ne tegye ki az XBee Adapter-, Gateway- vagy Router-termékeket víznek vagy nedvességnek.
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n Használja ezt a terméket az XBee Adapter, Gateway vagy Router termék használati
útmutatójában meghatározott antennákkal.

n A végfelhasználót tájékoztatni kell arról, hogyan távolítsa el az XBee Adapter, Gateway vagy
Router termék áramellátását, vagy hogyan helyezze el az antennákat az emberektől vagy
állatoktól 20 cm-re.

Istruzioni di sicurezza

Adattatore, gateway e router XBee
n Non è possibile garantire il funzionamento dei prodotti XBee Adapter, Gateway o Router a

causa del collegamento radio e pertanto non devono essere utilizzati per gli interblocchi in
dispositivi critici per la sicurezza come macchine o applicazioni automobilistiche.

n I prodotti XBee Adapter, Gateway o Router non sono stati approvati per l'uso in (questo elenco
non è esaustivo):

l dispositivi medici

l applicazioni nucleari

l atmosfere esplosive o infiammabili

n Non ci sono componenti riparabili dall'utente all'interno del prodotto XBee Adapter, Gateway o
Router. Non rimuovere i coperchi del prodotto né modificare in alcun modo il Gateway o il
Router. Le modifiche possono escludere il prodotto da qualsiasi garanzia e possono causare il
funzionamento del gateway o del router al di fuori della conformità normativa per un
determinato paese, portando al possibile funzionamento illegale del prodotto.

n Utilizzare la protezione ESD standard del settore quando si maneggia l'adattatore XBee, il
gateway o il prodotto router.

n Prestare attenzione durante la manipolazione per evitare danni elettrici al PCB e ai
componenti.

n Non esporre i prodotti XBee Adapter, Gateway o Router ad acqua o umidità.

n Utilizzare questo prodotto con le antenne specificate nelle guide per l'utente del prodotto
XBee Adapter, Gateway o Router.

n L'utente finale deve essere informato su come rimuovere l'alimentazione dal prodotto XBee
Adapter, Gateway o Router o come posizionare le antenne a 20 cm da esseri umani o animali.

Drošības instrukcijas

XBee adapteris, vārtejas un maršrutētāji
n XBee adaptera, vārtejas vai maršrutētāja izstrādājumu darbība nevar tikt garantēta radio

saites dēļ, tāpēc tos nevajadzētu izmantot bloķēšanai tādās drošībai svarīgās ierīcēs kā
mašīnas vai automobiļu lietojumprogrammas.



About Digi XBee Industrial Gateway Safety instructions

Digi XBee Industrial Gateway 22

n XBee adaptera, vārtejas vai maršrutētāja produkti nav apstiprināti lietošanai (šis saraksts nav
pilnīgs):

l medicīniskās ierīces

l kodolprogrammas

l sprādzienbīstamā vai uzliesmojošā vidē

n XBee adaptera, vārtejas vai maršrutētāja izstrādājumā nav neviena komponenta, ko lietotājs
varētu apkalpot. Nenoņemiet izstrādājuma vākus un nekādā veidā nepārveidojiet vārteju vai
maršrutētāju. Izmaiņas var izslēgt uz izstrādājumu no jebkādas garantijas un var izraisīt
vārtejas vai maršrutētāja darbību, kas neatbilst noteiktās valsts normatīvajiem aktiem,
izraisot iespējamu produkta nelikumīgu darbību.

n Strādājot ar XBee adaptera, vārtejas vai maršrutētāja izstrādājumu, izmantojiet nozares
standarta ESD aizsardzību.

n Rīkojoties, rīkojieties uzmanīgi, lai izvairītos no PCB un komponentu elektriskiem bojājumiem.

n Nepakļaujiet XBee adaptera, vārtejas vai maršrutētāja izstrādājumus ūdens vai mitruma
iedarbībai.

n Izmantojiet šo izstrādājumu ar antenām, kas norādītas XBee adaptera, vārtejas vai
maršrutētāja izstrādājuma lietotāja rokasgrāmatās.

n Galalietotājam ir jāinformē, kā atvienot strāvu no XBee adaptera, vārtejas vai maršrutētāja
izstrādājuma vai atrast antenas 20 cm attālumā no cilvēkiem vai dzīvniekiem.

Saugos instrukcijos

XBee adapteris, šliuzai ir maršrutizatoriai
n „XBee“ adapterio, šliuzo ar maršrutizatoriaus gaminių veikimas negali būti garantuotas dėl

radijo ryšio, todėl jie neturėtų būti naudojami blokuojant saugai svarbius įrenginius, pvz.,
mašinas ar automobilius.

n XBee adapterio, šliuzo ar maršrutizatoriaus produktai nebuvo patvirtinti naudoti (šis sąrašas
nėra baigtinis):

l medicinos prietaisai

l branduolinės programos

l sprogioje ar degioje aplinkoje

n XBee Adapter, Gateway arba Router gaminyje nėra komponentų, kuriuos vartotojas galėtų
taisyti. Jokiu būdu nenuimkite gaminio dangtelių ir nekeiskite šliuzo ar maršrutizatoriaus. Dėl
modifikacijų gaminiui gali būti netaikoma jokia garantija, o šliuzas arba maršruto parinktuvas
gali veikti nesilaikant tam tikros šalies teisės aktų reikalavimų, o tai gali sukelti neteisėtą
gaminio veikimą.



About Digi XBee Industrial Gateway Safety instructions

Digi XBee Industrial Gateway 23

n Dirbdami su XBee adapteriu, šliuzu ar maršrutizatoriumi naudokite pramonės standartinę ESD
apsaugą.

n Dirbdami būkite atsargūs, kad nepažeistumėte PCB ir komponentų.

n Saugokite XBee adapterį, šliuzą ar maršrutizatorių nuo vandens ar drėgmės.

n Naudokite šį gaminį su antenomis, nurodytomis XBee adapterio, šliuzo ar maršrutizatoriaus
gaminio vartotojo vadove.

n Galutiniam vartotojui turi būti paaiškinta, kaip atjungti maitinimą iš XBee adapterio, šliuzo ar
maršrutizatoriaus gaminio arba nustatyti antenas 20 cm atstumu nuo žmonių ar gyvūnų.

Sikkerhetsinstruksjoner

XBee-adapter, gatewayer og rutere
n XBee Adapter-, Gateway- eller Router-produktene kan ikke garanteres drift på grunn av

radiolinken og bør derfor ikke brukes til forriglinger i sikkerhetskritiske enheter som maskiner
eller bilapplikasjoner.

n XBee Adapter, Gateway eller Router-produktene er ikke godkjent for bruk i (denne listen er
ikke uttømmende):

l medisinsk utstyr

l kjernefysiske applikasjoner

l eksplosive eller brennbare atmosfærer

n Det er ingen komponenter som kan repareres av brukeren inne i XBee Adapter-, Gateway- eller
Router-produktet. Ikke fjern produktdekslene eller modifiser gatewayen eller ruteren på noen
måte. Endringer kan ekskludere produktet fra enhver garanti og kan føre til at gatewayen eller
ruteren fungerer utenfor regelverket for et gitt land, noe som kan føre til ulovlig drift av
produktet.

n Bruk industristandard ESD-beskyttelse når du håndterer XBee Adapter-, Gateway- eller Router-
produktet.

n Vær forsiktig ved håndtering for å unngå elektrisk skade på PCB og komponenter.

n Ikke utsett XBee Adapter-, Gateway- eller Router-produktene for vann eller fuktighet.

n Bruk dette produktet med antennene som er spesifisert i brukerveiledningene for XBee
Adapter, Gateway eller Router.

n Sluttbrukeren må bli fortalt hvordan man fjerner strømmen fra XBee Adapter-, Gateway- eller
Router-produktet eller plasserer antennene 20 cm fra mennesker eller dyr.
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Instrukcje bezpieczeństwa

Adapter, bramy i routery XBee
n Produkty XBee Adapter, Gateway lub Router nie mogą zagwarantować działania ze względu na

łącze radiowe, dlatego nie należy ich używać do blokad w urządzeniach o krytycznym znaczeniu
dla bezpieczeństwa, takich jak maszyny lub aplikacje motoryzacyjne.

n Produkty XBee Adapter, Gateway lub Router nie zostały zatwierdzone do użytku w (lista ta nie
jest wyczerpująca):

l wyroby medyczne

l zastosowania nuklearne

l atmosferach wybuchowych lub łatwopalnych

n Wewnątrz adaptera, bramy lub routera XBee nie ma żadnych elementów, które mogłyby być
serwisowane przez użytkownika. Nie zdejmuj osłon produktu ani nie modyfikuj w żaden sposób
bramki lub routera. Modyfikacje mogą wyłączyć produkt z jakiejkolwiek gwarancji i
spowodować, że brama lub router będzie działać niezgodnie z przepisami w danym kraju, co
może prowadzić do nielegalnego działania produktu.

n Używaj standardowej ochrony ESD podczas obsługi produktów XBee Adapter, Gateway lub
Router.

n Podczas obsługi należy zachować ostrożność, aby uniknąć uszkodzeń elektrycznych PCB i
komponentów.

n Nie wystawiaj adaptera, bramki lub routera XBee na działanie wody lub wilgoci.

n Używaj tego produktu z antenami określonymi w instrukcji obsługi adaptera, bramki lub
routera XBee.

n Użytkownik końcowy musi zostać poinformowany, jak odłączyć zasilanie od adaptera, bramki
lub routera XBee lub jak zlokalizować anteny w odległości 20 cm od ludzi lub zwierząt.

Instruções de segurança

Adaptador, gateways e roteadores XBee
n Os produtos XBee Adapter, Gateway ou Router não podem ter operação garantida devido ao

link de rádio e, portanto, não devem ser usados para intertravamentos em dispositivos críticos
de segurança, como máquinas ou aplicações automotivas.

n Os produtos XBee Adapter, Gateway ou Router não foram aprovados para uso em (esta lista
não é exaustiva):

l dispositivos médicos

l aplicações nucleares

l atmosferas explosivas ou inflamáveis
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n Não há componentes que possam ser reparados pelo usuário dentro do produto XBee Adapter,
Gateway ou Router. Não remova as tampas do produto nem modifique o Gateway ou o
Roteador de forma alguma. As modificações podem excluir o produto de qualquer garantia e
fazer com que o gateway ou roteador opere fora da conformidade regulatória de um
determinado país, levando à possível operação ilegal do produto.

n Use a proteção ESD padrão do setor ao manusear o produto Adaptador, Gateway ou Roteador
XBee.

n Tome cuidado ao manusear para evitar danos elétricos à PCB e aos componentes.

n Não exponha os produtos XBee Adapter, Gateway ou Router à água ou umidade.

n Use este produto com as antenas especificadas nos guias do usuário do produto Adaptador,
Gateway ou Roteador XBee.

n O usuário final deve ser informado sobre como remover a energia do produto Adaptador,
Gateway ou Roteador XBee ou localizar as antenas a 20 cm de humanos ou animais.

Instructiuni de siguranta

Adaptor XBee, gateway-uri și routere
n Nu se poate garanta funcționarea produselor XBee Adapter, Gateway sau Router din cauza

conexiunii radio și, prin urmare, nu trebuie utilizate pentru interblocări în dispozitive critice
pentru siguranță, cum ar fi mașinile sau aplicațiile auto.

n Produsele XBee Adapter, Gateway sau Router nu au fost aprobate pentru utilizare în (aceasta
listă nu este exhaustivă):

l dispozitive medicale

l aplicații nucleare

l atmosfere explozive sau inflamabile

n Nu există componente care să poată fi reparate de utilizator în interiorul produsului XBee
Adapter, Gateway sau Router. Nu îndepărtați capacele produsului și nu modificați Gateway-ul
sau Routerul în niciun fel. Modificările pot exclude produsul din orice garanție și pot face ca
gateway-ul sau routerul să funcționeze în afara conformității cu reglementările pentru o
anumită țară, ceea ce duce la o posibilă funcționare ilegală a produsului.

n Folosiți protecția ESD standard în industrie când manipulați produsul XBee Adapter, Gateway
sau Router.

n Aveți grijă în timpul manipulării pentru a evita deteriorarea electrică a PCB-ului și a
componentelor.

n Nu expuneți produsele XBee Adapter, Gateway sau Router la apă sau umiditate.

n Utilizați acest produs cu antenele specificate în ghidurile de utilizare ale produsului XBee
Adapter, Gateway sau Router.
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n Utilizatorului final trebuie să i se spună cum să scoată alimentarea de la adaptorul, gateway-ul
sau routerul XBee sau să găsească antenele la 20 cm de oameni sau anima

Bezpečnostné inštrukcie

XBee adaptér, brány a smerovače
n Produkty XBee Adapter, Gateway alebo Router nemožno zaručiť kvôli rádiovému spojeniu, a

preto by sa nemali používať na blokovanie v zariadeniach kritických z hľadiska bezpečnosti, ako
sú stroje alebo automobilové aplikácie.

n Produkty XBee Adapter, Gateway alebo Router neboli schválené na použitie v (tento zoznam
nie je úplný):

l zdravotnícke pomôcky

l jadrové aplikácie

l výbušné alebo horľavé atmosféry

n Vo vnútri produktu XBee Adapter, Gateway alebo Router sa nenachádzajú žiadne užívateľsky
opraviteľné komponenty. Neodstraňujte kryty produktu ani žiadnym spôsobom neupravujte
bránu ani smerovač. Úpravy môžu vyňať produkt zo záruky a môžu spôsobiť, že brána alebo
smerovač bude fungovať mimo zákonných predpisov pre danú krajinu, čo môže viesť k možnej
nezákonnej prevádzke produktu.

n Pri manipulácii s produktom XBee Adapter, Gateway alebo Router používajte štandardnú
ochranu ESD.

n Pri manipulácii buďte opatrní, aby ste predišli elektrickému poškodeniu dosky plošných spojov
a komponentov.

n Produkty XBee Adapter, Gateway alebo Router nevystavujte vode ani vlhkosti.

n Tento produkt používajte s anténami špecifikovanými v používateľských príručkách produktu
XBee Adapter, Gateway alebo Router.

n Koncový používateľ musí byť informovaný o tom, ako odpojiť napájanie XBee adaptéra, brány
alebo smerovača alebo ako umiestniť antény 20 cm od ľudí alebo zvierat.

Varnostna navodila

Adapter, prehodi in usmerjevalniki XBee
n Izdelkom XBee Adapter, Gateway ali Router ni mogoče zagotoviti delovanja zaradi radijske

povezave in se zato ne smejo uporabljati za zaklepanje v varnostno kritičnih napravah, kot so
stroji ali avtomobilske aplikacije.
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n Izdelki XBee Adapter, Gateway ali Router niso bili odobreni za uporabo v (ta seznam ni izčrpen):

l medicinskih pripomočkov

l jedrske aplikacije

l eksplozivne ali vnetljive atmosfere

n V izdelku XBee Adapter, Gateway ali Usmerjevalnik ni komponent, ki bi jih lahko popravil
uporabnik. Ne odstranjujte pokrovov izdelka in na noben način ne spreminjajte prehoda ali
usmerjevalnika. Spremembe lahko izključijo izdelek iz kakršne koli garancije in lahko
povzročijo, da prehod ali usmerjevalnik deluje zunaj zakonske skladnosti za dano državo, kar
vodi do možnega nezakonitega delovanja izdelka.

n Pri ravnanju z izdelkom XBee Adapter, Gateway ali Usmerjevalnik uporabljajte industrijsko
standardno zaščito pred ESD.

n Pri rokovanju pazite, da se izognete električnim poškodbam tiskanega vezja in komponent.

n Izdelkov XBee Adapter, Gateway ali Usmerjevalnik ne izpostavljajte vodi ali vlagi.

n Ta izdelek uporabljajte z antenami, navedenimi v uporabniških priročnikih izdelka XBee
Adapter, Gateway ali Router.

n Končnemu uporabniku je treba povedati, kako odstraniti napajanje iz izdelka XBee Adapter,
Gateway ali Usmerjevalnik ali naj locira antene 20 cm od ljudi ali živali.

Las instrucciones de seguridad

Adaptador XBee, puertas de enlace y enrutadores
n No se puede garantizar el funcionamiento de los productos del adaptador, puerta de enlace o

enrutador XBee debido al enlace de radio y, por lo tanto, no deben usarse para enclavamientos
en dispositivos críticos para la seguridad, como máquinas o aplicaciones automotrices.

n Los productos XBee Adapter, Gateway o Router no han sido aprobados para su uso en (esta
lista no es exhaustiva):

l dispositivos médicos

l aplicaciones nucleares

l atmósferas explosivas o inflamables

n No hay componentes reparables por el usuario dentro del adaptador XBee, la puerta de enlace
o el enrutador. No retire las cubiertas del producto ni modifique la puerta de enlace o el
enrutador de ninguna manera. Las modificaciones pueden excluir el producto de cualquier
garantía y pueden hacer que la puerta de enlace o el enrutador funcionen fuera del
cumplimiento normativo de un país determinado, lo que puede conducir a la operación ilegal
del producto.

n Utilice la protección ESD estándar de la industria cuando manipule el adaptador, la puerta de
enlace o el enrutador XBee.
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n Tenga cuidado al manipularlo para evitar daños eléctricos en la PCB y los componentes.

n No exponga los productos XBee Adapter, Gateway o Router al agua o la humedad.

n Utilice este producto con las antenas especificadas en las guías de usuario del producto XBee
Adapter, Gateway o Router.

n Se debe indicar al usuario final cómo desconectar la alimentación del adaptador, la puerta de
enlace o el enrutador XBee o cómo ubicar las antenas a 20 cm de personas o animales.

Säkerhets instruktioner

XBee-adapter, gateways och routrar
n XBee Adapter, Gateway eller Router-produkter kan inte garanteras funktion på grund av

radiolänken och bör därför inte användas för förreglingar i säkerhetskritiska enheter som
maskiner eller biltillämpningar.

n XBee Adapter, Gateway eller Router-produkter har inte godkänts för användning i (denna lista
är inte uttömmande):

l medicinsk utrustning

l kärnkraftstillämpningar

l explosiv eller brandfarlig atmosfär

n Det finns inga komponenter som användaren kan reparera inuti XBee Adapter-, Gateway- eller
Routerprodukten. Ta inte bort produkthöljena eller modifiera gatewayen eller routern på
något sätt. Ändringar kan utesluta produkten från alla garantier och kan göra att gatewayen
eller routern fungerar utanför regelverket för ett visst land, vilket kan leda till olaglig
användning av produkten.

n Använd industristandard ESD-skydd när du hanterar XBee Adapter, Gateway eller Router-
produkten.

n Var försiktig vid hanteringen för att undvika elektriska skador på kretskortet och
komponenterna.

n Utsätt inte XBee Adapter, Gateway eller Router-produkter för vatten eller fukt.

n Använd den här produkten med de antenner som specificeras i användarhandböckerna för
XBee Adapter, Gateway eller Router.

n Slutanvändaren måste informeras om hur man kopplar bort strömmen från XBee Adapter,
Gateway eller Router-produkten eller hur man placerar antennerna 20 cm från människor eller
djur.

International EMC (Electromagnetic Emissions/Immunity/Safety)
standards
This product complies with the requirements of following Electromagnetic Emissions/Immunity/Safety
standards.
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There are no user-serviceable parts inside the product. Contact your Digi representative for repair
information.

Emissions Immunity Safety

EN 55022:2010 Class B
EN 61000-3-2:2004
EN 61000-3-3:2013
FCC 15.107:2015 Class B
FCC 15.109:2015 Class B
FCC 15.109(g):2015 Class B
IEC-003:2012 Class B
EN 301 489-07 V1.3.1:2005

EN 301 489-07 V1.3.1:2005
EN 55024:2010

IEC 60950-1:2005
EN 60950-1:2006
SCA C22.22 No. 60950-1

XBee Industrial Gateway Python application
The XBee Industrial Gateway Python application resides on XBee Industrial Gateway. Its key functions
include connecting your XBee modules to Remote Manager, enabling uploads of data to Remote
Manager, and receiving remote text and commands. The XBee Industrial Gateway Python application
is installed by default in your XBee Industrial Gateway device and automatically starts when the
gateway is initialized.
For more information on the XBee Industrial Gateway Python application, see XBee Industrial
Gateway Python application and Remote Manager.

XBee ZigBee Cloud Kit
Digi offers a development kit called the XBee ZigBee Cloud Kit.
The XBee ZigBee Cloud Kit is designed to make it easy to set up your XBee ZigBee hardware and
configure its sample web application. You can see sensor data from your development board on the
web, as well as send data and commands from the web to your device. The components in this kit
allow you to create highly customized solutions for connected devices.
To order this kit, go to the XBee Gateway product page for ordering information. For setup
instructions, see the XBee ZigBee Cloud Kit Getting Started Guide.

Hardware interfaces
XBee Industrial Gateway hardware interfaces include LEDs that indicate device state and status of
connections, and activity for Ethernet, cellular, and XBee network connections. You can control some
of these hardware features through programming.
For detailed information about hardware interfaces, see Hardware.

Configuration and management interfaces
To establish network connectivity with an XBee Industrial Gateway device, minimal configuration is
required in many environments. This means that you may not need to set or change configuration
settings from their factory defaults to begin developing with the device. There are several user
interfaces for interacting with XBee Industrial Gateway, for example to view or change configuration
settings or perform important administrative tasks such as updating firmware or rebooting the
device. These include:

https://www.digi.com/products/xbee-rf-solutions/gateways/xbee-gateway#partnumbers
http://www.digi.com/resources/documentation/Digidocs/90001503/Default.htm
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n XBee Industrial Gateway web interface: A web-based interface for configuring, monitoring, and
administering Digi devices.

n Remote Manager interface: A web-based, remote-management interface.

n RF Gateway and Python remote device management solutions

n Programming interface applications

XBee Industrial Gateway web interface
The XBee Industrial Gateway web interface, available via a local network connection to XBee
Industrial Gateway, provides an easy way to configure device settings and perform administrative
tasks. Device information displayed varies by model.
You are required to log in to the web interface. The default user name and password are described
below:

n User name: python

n Password: The unique password printed on the device label. If the password is not on the
device label, the default password is dbps. If these defaults do not work, the password may
have been updated. Contact your system administrator for help.

For more information, see Configure settings from the XBee Industrial Gateway web interface.

Remote Manager interface
Remote Manager is a software-as-a-service that empowers IT, network operations and customer
support organizations to conquer the challenges of managing the vast array of equipment in their
device networks. As a network grows, the complexity of effectively managing the network assets
grows exponentially.
When XBee Industrial Gateway powers up, the device automatically connects to Remote Manager.
Remote Manager provides the capabilities you need to manage a dynamic device network, including:

n Centralized control over large numbers of devices

n Reducing service complexity

n Maintaining high levels of security

n Configuring and decommissioning of equipment

n Adding functionality to device networks

In addition, you can use the Remote Manager Web Services (API) to provide seamless integration from
Digi gateways into customer back-office applications. You can access these Web Services via the API
Explorer tab of the Documentation tab of the Remote Manager interface. See Digi Remote Manager
Programmer Guide for more information.
Some things to note about using Remote Manager:

n You must register devices on Remote Manager before you can access them from Remote
Manager.

n To minimize network traffic, Remote Manager uses caching. As a result, device settings can be
out-of-sync between the device and the settings viewed on the Remote Manager console.

n You can refresh device information on demand when the device is connected. The device
information refreshes automatically when a device connects.

https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
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For more information about configuring settings from Remote Manager, see Configure settings from
Remote Manager.
For more information on Remote Manager as a remote device network management solution, see
these resources:

n Digi Remote Manager User Guide

n Digi Remote Manager Programmer Guide

n Remote Manager tutorials and other documents available on the Digi Remote Manager
product page

Note To serve our customers most effectively, Digi International Inc. is consolidating its cloud
services, Digi Device Cloud and Digi Remote Manager®, under the Remote Manager name. This phased
process does not affect device functionality or the functionality of the web services and other
features. However, you will find instances of both Device Cloud and Digi Remote Manager in some
documentation, firmware, and user interfaces.

RF Gateway and Python remote device management solutions
XBee Industrial Gateway includes Remote Manager functionality by default. This functionality allows
you to see your data in the cloud quickly and with minimal effort.
However, you can extend the system through the Python interpreter and customize the gateway to
connect directly to the environment of your choice. See the Digi XBee, RF Gateway and Python
Resource page for more information.

Programming interface applications
XBee Industrial Gateway offers a variety of interfaces that produce and/or consume data. Developing
software programs for XBee Industrial Gateway products allows Digi customers to provide custom
logic to control the information to and from these interfaces.
For more information, see About programming.

Where to find more information
See the following topics in this guide for more information:

n Learn more about XBee Industrial Gateway

n About programming

The following documents are available on www.digi.com unless otherwise noted:
n For more information about features and operation of the XBee RF module mounted inside the

gateway, see XBee/XBee-PRO ZigBee RF Module User Guide.

n You can refer to the ConnectPort X2e section in the Digi Python Wiki Archive Reference Manual

for additional programming content for ConnectPort X2e products. Information in this section
also applies to XBee Industrial Gateway.

n DIA section in the Digi Python Reference Manual for Developers guide

n Digi Remote Manager User Guide

n Digi Remote Manager Programmer Guide

n Datasheets and other documents on the Digi Remote Manager product page

https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/products/cloud/digi-remote-manager
https://www.digi.com/products/cloud/digi-remote-manager
https://www.digi.com/support/knowledge-base/digi-xbee-rf-gateway-and-python-development-resour
https://www.digi.com/support/knowledge-base/digi-xbee-rf-gateway-and-python-development-resour
http://www.digi.com/
http://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_connectport_x2e.htm%3FTocPath%3DCategories|Drop-in%2520Networking%2520Products|_____3
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_welcome.htm%3FTocPath%3DWelcome%2520to%2520Digi%2520Python|_____0
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_device_cloud_wiki.htm
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_welcome.htm%3FTocPath%3DWelcome%2520to%2520Digi%2520Python|_____0
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/products/cloud/digi-remote-manager


Get started

Based on the XBee Industrial Gateway model that you have, choose one of the following options:
n Set up the XBee Industrial Gateway Cellular hardware

n Set up the XBee Industrial Gateway Ethernet hardware

Set up the XBee Industrial Gateway Cellular hardware
This section walks you through the steps required to set up your XBee Industrial Gateway Cellular
hardware and provides additional reference information.

Verify your XBee Industrial Gateway Cellular components
XBee Industrial Gateway cellular model includes the following components:

Component Description

XBee Industrial Gateway Cellular model
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Component Description

Ethernet cable

Power supply

Required additional equipment

Component Description

A computer connected to the
Internet.
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Component Description

XBee antenna An XBee antenna must be connected.
For information about purchasing an XBee antenna, see the Digi
XBee antenna product page.

Cellular antennas Depending on the device variant, either one or two cellular
antennas must be connected to the device.
For information about purchasing a cellular antenna, see the
Digi Cellular antenna product page.

Connect the cellular hardware
1. Install a SIM card. See Set up and configure a cellular device for instructions.

2. Optional: If you are using an Ethernet connection in addition to the cellular, connect one end of
the Ethernet cable to your gateway and the other to a live Ethernet jack.

3. Connect the XBee antenna to the device.

4. Connect the cellular antenna(s) to the device. If your device has two cellular antenna locations,
you must connect an antenna to each location.

5. Connect the power supply.

6. Startup Sequence - After power is applied:

a. The Power LED turns solid blue.

b. The XBee LED turns blinking green when XBee Industrial Gateway
creates a ZigBee network.

c. The Network LED blinks yellow and green and then turns solid green
when XBee Industrial Gateway connects to Remote Manager.

d. For the Cellular model, the Signal Strength LED turns either yellow or
green, depending on the cellular signal strength.

Connect XBee Industrial Gateway to the cellular network
Register the modem in the XBee Industrial Gateway cellular device and set it up in your mobile service
provider's network. See Set up and configure a cellular device for information on configuring the XBee
Industrial Gateway cellular model. Disconnect the Ethernet cable when the configuration steps are
complete.

https://www.digi.com/products/models/a24-hasm-450
https://www.digi.com/products/models/a24-hasm-450
https://www.digi.com/products/models/76000926
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Set up the XBee Industrial Gateway Ethernet hardware
This section walks you through the steps required to set up your XBee Industrial Gateway Ethernet
hardware and provides additional reference information.

Verify your XBee Industrial Gateway Ethernet components
XBee Industrial Gateway Ethernet model includes the following components:

Component Description

XBee Industrial Gateway Ethernet model

Ethernet cable

Power supply
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Required additional equipment

Component Description

A computer connected to the
Internet.

XBee antenna An XBee antenna must be connected.
For information about purchasing an XBee antenna, see the Digi
XBee antenna product page.

Connect the Ethernet hardware
1. Optional: If you are using an Ethernet connection in addition to the cellular, connect one end of

the Ethernet cable to your gateway and the other to a live Ethernet jack.

2. Connect the XBee antenna to the device.

3. Connect the power supply.

4. Startup Sequence - After power is applied:

a. The Power LED turns solid blue.

b. The XBee LED turns blinking green when XBee Industrial Gateway
creates a ZigBee network.

c. The Network LED blinks yellow and green and then turns solid green
when XBee Industrial Gateway connects to Remote Manager.

https://www.digi.com/products/models/a24-hasm-450
https://www.digi.com/products/models/a24-hasm-450


Get started Set up the XBee Industrial Gateway Ethernet hardware

Digi XBee Industrial Gateway 37

Connect XBee Industrial Gateway to the Ethernet network
Your XBee Industrial Gateway automatically connects to the Ethernet network when a DHCP server is
available to assign an IP address to it and no firewalls block outgoing traffic to ports 3197 and 3199. If
the Ethernet network does not come up, see see Cannot connect to DNS server to resolve the
Remote Manager server address.

Note XBee Industrial Gateway requires a DHCP server to assign its IP address. If you do not have a
DHCP server, see Ethernet IP network settings for information on configuring your IP parameters.



Set up your XBee Industrial Gateway

This section walks you through the steps required to set up your XBee Industrial Gateway and
provides additional reference information.

Set up XBee Industrial Gateway summary
These instructions give an overview of how to set up XBee Industrial Gateway.

1. Configure the network settings. These settings include IP networking parameters and Remote
Manager connectivity. For more information, see:

n Ethernet IP network settings

n Mobile connectivity settings

2. Connect the XBee nodes to XBee Industrial Gateway. This step involves configuring the
parameters for forming XBee networks on both XBee Industrial Gateway and XBee nodes.
There are three substeps:

a. Configure XBee Industrial Gateway as a coordinator.

b. Join XBee nodes to the coordinator.

c. Verify that the XBee nodes are joined to the coordinator.

See Connect the XBee nodes to XBee Industrial Gateway for more information.

3. Configure XBee ZigBee network addressing settings. See Configure the ZigBee network
addressing parameters for XBee nodes for more information.

4. Explore configuring XBee nodes for input/output.
a. If using serial I/O, configure XBee nodes for serial I/O. See Explore serial I/O for

more information.

b. If using digital or analog I/O, configure the XBee nodes for digital or analog I/O. See
Explore digital and analog I/O for more information.

5. Look at your device data on Remote Manager. See View your device data for more information.

The following image shows the layout of a fully set up XBee Industrial Gateway.

Digi XBee Industrial Gateway 38
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Joining ZigBee networks
ZigBee networks are called Personal Area Networks or PANs. In the ZigBee protocol, the only node
that can start a new network is the coordinator. For that reason, each ZigBee network must have one
coordinator.
XBee Industrial Gateway includes a built-in XBee ZigBee node already configured as coordinator.
Therefore, as soon as you power on the XBee Industrial Gateway device, your ZigBee network is
initialized.
To start a network, the coordinator must automatically choose a PAN identifier (PAN ID) and the
operating channel for that network. Once those parameters are established and the network is
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initialized, the coordinator and routers can allow other devices (other routers or end devices) to join
the network and route data.
Each network is defined with a unique PAN identifier (PAN ID). This identifier is common among all
devices of the same network. That is, devices on the same ZigBee network must share the same PAN
ID in order to communicate with each other. When you power on a coordinator, it automatically
establishes the PAN ID or uses a pre-configured one when it creates the new network.

n If the PAN ID of the coordinator is 0, it performs a PAN scan to identify nearby ZigBee networks
and uses a random unused PAN ID to start the new network. By default, an XBee Industrial
Gateway coordinator is configured to generate a random PAN ID.

n If the PAN ID for a router or end device is 0, it performs a PAN scan and tries to join any
available ZigBee network it finds.

You can connect to an XBee ZigBee module that is configured as a router node to the network
initialized by XBee Industrial Gateway. By default, the PAN ID of this ZigBee module is configured to 0.
Therefore, if you power on the XBee ZigBee module and there is no other ZigBee network around, the
module joins the ZigBee network initialized by XBee Industrial Gateway automatically. The joining
operation occurs when the Association LED of the board on which the XBee ZigBee module is mounted
starts blinking.
The 802.15.4 PHY (physical layer) protocol description defines 16 operating channels in the 2.4 GHz
frequency band. Before starting the network, the coordinator automatically performs a channel scan
to select a good channel to use for the network.
You can configure all the ZigBee nodes in a network with the channel or channels on which they
operate.

Join XBee Industrial Gateway to an existing ZigBee network
Although this is not a common task, you can configure your XBee Industrial Gateway device to operate
as a router and join an existing ZigBee network.
To join XBee Industrial Gateway to an existing ZigBee network:

1. Open a web browser and type the URL of XBee Industrial Gateway: http://192.168.100.1. The
XBee Industrial Gateway web interface appears.

2. Log in to the web interface:
n User name: The default user name is python. If that user name does not work, it may

have been changed by your system administrator. Contact your system administrator
for help.

n Password: The unique, default password is printed on the device label. If the password
is not on the device label, the default password is dbps. If these defaults do not work,
the password may have been updated. Contact your system administrator for help.

3. Click XBee Network in the left menu.

4. Select the XBee Industrial Gateway ZigBee local XBee device. The XBee Configuration page
appears.

5. From the XBee Configuration page, click Network Settings.
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6. Configure the Extended PAN ID (ID) option with the PAN ID of the network to which XBee
Industrial Gateway should join.

7. Clear the Coordinator Enable (CE) check box. This allows XBee Industrial Gateway to behave
as a router node within the ZigBee network.

8. Click Apply to save the changes to the device. After you apply the changes, XBee Industrial
Gateway behaves as a router node and tries to connect to the ZigBee network with the PAN ID
that you configured.

To join your XBee ZigBee module from the kit to an existing network, follow the steps described in
Configure XBee Industrial Gateway with a custom PAN ID.

Configure XBee Industrial Gateway with a custom PAN ID
In some cases, you want control of the PAN ID used to create your ZigBee network. Use a custom
PAN ID and configure the coordinator, routers, and end devices to use it when there are other
networks around and you do not want your router or end device nodes to join them.
To configure XBee Industrial Gateway with a custom PAN ID:

1. Open a web browser and type the URL of XBee Industrial Gateway: http://192.168.100.1. The
XBee Industrial Gateway web interface appears.
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2. Log in to the web interface:
n User name: The default user name is python. If that user name does not work, it may

have been changed by your system administrator. Contact your system administrator
for help.

n Password: The unique, default password is printed on the device label. If the password
is not on the device label, the default password is dbps. If these defaults do not work,
the password may have been updated. Contact your system administrator for help.

3. Under Configuration, click XBee Network.

4. Select the XBee Industrial Gateway local XBee device that you want to configure. The XBee
Configuration page appears.

5. From the XBee Configuration page, click Network Settings.

6. Configure the Extended PAN ID (ID) option with your custom PAN ID value.

7. Click Apply to save the changes to the device. After applying the changes, the coordinator
initializes the ZigBee network with the new PAN ID. If you had any other ZigBee nodes
connected to the network, you must update their PAN IDs so they will join the new one.

XBee Industrial Gateway and non-XBee ZigBee Devices
You can refer to additional resources to learn about using XBee Industrial Gateway with non-XBee
ZigBee devices. Digi provides support and resources for your use of the product.
Resources include:

n Digi forum

n Digi Knowledge Base

n XBee/XBee-PRO ZB RF Modules User Guide for more information about features and operation of
the XBee RF module mounted inside the gateway

n XBee ZigBee information on the Digi XBee ZigBee product page

http://www.digi.com/support/forum
http://knowledge.digi.com/
http://www.digi.com/resources/documentation/digidocs/PDFs/90000976.pdf
https://www.digi.com/products/xbee-rf-solutions/embedded-rf-modules-modems/digi-xbee-zigbee


Administration and maintenance tasks

There are several administrative and maintenance tasks that you need to perform periodically on
XBee Industrial Gateway. This topic covers common administrative tasks and how to perform them
through Remote Manager and the web interface.

Logging in to the web interface
When you access the web interface, a log in screen displays. You must enter a user name and
password specified for the device.

n User name: The default user name is python. If that user name does not work, it may have
been changed by your system administrator. Contact your system administrator for help.

n Password: The unique, default password is printed on the device label. If the password is not
on the device label, the default password is dbps. If these defaults do not work, the password
may have been updated. Contact your system administrator for help.

File management
The XBee Industrial Gateway file management feature lets you manage custom applications, their
associated data files, and other files. The File Management page is available in Remote Manager and
in the web interface.
You can also push firmware update files to the device file system, and pull log files from the device file
system. See XBee Industrial Gateway file system for information about the file system.

File Management page in Remote Manager
You can use the File Management page in Remote Manager to load files, such as custom application
files, onto XBee Industrial Gateway and display current information about loaded files.
You can also use this page to download system log files from XBee Industrial Gateway to view for
troubleshooting or other purposes. These log files are in the /WEB/logging folder. For a description of
the XBee Industrial Gateway file system layout, see XBee Industrial Gateway file system.

Note Digi recommends using no more than 20 MB for custom applications, as XBee Industrial Gateway
requires a portion of the same space to be capable of managing persistent system logs and firmware
updates.

Access the File Management page
Follow this process to access the File Management page in Remote Manager:

Digi XBee Industrial Gateway 43
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1. Access Remote Manager and log in. If you do not yet have a Remote Manager account, click the
Sign up link on the Remote Manager log in page.

2. Click the Device Management tab.

3. From the list of devices, double-click on the device you want to review.

4. Click the File Management link in the left-hand pane. The File Management screen displays.

File Management toolbar
The File Management toolbar provides quick access to file management tasks.

Button/Field Name Description

Upload file Opens a dialog for uploading files to the current folder (directory).

Download file Downloads the selected file to a computer. You can choose to
open the downloaded file with a specified tool or save it.

Delete Deletes the selected items.

Refresh Refreshes the list of folders and files displayed.

Back Move to the previous folder in folder history.

Forward Move to the next folder in folder history.

Home Returns to the root folder.

Current or
destination
folder

An editable field that displays the current folder. You can use this
field to type a different destination directory.

Go Goes to the directory specified in Current or destination folder
field.

File Management page in the XBee Industrial Gateway web interface
You can use the File Management page to load files onto XBee Industrial Gateway and display current
information about loaded files. For a description of the XBee Industrial Gateway file system layout, see
XBee Industrial Gateway file system.

Access the File Management page
Follow this process to access the File Management page in the web interface:

1. Access and log into the web interface.

2. Click File Management under Administration to launch the File Management page.

File Management page
The following fields and buttons appear on the File Management page:

https://remotemanager.digi.com/
https://remotemanager.digi.com/
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Volume Information section: Displays the current directory for loading files and free space remaining.

Note Digi recommends using no more than 20 MB for custom applications, as XBee Industrial Gateway
requires a portion of the same space to be capable of managing persistent system logs and firmware
updates.

Upload to Current Directory section: Uploads files to the current directory.
n Choose File: To find a file on your computer, click Choose File and go to the file.

n Update file: Click Update file to begin the file upload process.

File List: A listing of the current directory (as noted in the Volume Information section) on the device.
n Open: Opens a directory after it is selected in the file list. The current directory changes and

the list is updated.

n Make Directory: Creates a new, empty directory in the current directory.

n Save As: Downloads a regular file from the file system to your local computer.

n Remove: Deletes files or empty directories. If there are one or more files in a directory, the
directory cannot be deleted.

Refresh button: Reloads the information on the page.

Back up or restore the configuration
After you configure XBee Industrial Gateway device, back up the configuration settings. You can back
up the settings from the Remote Manager or the web interface.
Having a backup of the configuration settings is recommended if you run into one of the following
situations:

n You need to restore the configuration settings because a problem occurred.

n You upgraded or added the firmware and you need to restore your configuration settings.

n You added new devices that need to be configured and want to use the same configuration
settings as the original device. In this instance, you can load the backup configuration settings
from the original device onto other devices.

Back up and restore files from Remote Manager
1. Access Remote Manager and log in.

2. From the Devices page, click the devices in the Device list that you want to back up.

3. Click the More button within the toolbar and then select the Export Properties option from
under the Devices category.

4. Choose one of the following options from the Export Properties dialog and then click OK:

n Export all: Exports the device’s entire configuration. The option allows you to export
the entire configuration, including IP address information, and provides you with a
complete backup configuration for the device.

n Export all except unique network and device identity properties: Exports the
non-networking portion of the configuration. Choose this option if you want to use this
device's configuration as a template to apply to a group of devices in the future.

https://remotemanager.digi.com/
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Back up and restore files from the XBee Industrial Gateway web
interface
The Backup/Restore page allows you to back up and restore the following device configuration
settings to a file:

n XBee Industrial Gateway

n (Optional) XBee RF module

Back up files
To back up files from the XBee Industrial Gateway web interface:

1. Access and log into the web interface.

2. Click Administration > Backup/Restore.

3. In the Volume Information section, review the amount of free space available.

4. If you want to save the configuration settings for the XBee RF module along with the device
configuration settings, select the Include XBee gateway radio settings in the backup file
option.

5. In the Backup field, enter the name of the back up file.

6. Click OK to start the process.

Restore files
To restore files from the XBee Industrial Gateway web interface:

1. Access the XBee Industrial Gateway web interface. You are required to log in to the web
interface.

2. Click Backup/Restore under Administration.

3. Click Choose File in the Restore Configuration section.

4. Select the configuration file you want to restore.

5. Click OK.

6. Click Restore to restore the configuration from the selected file.

Backup/Restore page
The following fields and buttons appear on the Backup/Restore page:
Volume Information section: Displays information about the user file system, /userfs.

n Current Directory: The backup file is temporarily saved in this directory on the device. Note
that navigating to the file system is not possible on this page. To go to the file system, click File
Management under Administration and then go to the file system.

n Free Space: The amount of free space on the user file system. The typical size of a backup file
is about 8 KB.

Backup Configuration section: Downloads the gateway configuration file through the web browser
and allows you to save the file on your computer.

n Include XBee gateway radio settings in the backup file: If enabled, the configuration
settings for the XBee RF module are saved along with the device configuration settings.
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n Backup: The name of the backup file. The default file name is backup.cfg. You can change the
file name from the save file dialog box. Any name is allowed.

Restore Configuration section: Restores configuration settings from a backup file on your computer
or a server.

n Choose File: Opens a browse dialog for locating and selecting the appropriate configuration
file.

n Restore: Click Restore to restore the configuration from the selected file.

Errors
Any errors that occur during the restore process appear in a red banner at the top of the
Backup/Restore page. Typically, the only reason an error occurs is if a user has modified the backup
file. The following list provides some of the possible error messages.

n Invalid file contents: The file contents are not a valid backup format. This may be caused by
invalid XML syntax.

n Element set_setting has extra content (name): The settings group name is not recognized.

n Element set_setting failed to validate content (name): Incorrect value for setting name.

n Other RCI errors are possible, but are less common.

Update firmware
There are several types of firmware updates for XBee Industrial Gateway:

n XBee Industrial Gateway operating system: You can download Gateway operating system
firmware updates for XBee Industrial Gateway from the Digi Support site. You can then load
the firmware through the web interface or Remote Manager.

You can only upgrade the gateway operating system, not downgrade it, through the web
interface or Remote Manager. The firmware image contains a certificate that is verified before
XBee Industrial Gateway accepts an upgrade.

n XBee RF module on the gateway: See Update the local XBee Industrial Gateway firmware.

n XBee RF modules on your local network to be delivered Over the Air (OTA): As XBee
networks can involve a large number of nodes, Digi provides a way to schedule automatic XBee
Industrial Gateway firmware updates and manage firmware files. In the XBee Industrial
Gateway web interface, OTA firmware updates are performed from a page linked from the
XBee Configuration page. These firmware updates are supported for XBee ZigBee modules
only. For information on these updates, see XBee network OTA firmware updates.

Update firmware from Remote Manager
You can update the firmware from Remote Manager:

n Update the XBee Industrial Gateway device operating system firmware

n Update the local XBee Industrial Gateway firmware

n Update the XBee network node firmware (OTA updates) from Remote Manager

You can also schedule firmware updates from Remote Manager.

http://www.digi.com/support
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Update the XBee Industrial Gateway device operating system firmware
To update the XBee Industrial Gateway device operating system firmware:

1. Download the appropriate firmware from XBee Gateway product support page. For more
details on firmware filename conventions, see About firmware files.

2. Log in to Remote Manager.

3. Click the Device Management tab.

4. Select one or more devices from the device list to which you want to apply firmware updates,
right-click, and select Update Firmware.

5. Type or browse to the .bin filename containing the firmware update.

6. Click Update Firmware.

Update the local XBee Industrial Gateway firmware
To update the local XBee Industrial Gateway firmware:

1. Download the appropriate firmware from the XBee Gateway product support page. For more
details on firmware file name conventions, see About firmware files.

2. Log in to Remote Manager.

3. Click the Device Management tab.

4. Go to the device list.

5. Select one or more devices to which you want to apply firmware updates, right-click, and then
select Update Gateway XBee Radio Firmware.

6. Type or browse to the .ebl filename containing the firmware update.

7. Click Update Firmware.

The XBee Industrial Gateway firmware is updated. If the gateway is enabled, most XBee
Industrial Gateway module settings will be preserved when the firmware update completes.
Some settings, such as encryption keys, may not be preserved and must be entered again.

8. If required, type your encryption keys.

Schedule firmware updates
You can schedule firmware updates from Remote Manager. See the Digi Remote Manager User Guide
for more information on scheduling firmware updates.

1. Log in to Remote Manager.

2. Click the Device Management tab.

3. From the list, select the device for which you want to schedule a firmware update.

4. Right-click on the device, and choose Firmware > Update Firmware. The Update Firmware
dialog appears.

5. In the File field, enter or browse for the file containing the firmware update.

6. From the Schedule Options drop-down in the upper right corner of the dialog, select the

https://www.digi.com/products/xbee-rf-solutions/gateways/xbee-gateway#productsupport-firmware
https://remotemanager.digi.com/login.do
https://www.digi.com/products/xbee-rf-solutions/gateways/xbee-gateway#productsupport-firmware
https://remotemanager.digi.com/login.do
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://remotemanager.digi.com/login.do
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appropriate scheduling option.

7. Click Update Firmware to schedule the update.

Update firmware from the XBee Industrial Gateway web interface
Firmware updates are available from the Administration > Firmware Update page in the XBee
Industrial Gateway web interface.

n Update the XBee Industrial Gateway device operating system firmware

n Update the local XBee Industrial Gateway firmware

Update the XBee Industrial Gateway device operating system firmware
To update the XBee Industrial Gateway device operating system firmware:

1. Download the appropriate firmware from the XBee Gateway product support page. For more
details on firmware filename conventions, see About firmware files.

2. Access and log into the web interface.

3. Click Administration > Firmware Update. The Firmware Update page appears.

4. Select the Upgrade device operating system check box.

5. Click Next.

Status information for the firmware update appears, including the following information:

n Target Firmware: The device operating system firmware to be loaded on XBee
Industrial Gateway.

n Status: The current status of the firmware update operation.

For the XBee Industrial Gateway device operating system, the firmware update
operation moves through several states:

a. The web browser uploads the firmware file.

b. The firmware update is applied to the XBee Industrial Gateway operating
system. If the firmware update is successful, the message Firmware
Upgrades Completed Successfully appears. If errors occur during the
update, the message Completed with errors appears. If you need help
understanding the errors and viewing the log file containing the errors,
contact Digi Support.

c. XBee Industrial Gateway automatically reboots.

d. XBee Industrial Gateway returns to an operating state (run). All these states
are shown on the Firmware Update page.

Update the local XBee Industrial Gateway firmware
To update the local XBee Industrial Gateway firmware:

1. Download the appropriate firmware from the XBee Gateway product support page. For more
details on firmware filename conventions, see About firmware files.

https://www.digi.com/products/xbee-rf-solutions/gateways/xbee-gateway#productsupport-firmware
http://www.digi.com/support
https://www.digi.com/products/xbee-rf-solutions/gateways/xbee-gateway#productsupport-firmware
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2. Access and log into the web interface.

3. Click Administration > Firmware Update. The Firmware Update page appears.

4. Select the Upgrade local (gateway) XBee’s firmware check box.

5. Click Next.

6. Type or browse to the filename containing the firmware update.

7. Click Next.

Status information for the firmware update appears, including the following information:

n Target Firmware: The device operating system firmware to be loaded on XBee
Industrial Gateway.

n Status: The current status of the firmware update operation.

The XBee firmware is updated. If the gateway is enabled, most XBee module settings will be
preserved when the firmware update completes. Some settings, such as encryption keys, may
not be preserved and must be entered again.

8. If required, type your encryption keys.

About firmware files
Firmware files for the operating system and XBee module on XBee Industrial Gateway are available
through Digi Technical Support on the XBee Gateway Support page. Click the Firmware Updates link.

Gateway operating system firmware files
Gateway operating system firmware files have a .bin extension.

XBee RF module firmware files
XBee RF module firmware files have an .ebl extension. From the Digi XBee Gateway - Zigbee support
page, click the Firmware Updates option. You can select the product and then download the
firmware.
There is only one firmware file for the XBee RF module in XBee Industrial Gateway products. It is
named XBP24-S2C_40XX.ebl, where XX is the firmware version.
There are other possible file types for OTA firmware updates. See XBee network OTA firmware
updates.

Mobile device status
The items on Mobile Status page are specific to a cellular modem or service provider account. These
items vary in the information reported from modem to modem and also differ between LTE and GSM
services. A value that appears here depends on the modem type and connection state; if there is no
value for a status field, it does not appear. Use this information when troubleshooting issues and
communicating with technical support.

Display the mobile device status
To display the status of mobile device, choose one of the following options:

http://www.digi.com/support/productdetail?pid=5570
https://www.digi.com/support/productdetail?pid=5591
https://www.digi.com/support/productdetail?pid=5591
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From Remote Manager
1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Select System Information > Mobile Information. The Mobile Information page appears.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Click Administration > Mobile Status. The Mobile Status page appears.

Mobile Status page
The following table describes the fields on the Mobile Status or Mobile Information page.
In general, all of the status fields in the page may display for either GMS or LTE cellular modems. The
status fields display depending on the modem type, service, or registration or connection state.

Status field Description

Device type The type of cellular modem. The possible values are LTE and GSM.

Manufacturer The manufacturer of the cellular modem.

Model The manufacturer’s model number for the cellular modem.

Revision The manufacturer’s version number for the software running on the
cellular modem.

Serial number The manufacturer’s serial number for the cellular modem.

Phone number The phone number stored on the SIM. The SIM may not have a number
stored, or it may not be correct.

SIM IMSI The International Mobile Subscriber Identity (IMSI) for the SIM card. This
value is the account number for the mobile subscriber.

SIM ICCID The Integrated Circuit Card Identifier (ICCID) for the SIM card. This value
is the serial number of the SIM card.
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Status field Description

SIM PIN status Indicates the lock status of the SIM. There area many possible status
values. The most common status values are:

n READY: SIM is ready. The PIN was entered or no PIN is required.

n SIM PIN: A PIN is required to unlock the SIM. You can enter the
PIN from the Mobile Configuration page.

n SIM PUK, SIM PIN2, SIM PUK2, and similar codes: The SIM is
locked and cannot be unlocked by the XBee Industrial Gateway
cellular device. It must be placed in another device or phone to be
unlocked.

n Error: Either the SIM was not inserted or there was another SIM
problem.

SIM slot index This status only appears for products that support multiple SIMs.
Indicates which SIM slot is currently in use by the device.

n 1 means the first slot.

n 2 means the second slot.

Signal strength Received cellular signal strength indicator (RSSI) for GSM. A measure of
the signal level of the network.
Different RSSI levels are used by GSM to determine the number of bars.

n For GSM: -108 or more is 1 bar, -93 is 2, -77 is 3 bars.
Reference Signal Received Power (RSRP) for LTE. A measure of the signal
level of the network.

n For LTE: -118 or more is 1 bar, -106 is 2, -90 is 3 bars.

Signal level The number of bars indicates the strength of the received cellular signal.
n 0: No signal

n 1: Poor signal

n 2: Adequate signal

n 3: Good signal

Signal quality An indicator of the quality of the received cellular signal, measured in dB.
This value is also known as Ec/Io.
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Status field Description

Registration status The status of the cellular modem’s connection to a cellular network.
n Not registered

n Registered (Home network)

n Searching for Network

n Not Registered (Access Denied)

n Not Available (Reason not Known)

n Registered (Roaming)

Cell ID Identifier of the cellular base station with which the cellular modem is
registered.

Location area code Identifier of the location of a group of cellular base stations with which
the cellular modem is registered, in hexadecimal format.

Mobile country code Identifies a mobile phone operator/carrier with which the cellular modem
is registered.

Mobile network code Identifies a mobile phone operator/carrier with which the cellular modem
is registered.

Operator name The name of the mobile operator with which the modem is registered.
This corresponds to the mobile country and network codes.

Band The radio frequency band used by the modem.
LTE can use one of the following bands:

n Band 2

n Band 4

n Band 5

n Band 13

Service The type of data service provided by the cellular network. For LTE, the
data service is one of the following:

n None

n 1xRTT

n EVDO Rev 0

n EVDO Rev A
Future cellular modems may have other values.

Channel Radio channel being used by the cellular modem.

Profile The current set of mobile configuration settings used to configure the
cellular modem. XBee Industrial Gateway cellular products always use
profile 0.
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Status field Description

Connection state The operating state of the cellular modem. The possible states are as
follows:

n Initializing: Resetting and configuring the modem.

n Registering: Searching for the modem's cellular network.

n Delay before connecting: The modem delays after an
unsuccessful connection (Verizon only).

n Connecting: Establishing a mobile data connection.

n Connected: Established an active mobile data connection .

n Disconnecting: Ending the mobile data connection.

n Disconnected: Ended the mobile data connection. See Disconnect
reason for the cause.

n Disabled: The mobile data connection is disabled in the
configuration settings.

n PRL update: Updating the preferred roaming list (LTE only).

n Operator scan: Searching the modem for available mobile
operators (GSM only).

n No device found: The modem is not available or is
malfunctioning.

Connection duration Amount of time the current mobile data connection has been active. The
format is N days HH:MM:SS.
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Status field Description

Connection error This status appears only after a connection error occurs. The possible
reasons the previous connection attempt failed are as follows:

n SIM PIN required: The SIM PIN must be entered on the Mobile
Configuration page.

n SIM PIN incorrect: The SIM PIN entered does not match the
actual one for the SIM.

n SIM not ready: No SIM inserted or other SIM problem.

n Not registered: The modem did not register with a cellular
network.

n Dial failed: Error starting data connection.

n Authentication failed: Incorrect login or password entered on
the Mobile Configuration page.

n Connection timeout: Connection did not complete.

n Device reset error: The modem could not be reset.

n Device open error: The modem is malfunctioning.

n Device config error: The modem could not be configured.

n PPP error: Internal system error.

Disconnect reason This status appears after a previous connection ends. The possible
reasons the previous connection ended are as follows:

n User requested: Initiated by user action.

n Network disconnect: Initiated by cellular network or carrier.

n Carrier loss: Poor signal or disconnected by network.

n Connection timer: Connection did not complete.

n Receive idle timer: No data received for configured receive idle
time.

n Device monitoring error: Error while monitoring the modem
status. May indicate a malfunctioning modem.

IP address Internet protocol address of the mobile data interface. You can contact
the device at this IP address if permitted by the carrier.

DNS primary address IP address of the primary Domain Name System (DNS) server assigned by
the mobile carrier. This server resolves domain names to IP addresses.
See Default behavior regarding DNS for more information on how XBee
Industrial Gateway uses the DNS primary and secondary address.

Receive idle time The amount of time since the cellular modem last received data.

Transmit idle time The amount of time since the cellular modem last transmitted data.
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Status field Description

Connections The number of mobile data connection attempts since the XBee
Industrial Gateway cellular device was started.

Connection errors The number of unsuccessful mobile data connection attempts since the
XBee Industrial Gateway cellular device was started.

Carrier loss The number of times the connection was lost because of poor signal or
being disconnected by the network.

LCP echo failed The number of failed Link Control Protocol (LCP) echo requests that were
sent after a “quiet” interval to test the cellular link and/or keep it alive.
Not used by XBee Industrial Gateway cellular products.

Idle timeout The number of connection resets that occurred because the idle timeout
reached/exceeded the maximum allowed for transmitted and received
data.

User disconnect The number of disconnects of the cellular connection performed by
device users.

Monitoring errors Number of errors encountered while monitoring the cellular modem
status. May indicate a malfunctioning modem.

Device resets Number of cellular modem resets caused by errors, failed connection
attempts, or user requests.

Received bytes Number of bytes received by the cellular modem during the current data
session.

Transmitted bytes Number of bytes transmitted by the cellular modem during the current
data session.

Total received bytes Total number of bytes received by the modem since the XBee Industrial
Gateway cellular device was started.

Total transmitted bytes Total number of bytes transmitted by the modem since the XBee
Industrial Gateway cellular device was started.

Change the password for the web interface
You can change the current password for the python user account, which is used to access the web
interface. You can use any of the methods described below. The password must have a minimum of
eight valid, printable, ASCII characters.

Note Each device has a unique, default password printed on the device label. If the password is not on
the device label, the default password is dbps. If neither these defaults work, the password may have
already been updated. Contact your system administrator for help.

Linux command shell
1. Connect and log in to the XBee Industrial Gateway device.

2. At the prompt type: passwd
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3. At the Old Password prompt, enter the current password.

4. At the New Password prompt, enter the new password.

Web interface
1. Access the XBee Industrial Gateway web interface.

2. Select Configuration > Authentication.

3. In the Current Password field, enter the current password.

4. In the New Password field, enter the new password.

5. In the Confirm Password field, re-enter the new password.

6. Click Apply.

RCI from the Linux command shell
1. Connect and log in to the XBee Industrial Gateway device.

2. Type the following, replacing NEW_PASSWORD with the new password you wish to use and
CURRENT_PASSWORD with your existing password:

rci_request '<do_command target="set_

password"><login>python</login><password>NEW_PASSWORD</password><current_

password>CURRENT_PASSWORD</current_password></do_command>'

Note If the password contains the following characters, you will need to escape those
characters following standard Linux shell conventions: ' (apostrophe), < (less than sign), >
(greater than sign).

3. If successful, the following message appears:

<rci_reply version="1.1"><do_command target="set_password"></do_

command></rci_reply>

If an error is encountered, the following message appears:

<rci_reply version="1.1"><do_command target="set_password"><error

id="4"><desc>Update failed</desc><hint>password</hint></error></do_

command></rci_reply>

You can check the system logs for more information on the error.

RCI from Python
The rci module in Python can process RCI using the process_request method. It accepts as a
single argument an RCI request, and returns the response. The set_password request matches the
request used in RCI from the Linux command shell (as described above), but wrapped in the rci_
request tag.
Copy and enter the code below, replacing NEW_PASSWORD with the new password you wish to use
and CURRENT_PASSWORD with the existing password.
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<rci_request>
<do_command target="set_password">
<login>python</login>
<password>NEW_PASSWORD</password>
<current_password>CURRENT_PASSWORD</current_password>

</do_command>
</rci_request>

Note The set_password do_command to change the python password is only available in XBee
Industrial Gateway firmware versions 3.2.30.x and newer.

RCI from Digi Remote Manager
1. From a web browser, log in to Remote Manager.

2. Select Documentation > API Explorer. The API console appears.

3. From the API console, select POST HTTP Method and write the following SCI request, as
follows:

<sci_request version="1.0">

<send_message>

<targets>

<device id="{device_id}"/>

</targets>

<rci_request version="1.1">

<do_command target="set_password">

<login>python</login>

<password>NEW_PASSWORD</password>

<current_password>CURRENT_PASSWORD</current_password>

</do_command>

</rci_request>

</send_message>

</sci_request>

Where:

n {device_id} is the ID of your XBee Industrial Gateway device.

n NEW_PASSWORD is the new password you want to use.

n CURRENT_PASSWORD is the existing password.

4. Click Send.

Update the cellular modem firmware
For best performance, you should update the Telit LE910 cellular modem to the latest cellular modem
firmware supported by the device.
A cellular modem firmware update is needed only if the version does not match the versions listed
below. The latest revisions supported are:

https://remotemanager.digi.com/login.do
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n Verizon: 20.00.016.1

n AT&T: 20.00.526.0

If the version matches, you do not need to update the firmware.

Prerequisites
n Digi XBee Industrial Gateway firmware version 3.2.29.8 (PN 82004081) or later

n Telit LE910 modem on the device

n Remote Manager account

n Device ID of the gateway you want to update

n Modem IMEI

n fota.exe application (PN 80010027)

Step 1: Determine the current version of the Telit modem
Verify the modem revision.

1. Determine the current version of the Telit LE910 modem.
a. Access the XBee Industrial Gateway web interface.

b. Choose Administration > Mobile Status.

c. Refer to the version listed in the Revision field.

2. Determine what modem firmware revisions are available.

Note If there isn’t a fourth field in the revision, the gateway’s firmware needs to be updated first so
that the fourth field can be determined. If the modem is already at the desired revision, no modem
firmware update is needed.

Step 2: Determine if an update is needed and the update file name
to use
Determine which update file is needed. Depending on your current version, you may have to perform
multiple updates to get to the latest version.
If the most recent update file matches the current version on your Telit modem, found in Step 1, no
update is needed.

1. Go to: http://ftp1.digi.com/support/Telit/

2. Find the most recent update file, which will look like one of these examples:
n UpdPkg_LE910_NA1_1G_SKU_<source_version>_<destination_

version>.bin

n UpdPkg_LE910_SV1_1G_<source_version>_<destination_version>.bin

Where <source_version> is the modem's current version and <destination_version> is the
latest or desired version.

3. Make a note of the name of the update file that you are going to apply to the Telit modem. This
will be required in a future step.

https://www.digi.com/support/productdetail?pid=5640&type=firmware
ftp://ftp1.digi.com/support/telit/80010027.zip
http://ftp1.digi.com/support/Telit/
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Step 3: Update the cellular modem firmware
This section describes how to update the modem over the air. The update process is initiated from
Digi Remote Manager. It requires a working cellular connection. It does not require physical access to
the device.

Prerequisites

Step A: Open Remote Manager and get the device ID
1. Open a web browser and navigate to https://remotemanager.digi.com.

2. Log into your account.

3. Click on the Device Management tab.

4. Find your device using the device ID.

5. Double-click to open your device.

6. Click Edit Device Configurations to view the device ID. The device ID looks like: 00000000-
00000000-0004F3FF-FFxxxxxx. It contains the MAC address of the modem. You will need the
device ID later to start the FOTA process.

Step B: Confirm the current firmware revision
1. In Digi Remote Manager, select System Information > Mobile information.

2. Note the current Revision.

Note If there isn’t a fourth field in the revision, the gateway’s firmware needs to be updated first so
that the fourth field can be determined. If the modem is already at the desired revision, no modem
firmware update is needed.

Step C: Determine the update string

Note In this step you will need the name of the update file you previously selected in Step 2:
Determine if an update is needed and the update file name to use.

1. Get the fota.exe application. (PN 80010027)

2. Following the example below, replace the highlighted sample update file name with the file
name to which you want to update your Telit modem. Patch the #update file name# in
the line below with the correct value from Step 2: Determine if an update is needed and the
update file name to use.

C:\>fota ftp1.digi.com 21 anonymous test support/#update file name#

An example is below, with a sample update file name highlighted:

C:\>fota ftp1.digi.com 21 anonymous test support/telit UpdPkg_

LE910_SV1_1G_20.00.012.2_20.00.015.0.bin

https://remotemanager.digi.com/
ftp://ftp1.digi.com/support/telit/80010027.zip
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3. Generate the update string. An example update string is below:

ZnRwMS5kaWdpLmNvbQAyMQBhbm9ueW1vdXMAdGVzdABzdXBwb3J0L3RlbGl0AFVwZF

BrZ19MRTkxMF9TVjFfMUdfMjAuMDAuMDEyLjJfMjAuMDAuMDE1LjAuYmlu

4. Make a note of the string, as it will be used in the next step, Step D: Initiate the firmware
update.

Step D: Initiate the firmware update
In this step, you will need the device ID and the update string.

1. In the Remote Manager, select Documentation > API Explorer.

2. Select Examples/SCI/Data Service/Send Binary Request.

3. A template request (in XML) appears. Delete the template and replace with XML below.

4. Patch the #Device ID# with the correct value from Step A: Open Remote Manager and get
the device ID.

5. Patch the #update string# with the update string from Step C: Determine the update
string.

<sci_request version="1.0">

<data_service allowOffline="false” synchronous="true">

<targets>

<device id="#Device ID#"/>

</targets>

<requests>

<device_request target_name="FTP_OTA" format="base64">

#update string#

</device_request>

</requests>

</data_service>

</sci_request>

6. Click Send.

7. Enter your user name and password.

8. Once started, the update will take a few minutes to complete. After the device completes the
pdate, it will reconnect to Digi Remote Manager.

Updating multiple devices
The above example shows how to update a single XBee Industrial Gateway. More than one device can
be updated with a single Remote Manager request.

Note All devices in the request must have the same modem revision and update string. Devices will
individually connect as scheduled and perform the update.

To update a list of devices, add their device IDs to <targets> in the request. For example:
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<targets>
<device id="00010000-00000000-03566100-79000697"/>
<device id="00010000-00000000-03566100-79000698"/>
<device id="00010000-00000000-03566100-79000699"/>
<device id="00010000-00000000-03566100-7900069A"/>
<device id="00010000-00000000-03566100-7900069B"/>

</targets>

To update all devices in a Remote Manager group, add the group name to <targets>. For example:

<targets>
<group path="my_group"/>

</targets>

See the Digi Remote Manager User Guide and Digi Remote Manager Programming Guide on the Remote
Manager Documentation tab for more information.

Step E: Verify that the update was successful
Confirm the new modem firmware revision. See Step 1: Determine if an update is needed for
information about finding the revision.

Troubleshooting the update
If the device does not report the expected revision, follow these steps:

1. Check if the device has connected to Digi Remote Manager since the firmware update was
initiated. Select Connection History on the Digi Remote Manager device page.

2. Update device information by clicking Refresh at the bottom of the device page.

3. Try the update again.

4. If none of the above work, contact Digi Tech support at tech.support@digi.com.

Display the XBee Industrial Gateway End User License Agreement
(EULA)

You can access the End User License Agreement (EULA) for XBee Industrial Gateway from the web
interface.

Note The XBee Industrial Gateway EULA is not available through Remote Manager.

1. Access and log into the web interface.

2. Click Legal Notices under Administration. The EULA for XBee Industrial Gateway appears.

Reboot XBee Industrial Gateway
You can reboot XBee Industrial Gateway as needed. Note that XBee Industrial Gateway reboots itself
if you make changes to the configuration that require a reboot to activate those changes.
To reboot XBee Industrial Gateway, choose one of the following options:
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n From Remote Manager, right-click the XBee Industrial Gateway device and select More >
Reboot.

n From the web interface, click Administration > Reboot.

Wait approximately one minute for the reboot to complete.

Display system information
To display system information, choose one of the following options:

From Remote Manager
1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Click System Information. The System Information page appears.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. View general system information and system statistics from the Home page.

Disconnect XBee Industrial Gateway from Remote Manager
You can disconnect XBee Industrial Gateway from Remote Manager.

1. Log in to Remote Manager.

2. Click the Device Management tab.

3. From the device list, select the XBee Industrial Gateway device that you want to disconnect.

4. Select More > Disconnect. A confirmation dialog displays.

5. Click Yes to complete the disconnect process.

If XBee Industrial Gateway is configured to automatically reconnect to Remote Manager, the
device re-establishes the connection to Remote Manager after its reconnection timeout period
has expired.

https://remotemanager.digi.com/


About programming

XBee Industrial Gateway offers a variety of interfaces that produce and/or consume data. Developing
software programs for XBee Industrial Gateway products allows Digi customers to provide custom
logic to control the information to and from these interfaces.
This section introduces the Digi programming tools and resources available to you. You can also see
Program XBee Industrial Gateway using Python to learn about programming elements and operations
available for XBee Industrial Gateway using annotated example programs.

Python
XBee Industrial Gateway features a standard Python 2.7 distribution, allowing you to develop and test
applications that are not dependent on Digi-proprietary interface modules. Python is a dynamic,
object-oriented language for developing software applications, from simple programs to complex
embedded applications.
The standard Python 2.7 distribution has a more complete library set than the versions supported in
predecessor gateway products, and integrates well with standard Python. You can typically transfer
scripts developed in this manner to the device for final testing at the end of the development cycle,
with a computer serving as a device proxy during the bulk of development.
For detailed information about programming with Python, see Program XBee Industrial Gateway
using Python.
The sections below describe the basic Python applications that you may use:

n Python: XBee Industrial Gateway features a standard Python 2.7 distribution, allowing you to
develop and test applications that are not dependent on Digi-proprietary interface modules.
Python is a dynamic, object-oriented language for developing software applications, from
simple programs to complex embedded applications.

For more information, see Program XBee Industrial Gateway using Python.
n XBee Industrial Gateway Python application: The XBee Industrial Gateway Python

application resides on XBee Industrial Gateway. Its key functions include connecting your XBee
modules to Remote Manager, enabling uploads of data to Remote Manager, and receiving
remote text and commands. Python application is installed by default in your XBee Industrial
Gateway device and automatically starts when the gateway is initialized.

For more information on the XBee Industrial Gateway Python application, see XBee Industrial
Gateway Python application and Remote Manager.

n Digi ESP: Digi ESP is an IDE featuring device detection, debugging, compiling, and downloading
of Device Integration Application (DIA)/Python code to Digi gateways.

For more information, see Digi ESP for Python.
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n DIA: Device Integration Application (DIA) is an application software platform for Digi gateways.
DIA makes it easy to connect remote devices and sensors to Digi gateway products.

For more information, see DIA software.
n Linux command shell: The Linux command shell interface that is available on XBee Industrial

Gateway is useful for some programming and device management tasks. With the Linux
command shell, you can experiment with the Python interpreter interactively, create scripts,
launch scripts, and control the script operation.

For more information, see Linux command shell (command line interface).

XBee ZigBee Cloud Kit web application source code
You can use the XBee ZigBee Cloud Kit web application source code and other tools available on
Github to build your own custom applications.
The source code for the XBee ZigBee Cloud Kit web application is located at
https://github.com/digidotcom/XBeeZigBeeCloudKit.
For more information on the XBee ZigBee Cloud Kit, see the XBee ZigBee Cloud Kit support page.

Programming calls through Server Command Interface (SCI) and
Remote Command Interface (RCI)

You can use the Web Services Server Command Interface (SCI) and the Remote Command Interface
(RCI) as an alternative means of getting settings and state data from the device. For more
information, see:

n SCI (Server Command Interface) chapter of the Digi Remote Manager Programmer Guide

n Remote Command Interface (RCI) Specification document

XBee Industrial Gateway file system
XBee Industrial Gateway supports standard Linux shell file operations for managing directories and
files.
You can access the file system resident on XBee Industrial Gateway through the following interfaces:

n Web interface

n Command line interface

n Remote Manager

Important directories

/WEB/python
The /WEB/python/ directory contains user-specific files, such as custom Python applications. You can
create subdirectories in this area for the customer's applications. This area is read-write.

/WEB/logging
The /WEB/logging directory contains system log files, including eventlog.txt, python.log, digi.log,
xbee.log, and sef.log. These files are read-only. For more information on these files, see XBee

https://github.com/digidotcom/XBeeZigBeeCloudKit
https://www.digi.com/support/productdetail?pid=5605
http://www.digi.com/resources/documentation/digidocs/90002008/default.htm#reference/r_ws_sci.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90000569/default.htm
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Industrial Gateway system log.

Load applications onto XBee Industrial Gateway
To load an application onto XBee Industrial Gateway, use the File Management function in Remote
Manager or the XBee Industrial Gateway web interface. For instructions, see File management.
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XBee Industrial Gateway features a standard Python 2.7 distribution, allowing you to develop and test
applications that are not dependent on Digi-proprietary interface modules. Python is a dynamic,
object-oriented language for developing software applications, from simple programs to complex
embedded applications.
The standard Python 2.7 distribution has a more complete library set than the versions supported in
predecessor gateway products, and integrates well with standard Python. You can typically transfer
scripts developed in this manner to the device for final testing at the end of the development cycle,
with a computer serving as a device proxy during the bulk of development.
The following sections contain information about programming XBee Industrial Gateway with Python:

Find Python learning resources 68
Digi-specific Python modules for programming 68
Sample programs 68
XBee Industrial Gateway Python application and Remote Manager 71
Digi ESP for Python 96
DIA software 99
Linux command shell (command line interface) 100
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Find Python learning resources
You can learn more about programming with Python by referring to the following sections.

Python 2.7 documentation
You can find information about how to learn and use the Python programming language, and
reference material for the Python 2.7 standard library.

Python support forum
You can find answers to common questions and exchange ideas and examples with other members of
the Digi Python development community at the Digi Forum.

Digi Python Wiki Archive Reference Manual
The Digi Python Wiki Archive Reference Manual provides references for developing solutions using the
Digi communications portfolio, software and services, including Python, Remote Manager, DIA, and
more. This manual includes how-to's, example code, and M2M information to speed application
development.

Digi-specific Python modules for programming
Several Digi-provided built-in modules apply to functionality in XBee Industrial Gateway and are
documented in the ConnectPort X2e section in the Digi Python Wiki Archive Reference Manual. From
that section, you can go to the information pages on these modules:

n digihw: Provides an interface to local hardware.

n idigimsg: This is an internal module with functions used by DIA and Smart Energy Framework.

n rci: Provides a mechanism for processing arbitrary RCI request strings, as well as a means to
set up callbacks to allow Python scripts to respond to remote requests made via specialized
RCI commands.

n uptime: Allows access to the Linux gettime function for various clocks.

n watchdog: A safeguard that an application can use for critical operations, in which, if the
application threads do not service their watchdog within the promised interval, the entire
system reboots.

n xbee: A collection of utility methods for programming the XBee RF module on XBee Industrial
Gateway. It also includes the Python XBee socket interface support.

Sample programs
These simple annotated samples introduce several programmable features for XBee Industrial
Gateway, including:

n LED control

n Watchdog

n RCI callback

n XBee functions

https://docs.python.org/2.7/
http://www.digi.com/support/forum/categories/
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_welcome.htm%3FTocPath%3DWelcome%2520to%2520Digi%2520Python|_____0
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_connectport_x2e.htm%3FTocPath%3DCategories|Drop-in%2520Networking%2520Products|_____3
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_welcome.htm%3FTocPath%3DWelcome%2520to%2520Digi%2520Python|_____0
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LED control
Controlling the LEDs on XBee Industrial Gateway is handled through the user_led_set function. This
sample program controls the Network LED.
Note that if native features are still assigned to the LED, those behaviors will mix with the behaviors in
the sample program.

Note The highlighted numbers in the sample code correspond to the items in the Program Notes,
below.

import digihw (1)
import time

while True:
         digihw.user_led_set(True,1) (2)
         time.sleep(1.0)
        digihw.user_led_set(False,1) (3)

        digihw.user_led_set(True, 2) (4)
        time.sleep(1.0)
        digihw.user_led_set(False,2) (5)

Program notes
1. The digihw module includes the user_led_set function needed by the program. The user_led_

set has two are two parameters: value and led. The user controlled LED is made to match the
logic state of the “value” parameter. A value of “True” turns on the LED, and a value of “False”
turns it off. The “led” parameter indicates which user LED to blink, with LED 1 being the default.

2. Turn on the “yellow” Network LED.

3. Turn off the “yellow” Network LED.

4. Turn on the “green” Network LED.

5. Turn off the “green” Network LED.

Watchdog
The watchdog feature, provided through the watchdog module, exists as a safeguard. If there are
critical operations that “must” happen periodically, or else the system will be irretrievably broken, an
application can request that a “watchdog” be established. If the application threads do not service
their watchdog within the promised interval, the entire system reboots. You can change or, if
necessary, delete the intervals for these software watchdogs. Using a software watchdog exists as a
measure of last resort. Appropriate error detection and handling with Python scripts is certainly
recommended.
The following sample program demonstrates the watchdog feature.

Note The highlighted numbers in the sample code correspond to the items in the Program Notes,
below.

import watchdog (1)
import time

w=watchdog.Watchdog('test',20) (2)
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for x in xrange(1,6): (3)
  print "Step ", x (4) 
  time.sleep(10.0) (5)
  w.heartbeat() (6)
print "Step just before the end..." (7)
time.sleep(60.0) (8)
print "Step after the end." (9)

Program notes
1. The watchdog module includes the Watchdog class needed by the program.

2. Create a watchdog object named “test” that will expire in 20 seconds.

3. Loop five times (1-5).

4. Indicate our iteration...

5. ... sleeping less than the timeout on each iteration, but more time than the timeout in total.

6. Reset the watchdog timer to 20 seconds each iteration, allowing all of the loops to complete.

7. Indicate that small loops are complete.

8. Sleep for an interval much longer than the timeout.

9. This print statement never executes, because the system will reboot when the watchdog
timeout expires.

RCI callback
An RCI callback involves two types of actions, demonstrated in the following programs:

n Making RCI requests from Python applications.

n Extending RCI to allow Remote Manager to make requests of Python applications. This is
known as an RCI callback.

The following example shows an RCI request.

Note The highlighted numbers in the sample code correspond to the items in the Program Notes,
below.

  import rci (1)

  request_string=""" (2)
<rci_request version="1.1">
  <query_state>
    <interface_info name="eth0">
      <ip/>
    </interface_info>
  </query_state>
</rci_request>
"""

print rci.process_request(request_string) (3)

Program notes
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1. The rci module includes the process_request function needed by the program.

2. A string representing the RCI request is needed. This sample uses the Python multi-line string
syntax to make it clear that the XML represents a request for the current IP address of the
Ethernet interface. Combining the lines into a single string on one line would work in the same
way.

3. The RCI XML is submitted for parsing, and the resulting string is returned. In this sample, the
result is simply printed.

Following example shows a simple RCI callback:

import rci (1)

def cb(req): (2)
         print "Received request: " + req (3)

r=rci.RciCallback() (4)
r.register_callback('test', cb) (5)

rci.process_request('<rci_request version="1.1"><do_command
target="test"><customxml/></do_command></rci_request>')(6)

Program notes
1. The RCI module includes the RciCallback class needed by the program.

2. Create a function to be called whenever a remote entity wants to communicate with this
script.

3. This simple function will simply demonstrate that it received a request that could be parsed
and handled however the application saw fit.

4. Create a callback object.

5. Assign the target “test” to the new callback object. If a remote entity issues a “do_command”
with the target “test”, the supplied callback function will be called.

6. This is simply an example that causes the callback to be called. This example could also have
been a remote SCI query through Remote Manager.

XBee functions
For a description of the XBee module and program samples, see the ZigBee module information
section in the Digi Python Wiki Archive Reference Manual.

XBee Industrial Gateway Python application and Remote Manager
The XBee Industrial Gateway Python application is an application that resides on XBee Industrial
Gateway. It allows you to connect your XBee modules to Remote Manager, enabling them to upload
data to Remote Manager and receive remote text and commands. The XBee Industrial Gateway
Python application is already installed in your XBee Industrial Gateway device and automatically starts
when the gateway is initialized.
For a complete description of Remote Manager, see the Digi Remote Manager User Guide on the
Remote Manager support page.

https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_module_xbee.htm
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_welcome.htm%3FTocPath%3DWelcome%2520to%2520Digi%2520Python|_____0
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/products/cloud/digi-remote-manager#productsupport


Program XBee Industrial Gateway using
Python

XBee Industrial Gateway Python application and Remote
Manager

Digi XBee Industrial Gateway 72

How does the XBee Industrial Gateway Python application work?
XBee Industrial Gateway and XBee Industrial Gateway Python application software combination acts
as a bridge between your XBee network and Remote Manager. This means that using the capabilities
provided by Remote Manager, you can communicate with and manage not just XBee Industrial
Gateway, but also all the XBee modules of the network individually. Similarly, all the XBee modules can
report data to Remote Manager and store the data there to be retrieved later.
Consumer applications, such as web apps, mobile apps, and so on, can use Remote Manager web
services to retrieve data stored by the XBee modules and represent it in different ways, or talk
directly with any of the XBee modules to configure them, activate Digital Input/Output (DIO) lines, etc.
The following figure illustrates the role of XBee Industrial Gateway and XBee Industrial Gateway
Python application in such a scenario.

Key features and operations of the XBee Industrial Gateway Python
application
The XBee Industrial Gateway Python application provides the following features:
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n Automatically store status information for DIO and Analog-to-Digital Converter (ADC) lines
reported by the XBee nodes of the network in Remote Manager.

n Receive serial data from Remote Manager and send it to the corresponding XBee module of
the network.

n Receive serial data from an XBee node of the network and store it in Remote Manager
automatically.

n Set the value of the DIO lines of any XBee module in the network through Remote Manager.

XBee Industrial Gateway Python application requirements
You must complete the following requirements before you can use the XBee Industrial Gateway
Python application and Remote Manager capabilities:

1. A Remote Manager account. If you do not have a Remote Manager account, follow the
instructions in the create a Remote Manager account section in the Digi Remote Manager User

Guide.

2. Your XBee Industrial Gateway device must be registered in your Remote Manager account.
Follow the instructions in the register a device section in the Digi Remote Manager User Guide.

3. The XBee Industrial Gateway Python application must be running in your XBee Industrial
Gateway device. By default, the XBee Industrial Gateway Python application is already installed
and running on the XBee Industrial Gateway devices; that is, the application executes
automatically when the device is initialized. Therefore, you do not have to start the application.
If you uninstalled the application, use the File Management function in Remote Manager or the
XBee Industrial Gateway web interface to install the XBee Industrial Gateway Python
application again.

Store status data for XBee lines in Remote Manager
You can configure XBee nodes in a network to report information about the status of the DIO lines and
ADC values to the coordinator or other nodes in the network. This scenario is very common when the
XBee node is attached to one or more sensors to monitor a process or some environment values. In
such a case, you may want to report the data from the sensor(s) to the coordinator every time a line
changes its status or every period of time. Using the XBee Industrial Gateway Python application, you
can automatically upload those values to Remote Manager, store them there, and retrieve the values
later for use by other user applications.
Whenever an XBee module in the network reports the status of the DIO lines and ADC values to XBee
Industrial Gateway, the XBee Industrial Gateway Python application automatically handles the XBee
frame containing those values, processes it, and uploads the reported values to Remote Manager.
This process generates a data stream for each of the different measures reported by the XBee
module. For more information about data streams are, see the Digi Remote Manager Programmer
Guide. The following figure demonstrates the process of storing status data on Remote Manager.
Using the Remote Manager Web Services API, you can retrieve the data stream values from Remote
Manager to be used in end user applications with different purposes, for example, to display a
histogram or generate a database. To learn more about the Remote Manager Web Services API, see
the Digi Remote Manager Programmer Guide.

https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#tasks/t_create_new_account.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#concepts/c_adding_devices.htm%3FTocPath%3DDevice%2520management|Adding%2520and%2520removing%2520devices|_____0
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
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Example: Configure the XBee node to report line and upload status
You can configure an XBee node from the network to report the status of the DIO1 each time it
changes and verify that the values are uploaded to Remote Manager.
To configure XBee node to report line and upload status:

1. Ensure the XBee device you are going to configure is attached to an XBee Interface Board
(XBIB). You will use the User Button 3 (SW3) of the XBIB to change the status of DIO1 as it is
directly connected to the DIO1 of the module.

2. From a web browser, go to the Home page of your XBee Industrial Gateway web interface.

3. Under Configuration, click XBee Network. The XBee Configuration page appears.
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4. Click the Discover XBee Devices button to locate the remote XBee devices that are in the
same network as XBee Industrial Gateway. 

5. Click the XBee device that you want to configure.

6. From the XBee Configuration page, click Input/Output Settings.

7. Under I/O Pin Settings, configure I/O Pin 1 (AT setting D1) to Digital Input (3) and change
the value of the DIO Change Detect (IC) setting to 0x2. These settings configure DIO1 as
input. Each time the value of DIO1 changes, the XBee device sends an XBee packet to XBee
Industrial Gateway with the new value of the DIO. In addition, the XBee Industrial Gateway
Python application uploads the new value to Remote Manager.

8. On the XBIB, press the User Button 3 (SW3) several times. This action causes the XBee
module report the status of DIO1.

9. From a web browser, log in to Remote Manager.

10. From Remote Manager, click Data Services. The Data Services page appears.

https://remotemanager.digi.com/login.do
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11. Click Data Streams. The Data Streams view contains all the data streams, or data channels, of
the devices that you have registered in your account.

There you will find the streams generated by any XBee node from your network that reported
any data. The data streams follow this pattern:
[device_id]/[source]/[xbee_mac]{/[dio_number]}

Where:
n [device_id] Is the ID of your XBee Industrial Gateway.

n [source] Is the source of the data. Legal values are:
l xbee.digitalIn

l xbee.analog

l xbee.serialIn

n [xbee_mac] Is the MAC Address of the XBee node that reported the data in the
following format:
[XX:XX:XX:XX:XX:XX:XX:XX]!

n [dio_number] Is the name of the DIO that generated the data. This is only present if
the [SOURCE] is xbee.digitalIn or xbee.analog.

One of those streams should correspond to the DIO1 of your XBee device. For example:
00000000-00000000-00409DFF-FF5C388D/xbee.digitalIn/

[00:13:A2:00:40:31:A8:E1]!/DIO1

12. Click the serial data stream that correspond to the DIO1 of your XBee device. Note how the
values stored have been changed between 0 and 1. For example:

Each stream contains a historical view of the values of the data channel it represents. To
display the historical values, switch from the Table to Chart view.
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Receive serial data from Remote Manager
In some scenarios, you can attach an XBee module to a microcontroller that can manage the radio
module, configure it, process data reported by the module, and execute actions. In those cases, the
combination of XBee module and microcontroller can use a custom communications protocol
transmitted wirelessly from an XBee network node to the target XBee node, and via serial from the
target XBee node to the microcontroller to which it is attached.
The XBee Industrial Gateway Python application allows sending a serial data packet through Remote
Manager, using the Web Services API, to a specific XBee module or all XBee modules in the network
that will be transmitted through its serial interface. That serial packet can contain any data, including
the custom protocol that your XBee module and microcontroller use to communicate between them.
The following figure demonstrates the process for receiving serial data from Remote Manager.
To send serial data to one of the XBee nodes on your network through Remote Manager, you need to
use the Remote Manager Web Services API. In this case, you need to send a POST command
containing a Server Command Interface (SCI) request to Remote Manager. The SCI request in turn
contains a Remote Command Interface (RCI) do_command element, with xbgw as target attribute
and the send_serial command as content. To learn more about SCI requests, the RCI protocol, and
the Web Services API, see the Digi Remote Manager Programmer Guide.

https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
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send_serial command definition
The send_serial command sends serial data to a specific XBee node in your network. To use this
command, add it to an SCI request inside the RCI do_command element.
Command syntax
The send_serial command must follow this syntax:
<send_serial addr=”{address|broadcast}” encoding={“base64”|”utf-
8”}”>value</send_serial>

Command attributes
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n addr
l Usage: Required.

l Description: This attribute indicates the destination address of the node to which the
content indicated by the command body should be transmitted.

l Value: Legal values for this attribute include:

The 64-bit IEEE address of the node following one of these patterns:
XX:XX:XX:XX:XX:XX:XX:XX

[XX:XX:XX:XX:XX:XX:XX:XX]!

XXXXXXXXXXXXXXXX

XX-XX-XX-XX-XX-XX-XX-XX

The string broadcast, which transmits the string to all nodes using a broadcast packet.

n encoding
l Usage: Optional.

l Description: Specifies how the character data in the command elements is processed.

l Value: The following encoding types are allowed:
o base64: Use Base64 encoding. Character data is decoded during command processing

prior to transmit on the RF network.

o utf-8: Use UTF-8 variable-width encoding. While you can specify this encoding type,
current limitations in RCI/SCI processing through Remote Manager mean that true UTF-
8 encoding is not passed cleanly through all systems and end-to-end. It is only safe to
use ASCII. Specifying 'utf-8' is primarily useful for evaluation only.

o Default value: base64.

Command body (value)
The command body contains the data to be transmitted to the specified XBee node of the network.
The command body content depends on the value of the encoding attribute:

n base64: The command body value must be encoded in base64. The XBee Industrial Gateway
Python application will receive the encoded content but, prior to transmission to the
corresponding XBee node, the application will decode the command body to its original content
and that will be transmitted.

n utf-8: The command body value must be the serial data that you want to send to the XBee
node. The entire content of the command body as received by the gateway Python application
will be transmitted subject to whitespace handling rules of XML and the limitations of Remote
Manager to represent individual code points. For best results, base64 encoding is preferred for
production code and evaluation is best when limited to the ASCII subset.

Note Whitespace is not significant when the XBee Industrial Gateway Python application processes
base64. However, whitespace in UTF-8 is significant, because it is impossible to determine whether
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the whitespace should be considered as such and thus take the conservative approach of keeping it
significant and passing it on.

Request and reply examples

n Request

This SCI request sends a serial data command with the text Hello, World! encoded in base64
to the XBee node of our network corresponding to the MAC address 00:11:22:33:44:55:65:77.

Note The request is using a dummy device ID and XBee MAC address. You will need to use your
own XBee Industrial Gateway device ID and XBee MAC address if you want to test this example.

<sci_request version="1.0">

  <send_message>

    <targets>

        <device id="00000000-00000000-001122FF-FF334455"/>

    </targets>

<rci_request version="1.1">

    <do_command target="xbgw">

<send_serial addr="00:11:22:33:44:55:66:77"

                    encoding="base64"> SGVsbG8sIFdvcmxkIQ==

</send_serial>

    </do_command>

  </rci_request>

 </send_message>

</sci_request>
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n Reply

If the SCI request succeeds, you will receive a SCI reply containing the send_serial command
response element. As it was successful, the response will be empty.
<sci_reply version="1.0">

  <send_message>

      <device id="00000000-00000000-001122FF-FF334455">

          <rci_reply version="1.1">

              <do_command target="xbgw">

                  <responses command="send_serial">

 <response/>

                 </responses>

              </do_command>

          </rci_reply>

      </device>

   </send_message>

</sci_reply>

If the SCI request fails, you will receive an SCI reply containing the send_serial command
response element that includes an error element indicating the cause of the error. For
example:

<sci_reply version="1.0">

    <send_message>

        <device id="00000000-00000000-001122FF-FF334455">    

            <rci_reply version="1.1">

                <do_command target="xbgw">

                    <responses command="send_serial">

<response>

<error id="encoding">

<desc>Unrecognized encoding</desc>

<hint>basd64</hint>

</error>

</response>

               </responses>

            </do_command>

         </rci_reply>

       </device>

    </send_message>

</sci_reply>

The error element contains an id attribute indicating the error identifier. For more information
regarding the possible XBee Industrial Gateway Python application error identifiers, see XBee
Industrial Gateway Python application command errors.
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The desc element displays the meaning of the error identifier, and the hint element provides an
explanation of what caused the received error.

Example: Sending text to an XBee node through Remote Manager
The following example assumes the microcontroller attached to the XBee device is a computer.
You must install XCTU on your computer. If you do not have XCTU installed, go to www.digi.com/xctu
to download and install XCTU.
To send a Hello, World! text to an XBee node on your network through Remote Manager:

1. Attach the XBee node from your network to an XBIB device and connect it to your computer
using a serial or USB cable. This is the node that will receive the serial data.

2. Open XCTU and add the XBee node that is connected to your computer to the list of radio
modules.

3. Once XCTU has started and your XBee node is added to the list, select the node and click the
Consoles working mode tab. The Console log window appears and displays the XBee

node’s serial console.

4. Connect the console.

5. From a web browser, log in to Remote Manager.

6. Click Documentation and then click API Explorer. The API console appears.

https://www.digi.com/products/xbee-rf-solutions/xctu-software/xctu
https://remotemanager.digi.com/
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7. From the API console, select POST HTTP Method and write the following SCI request that
includes the send_serial command. The send_serial command will be sent to the remote
XBee node within the RCI do_command element, as follows:

<sci_request version="1.0">

    <send_message>

        <targets>

            <device id="{device_id}"/>

       </targets>

      <rci_request version="1.1">

         <do_command target="xbgw">

<send_serial addr="{xbee_mac}"

                        encoding="base64">SGVsbG8sIFdvcmxkIQ==

</send_serial>

         </do_command>

     </rci_request>

  </send_message>

</sci_request>

Where:

n {device_id} is the ID of your XBee Industrial Gateway device.

{xbee_mac} is the MAC address of the XBee node that you attached to your computer.

For example:

<sci_request version="1.0">

    <send_message>

        <targets>

            <device id="00000000-00000000-00409dff-ff5c3BBd"/>

       </targets>

      <rci_request version="1.1">

         <do_command target="xbgw">

             <send_serial addr="0013A2004031A8E1"

                        encoding="base64">SGVsbG8sIFdvcmxkIQ==

             </send_serial>

         </do_command>

     </rci_request>

  </send_message>

</sci_request>

The content of the send_serial command is the text Hello, World! encoded in base64 as it is
specified in the encoding attribute.

8. Click Send.
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9. Verify in XCTU that the serial console for the XBee node that you added received the data.
Depending on the operating mode (API or AT) of the XBee device, you will receive the data in
one of the following modes:

n AT mode: You will see the text Hello, World! in the console.

n API mode: You will receive a Receive Packet API frame with the Hello World! text (HEX
values of the ASCII characters) in the Received data field of the frame.

Store serial data in Remote Manager
As explained in Receive serial data from Remote Manager, when your XBee device is connected to a
microcontroller and you want to send serial data to it, you can do so through Remote Manager by
using the Web Services API and the send_serial command. The XBee Industrial Gateway Python
application stores serial data sent from the microcontroller to the XBee Industrial Gateway device and
from the XBee Industrial Gateway device to XBee Industrial Gateway running the XBee Industrial
Gateway Python application.
Store serial data in Remote Manager when you want to:

n Track an event that happened in the microcontroller.

n Track the measurements that are managed by the microcontroller.

n Store commands or serial data generated by the microcontroller in Remote Manager.

End-user applications can retrieve the serial data from Remote Manager later to perform some tasks.
Whenever an XBee module on the network sends any kind of serial data to XBee Industrial Gateway,
the XBee Industrial Gateway Python application automatically processes the frame containing the
serial data and uploads it to Remote Manager, thereby generating a data stream. To learn more
about data streams, see the Digi Remote Manager User Guide and Digi Remote Manager Programmer
Guide.

https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
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Using the Remote Manager Web Services API, you can retrieve the serial data values from Remote
Manager. End user applications can use the serial data for different purposes. For example:

n Display a list of events

n Perform a specific task

To learn more about the Remote Manager Web Services API, see the Digi Remote Manager
Programmer Guide.
By default, the serial data is stored in Remote Manager and encoded in base64 format. The reason
behind this is that white spaces are not correctly handled by Remote Manager at the moment. The
XBee Industrial Gateway Python application has a configuration file containing the settings of the
application. One of those settings is the encoding of the serial data prior to store it in Remote
Manager.
To change the setting to store the data in UTF-8 format:

1. Open /WEB/python/xbgw_settings.json in an editor.

2. Change "encode serial": true to "encode serial": false.

See XBee Industrial Gateway Python application configuration file for more information on the
configuration file.

https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
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Example: Send serial data from an XBee node to XBee Industrial Gateway
The following example assumes the microcontroller attached to the XBee device is a computer.
To send a serial data package from an XBee node on your network to XBee Industrial Gateway and
verify that it has been automatically uploaded to Remote Manager:

1. Attach one XBee node from your network to an XBIB device and connect it to your computer
using a serial or USB cable. This is the node that will send the serial data to XBee Industrial
Gateway.

2. Open XCTU. Add the XBee node that is connected to your computer to the list of radio modules.

3. Once XCTU has started and your XBee node is added to the list, select the node and click the
Consoles working mode tab. The Console log window appears and displays the XBee

node’s serial console.

4. Connect the console.

5. Depending on the working mode (API or AT) of the XBee device, choose one of the following
options.

n AT mode:

a. Click the Add new packet button and paste the following text in the dialog:

Hello, World!

b. Once the packet is added to the list of packets, select it and click the Send
selected packet button.

n API mode:
a. Click the Add new frame button.

b. Paste the following text in the dialog:

7E 00 1B 10 01 00 00 00 00 00 00 00 00 FF FE 00 00 48 65 6C

6C 6F 2C 20 57 6F 72 6C 64 21 88

The previous text is a Transmit Request frame. You can also generate it by
yourself by clicking the Edit frame using the Frames Generator tool button:

c. After adding the frame to the list of frames, select the frame and click the
Send selected frame button.

6. From a web browser, log in to Remote Manager.

https://remotemanager.digi.com/login.do
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7. Click Data Services and then click Data Streams. The Data Streams page appears and displays
all the data streams (data channels) by the XBee nodes that are registered to your account on
your network that reported data. The streams follow this pattern:

[device_id]/[source]/[xbee_mac]{/[dio_number]}

Where:

n [device_id] Is the ID of your XBee Industrial Gateway.

n [source] Is the source of the data. Legal values are:

l xbee.digitalIn

l xbee.analog

l xbee.serialIn

n [xbee_mac] Is the MAC Address of the XBee node that reported the data in the
following format:

[XX:XX:XX:XX:XX:XX:XX:XX]!

n [dio_number] Is the name of the DIO that generated the data. This is only present if
the [SOURCE] is xbee.digitalIn or xbee.analog.

One of the streams displayed should correspond to the serial data of your XBee device.
For example:

00000000-00000000-00409DFF-FF5C388D/xbee.serialIn/

[00:13:A2:00:40:31:A8:E1]!

Click that serial data stream. Observe how the latest serial data value corresponds to
the following text:

SGVsbG8sIFdvcmxkIQ==

This serial data value is Hello, World! encoded in base64.

Manage XBee DIO lines though Remote Manager
The XBee Industrial Gateway Python application allows you to remotely manage the DIO lines of any
of the XBee nodes on your network through Remote Manager. Use this application feature to turn
on/off different actuators.
The XBee Industrial Gateway Python application can receive digital output commands sent through
Remote Manager (using the Web Services API) and dispatch them to a specific XBee module in the
network to set its corresponding pin high or low.
The following figure demonstrates how this remote management mechanism works.
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To set the value of a DIO pin of one XBee node on your network through Remote Manager, you need to
use the Remote Manager Web Services API.
In this case, you will need to send a POST command, containing a Server Command Interface (SCI)
request to Remote Manager. The SCI command in turn contains a Remote Command Interface (RCI)
do_command element with xbgw as target attribute and the set_digital_output command as
content.
If you never worked with Remote Manager Web Services API before, see the Digi Remote Manager
Programmer Guide to learn more about SCI requests and RCI protocol.

set_digital_output command definition
The set_digital_output command configures the value of a DIO of a specific XBee node in your
network. Add this command to the SCI request inside the RCI do_command element.
Command syntax

https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001437-13/default.htm
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The set_digital_output command must follow this syntax:

<set_digital_output addr=”address” index=”index”>value</set_digital_output>

Command attributes
n addr

l Usage: Required.

l Description: This attribute indicates the destination address of the node to which the
content indicated by the command body should be transmitted. This address is expressed
as the 64-bit IEEE address of the node.

l Value: The 64-bit IEEE address of the node following one of these patterns:
XX:XX:XX:XX:XX:XX:XX:XX

[XX:XX:XX:XX:XX:XX:XX:XX]!

XXXXXXXXXXXXXXXX

XX-XX-XX-XX-XX-XX-XX-XX

n index

l Usage: Required if the name attribute is not specified.

l Description: This is the pin index for which settings are being changed.

l Value: The value for this attribute must represent a valid integer between 0 and 12.

Indices 0-9 map to DIO values. That is, they set the Dx AT parameter, where x is the index.
For example, index 8 is equivalent to setting D8; index 12 is equivalent to setting P2.

Indices 10-12 map to PWM values. That is, they set the Px AT parameter, where x is index-
10.

n name
l Usage: Required if index attribute is not specified.

l Description: The name of the pin for which settings are being changed.

l Value: Specify either the AT parameter corresponding to that pin (from D0 to D9) or the
functional name of the pin (from DIO0 to DIO12) as the value for this attribute.

Note Currently, set_digital_output supports setting pins on remote ZigBee nodes only. This means
that pin index 9 is invalid, because DIO9 is not user-configurable on such nodes. Future updates to this
command may open up the possibility to change this behavior; for example, for 802.15.4 nodes.

Command body (value)
The body of the set_digital_output command indicates whether to set the digital output pin low or
high. Legal values for the body to configure the pin are:

n high or true: Sets the pin high (ON). Other legal values include:

1, yes, y, on
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n low or false: Sets the pin low (OFF). Other legal values include:

0, no, n, off

Request and reply examples

n Request

This SCI request example configures DIO4 of the XBee node corresponding to the MAC address
00:13:a2:00:40:9f:6f:cb to high. The command uses the attribute index to indicate the pin to
be configured instead of the name one:

<sci_request version="1.0">

    <send_message>

        <targets>

            <device id="00000000-00000000-00409DFF-FF5C4C66"/>

        </targets>

        <rci_request version="1.1">

            <do_command target="xbgw">

<set_digital_output addr="00:13:a2:00:40:9f:6f:cb"

index="4">1</set_digital_output>

            </do_command>

        </rci_request>

    </send_message>

</sci_request>

Note This example request uses a dummy device ID and XBee MAC address. You must use your
own XBee Industrial Gateway device ID and XBee MAC address to test this example.
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n Reply

<sci_request version="1.0">

    <send_message>

        <device id="00000000-00000000-00409DFF-FF5C4C66"/>

             <rci_reply version="1.1">

                 <do_command target="xbgw">

                      <responses command="set_digital_output">

<response/>

                      </responses>

                </do_command>>

             </rci_reply>

         </device>

     </send_message>

</sci_reply>

If the SCI request fails, you will receive an SCI reply containing the set_digital_output
command response element that includes an error element indicating the cause of the error.
For example:

<sci_reply version="1.0">

    <send_message>

        <device id="00000000-00000000-00409DFF-FF5C4C66">     

            <rci_reply version="1.1">

                <do_command target="xbgw">

                    <responses command="set_digital_output">

 <response>

<error id="invalidattr">

<desc>Attribute value is incorrect</desc>

<hint>DIO9 cannot be configured for

digital.</hint>

</error>

</response>

                    </responses>

                </do_command>

            </rci_reply>

        </device>

    </send_message>

</sci_reply>

The error element contains an id attribute indicating the error identifier. For more information
regarding the possible XBee Industrial Gateway Python application error identifiers, see XBee
Industrial Gateway Python application command errors.
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The desc element displays the meaning of the error identifier. The hint element provides an
explanation with the cause of the received error.

Example: Turn on an LED on the XBee interface board
To turn on the User LED 4 (DS4) of the XBee Interface Board (XBIB):

1. Ensure the XBee node you are going to configure is attached to an XBIB device. You will change
the status of the User LED 4 (DS4) of the board by modifying the value of the DIO4 of the XBee
node because they are connected each other.

2. From a web browser, go to the Home page of your XBee Industrial Gateway web interface.

3. Under Configuration, click XBee Network. The XBee Configuration page appears.

4. Click the Discover XBee Devices button to locate the remote XBee devices that are in the
same network as XBee Industrial Gateway. 

5. Click the XBee device that you want to configure.

6. From the XBee Configuration page, click Input/Output Settings.

7. Under I/O Pin Settings, configure I/O Pin 4 (AT setting D1) to Digital Output High (5). This
way, the DIO4 is configured as output and its value is set to high turning the User LED 4 (DS4)
OFF because the LED in the board is using an inverted logic.
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8. From a web browser, log in to Remote Manager.

9. Click Documentation and then click API Explorer. API console appears.

10. From the API console, select POST HTTP Method and write the following SCI request that
includes the set_digital_output command. The set_digital_output command will be sent to
the remote XBee node within the RCI do_command element, as follows:

<sci_request version="1.0">

    <send_message>

        <targets>

            <device id="{device_id}"/>

       </targets>

      <rci_request version="1.1">

         <do_command target="xbgw">

<set_digital_output addr="{xbee_mac}" name="DIO4">low</set_

digital_output>

         </do_command>

     </rci_request>

  </send_message>

</sci_request>

Where:

n {device_id} is the ID of your XBee Industrial Gateway device.

n {xbee_mac} is the MAC address of the XBee node that you attached to your computer.

For example:

<sci_request version="1.0">

    <send_message>

        <targets>

            <device id="00000000-00000000-00409dff-ff5c3BBd"/>

       </targets>

      <rci_request version="1.1">

         <do_command target="xbgw">

             <set_digital_output addr="0013A2004031A8E1"

                        name="DIO4">low</set_digital_output>

         </do_command>

     </rci_request>

  </send_message>

</sci_request>

The set_digital_output command sets the value of the DIO4 to low, which will turn ON the
User LED 4 (DS4) of the board.

11. Click Send.

https://remotemanager.digi.com/login.do
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12. Verify that the User LED 4 (DS4) on the XBIB board is now ON.

13. Now try to turn the LED off by sending the same request, but changing the value of the set_
digital_output command to high.

XBee Industrial Gateway Python application configuration file
You can configure some of the XBee Industrial Gateway Python application features using a
configuration file. This configuration file is placed at the same level as the application itself within the
file system and its content is written in JSON format. The file has the following structure:

{
     category 1: {
          setting 1: value 1
          setting 2: value 2
          ...
          setting n: value n
    }
     category 2: {
          setting 1: value 1
          setting 2: value 2
          ...
         setting n: value n

     ...
     category n: {
          setting 1: value 1
          setting 2: value 2
          ...
          setting n: value n
    }
}

The first level of the settings structure in this configuration file is the name of the category to which
the settings contained inside belongs. The second level of the structure is the list of settings
contained in the category.
The contents of this configuration file are:

{
     "devicecloud": {
          "encode serial": true
     }
}

The XBee Industrial Gateway Python application provides the following category, with one
configurable setting:

n devicecloud
l encode serial:

o Type: Boolean

o Description: Indicates whether or not the serial data that is sent and stored in Remote
Manager is encoded in base64.

o Default value: true
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Change XBee Industrial Gateway Python application settings
To change any XBee Industrial Gateway Python application setting:

1. Open a web browser and access the Home page of your XBee Industrial Gateway web
interface.

2. Click File Management under Administration.

3. Download the file xbgw_settings.json.

4. Using a text editor, open the xbgw_settings.json file and modify the settings that you want to
change.

5. Return to the File Management page for XBee Industrial Gateway and upload the xbgw_
settings.json file to XBee Industrial Gateway.

6. Reboot your XBee Industrial Gateway device. Your changes to the XBee Industrial Gateway
Python application settings go into effect when the XBee Industrial Gateway device is
initialized.

XBee Industrial Gateway Python application command errors
When you use the Web Service API from Remote Manager to send the commands provided by the
XBee Industrial Gateway Python application, you may receive an error with an identifier. The following
list displays all possible errors that may appear when sending commands to XBee Industrial Gateway
Python application.
These errors do not generally appear during in normal operation. When setfailed, txfailed, or txfull
appears, the most likely cause is network issues. These errors typically appear when you issue a
command incorrectly.

ID Description

address Invalid address

encoding Unrecognized encoding

badoutput Invalid digital output value

base64 Unable to decode as base64

invalidattr Attribute value is incorrect

missingattr Missing required command attribute

toomanyattrs Too many attributes were given

setfailed Remote node rejected set command

txfailed Transmit operation failed

txfull Too many outstanding transmits

txstatus TX Status delivery failure

unexpected Unexpected/unclassified error
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Digi ESP for Python
Digi ESP™ for Python supports XBee Industrial Gateway. Digi ESP is an IDE featuring device detection,
debugging, compiling, and downloading of Device Integration Application (DIA)/Python code to Digi
gateways. Digi ESP includes example applications that can demonstrate the use of some of Digi’s
proprietary Python extensions, serving as templates for applications seeking to incorporate common
functionality.

n For examples of how to use Digi ESP for Python with XBee Industrial Gateway, see Access the
program samples in Digi ESP.

n For Digi ESP for Python installation instructions, see Install the Digi ESP for Python
Development Environment.

Access the program samples in Digi ESP
Digi ESP for Python provides samples to use as a base for programming XBee Industrial Gateway,
including specific examples for exercising specific interfaces available on XBee Industrial Gateway. You
can access these program samples from the Python or DIA samples wizard.
To access the program samples in Digi ESP:

1. From Digi ESP, go to File > New > Digi Python Application Sample Project or File > New >
DIA Sample Project. The sample wizard for Python or DIA appears.

2. Select the Show only samples compatible with platform check box and then select XBee
Gateway from the combo box. The compatible samples appear in the Sample projects list.

3. Select the samples you want to display or click Select All to select all of the samples.

4. Click Next. The Remote device selection page appears.

5. Specify the XBee Industrial Gateway device you want to use.
n Select Use Current Remote Device to use the device that is currently active in Remote

Manager.

n Select Select Specific Remote Device to display a list of devices and select a device
from the list.

6. Click Next to complete the process.

Install the Digi ESP for Python Development Environment
The Digi ESP for Python Development Environment is an Eclipse-based Integrated Development
Environment (IDE) that simplifies the process of creating Python applications for XBee Industrial
Gateway. It also provides many example projects.
To download and install the Digi ESP for Python Development Environment:

1. Navigate to the Digi XBee Gateway product support page.

2. Click the Product Support > Drivers link or scroll down the page to the Drivers section.

3. Click the Digi ESP for Python - Windows XP/Vista/Windows 7 installer link to download the
Digi ESP for Python Development Environment.

http://www.digi.com/products/xbee-rf-solutions/gateways/xbee-gateway#productsupport
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Note While MAC operating systems are supported, this procedure shows how to install Digi
ESP for Python on a Windows operating system. If you are using a MAC operator system, click
the Digi ESP for Python - MAC OS X (10.6) installer link.

4. Once the Digi ESP for Python framework has been downloaded, run the Digi ESP for Python
framework installation wizard.

a. Follow the steps in the wizard to complete the installation process.

b. In the Choose Components dialog, select Digi ESP for Python.

c. On the last page of the wizard, several prompts are displayed. Select Show Release
Notes to open and view the Release Notes for the Digi ESP for Python framework.

d. Click Finish to close the installation wizard. The installation process installs Digi
ESP in this program group:

Digi > Python > Dev Tools > Digi ESP for Python

5. The Digi ESP for Python framework will launch automatically. A prompt to select a workspace
directory is displayed. This 'workspace' is the directory where projects and configurations will
be stored. The default location is a sub-folder called workspace on the user home directory, for
example:

c:/Documents and Settings/[username]/workspace
Use the default workspace directory, or click Browse and navigate to your desired alternate
workspace location, select Use this as the default and do not ask again, and click OK.

6. The first time you run Digi ESP for Python, the Workbench displays.

Before the Workbench displays, the Welcome page displays for just a moment, and then
displays along the right side of the Workbench screen. Most of the time, the Welcome page is
minimized. When minimized, select Help > Welcome from the main menu to maximize the
Welcome page.
In the Welcome page, click the Workbench icon to display the Workbench screen.
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7. You can display an overview for Digi ESP for Python.
a. Select Help > Welcome from the main menu. The Welcome page appears.

b. In the Welcome tab, click the Overview icon. The Overview page appears.

c. On the overview page, click Getting Started. The Digi ESP for Python Getting Started

Guide is displayed in the Help - Digi ESP for Python window.

8. Scroll to and click the XBee Gateway/ConnectPort X2e link.
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9. Follow the XBee Gateway/ConnectPort X2e getting started instructions to build your first
application using Digi ESP for Python.

Configure a Python application in the web interface
The web interface of the XBee Industrial Gateway device includes a section that allows you to
configure and manage the Python processes or applications running in the device.
Before you configure a Python application, the Python application must be loaded on the XBee
Industrial Gateway device. See File management for more information on loading files on an XBee
Industrial Gateway device.
To configure a Python application for an XBee Industrial Gateway device:

1. Access and log into the web interface.

2. Under Configuration, click Python. The Python Configuration page appears and displays the
list of Python processes or applications that are currently configured in XBee Industrial
Gateway as well as their status and the action that will be executed when the applications exit.
Note that the first time you load this page, the list will be empty.

3. Select the Enable check box associated with the Python application. When enabled, the Python
application starts immediately after your changes are saved. By selecting the Enable check
box, the Python application also automatically starts after a system starts up.

A green icon will appear in the Active column when a Python application is running. Note

that you can stop a configured Python application immediately by clearing the Enable check
box and clicking Apply.

4. Click Apply to save your changes.

DIA software
The Digi ESP development environment includes Device Integration Application (DIA) software. DIA
software is another advanced programming tool for developing custom programs for XBee Industrial
Gateway. DIA software simplifies connecting remote devices and sensors to Digi gateway products by
providing ready-to-use software. DIA is targeted for applications that need to gather samples of data
from a set of devices, such as ZigBee sensors and wired industrial equipment. The Digi gateways can
use the DIA framework to gather data from XBee sensor networks, transform the data into a useful
form, and push the data to Remote Manager for consumption by a user.
DIA allows developers to focus efforts on proprietary logic, and includes a comprehensive library of
ready-to-use modules for common operations and abstractions for components like:

n Interface handling (drivers)

n Data management (channels)

n Data delivery (presentations)
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Written in the Python programming language for use on Digi devices, you can extend it to meet unique
device connectivity requirements. When used with the Digi ESP for Python, DIA can shrink the
development cycle for complex data gathering and transformation applications.
For more information on DIA software, see the DIA section in the Digi Python Wiki Archive Reference
Manual.

Linux command shell (command line interface)
XBee Industrial Gateway has a Linux shell command line interface, which allows you to experiment
with the Python interpreter interactively, create scripts, launch scripts, and control the script
operation. While Digi ESP for Python is intended as the main programming interface, you may find this
interface useful for some programming and device management tasks.
A shell is a program that takes commands from the keyboard and gives them to the operating system
to perform. On XBee Industrial Gateway, a program called ash acts as the shell program. You can use
this shell in several useful instances, particularly in managing files, executing Python programs, and
programming and executing commands to the XBee RF module in the gateway.

Note For more information on the ash shell, go to the following website:
http://linux.die.net/man/1/ash. Note that the ash shell supported in XBee Industrial Gateway is
similar, but not identical, to the ash shell described in this website.

User name and password for the Linux command shell
The command line interface is accessed using SSH and is described in the Linux command shell
(command line interface). Access to XBee Industrial Gateway is at the user level.

n User name: python

n Password: The unique, default password is printed on the device label. If the password is not
on the device label, the default password is dbps. If these defaults do not work, the password
may have been updated. Contact your system administrator for help.

Connect and log in to the XBee Industrial Gateway device
To connect and log in to the XBee Industrial Gateway device through the command line interface:

1. Open a command prompt or terminal window, such as one provided by PuTTY. You can
download PuTTY from http://www.putty.org/.

2. Choose one of the following option:

n From Windows, type:

putty python@my_ip_address

n From Linux, type:

$ ssh python@my_ip_address

Where my_ip_address is the IP address of XBee Industrial Gateway.

https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_device_cloud_wiki.htm
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_welcome.htm%3FTocPath%3DWelcome%2520to%2520Digi%2520Python|_____0
https://www.digi.com/resources/documentation/digidocs/90001537/default.htm#references/r_welcome.htm%3FTocPath%3DWelcome%2520to%2520Digi%2520Python|_____0
http://linux.die.net/man/1/ash
http://www.putty.org/
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3. You are prompted for the password. The unique, default password is printed on the device
label. If the password is not on the device label, the default password is dbps. If these defaults
do not work, the password may have been updated. Contact your system administrator for
help.

Log in to XBee Industrial Gateway through the Digi ESP for Python
command line interface
Within Digi ESP for Python, there is a separate login on the Device Manager LAN Connection tab in
Digi ESP for Python.

1. Access Digi ESP for Python.

2. Click the Device Manager icon in the toolbar.

3. Select Digi Device > New_configuration from the left pane.

4. Click the LAN Connection tab.

5. Perform authentication.
a. Select the User login information if required option.

b. In the Login field, enter the default user name: python

c. In the Password field, enter the unique, default password, which is printed on the
device label. If the password is not on the device label, the default password is
dbps. If these defaults do not work, the password may have been updated. Contact
your system administrator for help.

6. Click Apply to start the validation process.
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Linux command: xbee
To interact with the XBee RF module inside of the XBee Industrial Gateway while using the command
shell, use the built-in xbee command line program.

Usage

XBee utilities

syntax:
xbee [option ...] [command ...]

options:
-h, --help {Display this help and exit}

commands:
refresh {Discover network devices}
zigbee {Discover ZigBee devices}
clear {Clear list and discover devices}
id|network|extended|node|product {Sort node list by field}
[node] <CC>[[=]param] {Run AT command on device:

<CC> is 2 character upper case command
param is <decimal>, 0x<hex>, or "string"}

load_profile [node] file {Load settings from file}
save_profile [node] [file] {Save settings to file}
factory_default [node] {Restore factory default settings}
restart [node] {Restart node}
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child_table [node] {Display child table}
neighbor_table [node] {Display neighbor table}
source_route node {Display source route}
route destination [source] {Display route}

identify {Display identify messages}
identify node [seconds] {Send identify message}
ping node [count size interval_ms] {Send loopback data}

fw_update file {Update gateway radio firmware}
fw_update target [updater] [file] {Schedule remote firmware update}
fw_update target cancel {Cancel remote firmware update}
fw_update {Display firmware status list}
fw_status [node] {Display firmware status for node}

Common xbee command examples
Display node list
To display the list of known devices on the RF network, as well as basic information about the
network configuration, run this command:

xbee

Example output:

XBee network device list

Network: 0
PAN ID: 0xe9e4 - 0x0013a20040abe468
Channel: 0x12 (2440 MHz)
Gateway address: 00:13:a2:00:40:ab:e4:68!
Gateway firmware: 0x4061

Node ID Network Extended address Node type Product
type
--------------- ------- -------------------------------- ----------- -----------
-

[0000]! 00:13:a2:00:40:ab:e4:68! coordinator X2e Gateway

1 coordinator

In this example, the XBee module inside of the XBee Industrial Gateway is acting as a Zigbee network
coordinator, as indicated by the 16-bit network address of 0000. If this network had other devices
joined, they would appear in this list.
As seen in the Usage section above, you can sort the node list by any of the fields in the table.
Examples:

xbee id
xbee network
xbee extended
xbee node
xbee product
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Perform a node discovery
Use the command xbee refresh to perform a node discovery (ND command). Use the command xbee
zigbee to perform a ZDO device discovery.
Use the command xbee clear to clear the cached node list and automatically trigger a discovery. This
can be useful if a node has been removed from the network but still appears in the node list.
Perform an AT command
To issue an AT command against the XBee inside of the XBee Industrial Gateway, pass that command
as a parameter to the xbee command.
Examples:

xbee AI
xbee VR
xbee NI=myxbeegateway
xbee NJ=0xff

You can also send a remote AT command to another XBee on the RF network, by specifying the target
node before the command.
Examples:

xbee 1bf2 VR
xbee 00:13:a2:00:12:34:56:78 AI
xbee LightSwitch1 VR

The target node can be specified by its 16-bit network address, 64-bit MAC address, or XBee node ID.
Manage over-the-air firmware updates of XBee devices
Use the command xbee fw_update to display the current firmware update status for all nodes in the
cached node list.

Note This command displays only update statuses for nodes which have been updated by the XBee
Industrial Gateway. If an update is being performed by another device on the network (such as
another XBee Gateway, or other tool), this XBee Industrial Gateway will not be aware of that.

To update the firmware of the XBee module inside of the XBee Industrial Gateway, run the command
xbee fw_update FILE, replacing FILE with the path to the firmware file you wish to install.
For example:

xbee fw_update /WEB/python/xbp24c-zb_405F.ebl

To perform an over-the-air update of an XBee module on the RF network, run the command xbee fw_
update TARGET FILE, replacing TARGET with the node to update. As with other xbee commands, this
can be a 16-bit address, 64-bit address, or XBee node ID.
If the target of an over-the-air update is an XBee Series 2 Zigbee module (S2, S2B, or S2C), when using
the xbee fw_update TARGET FILE command, the XBee Industrial Gateway will automatically detect
candidate updater nodes from the neighbors of the target. To select a specific updater node, use the
command xbee fw_update TARGET UPDATER FILE.
When an over-the-air update is triggered using xbee fw_update TARGET ..., the update is scheduled
in the XBee engine inside of the XBee Industrial Gateway and the command returns immediately. Run
xbee fw_update to see the status of the update.
To cancel a scheduled over-the-air update, run xbee fw_update TARGET cancel. Note that if the
update has already commenced, this will not interrupt the update operation.
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Linux command: rci_request
RCI, or the Remote Command Interface, can be used to perform system-level configuration of the
XBee Industrial Gateway, as well as to issue commands to certain components of the XBee Industrial
Gateway. For more information, refer to the RCI Specification.
When using the XBee Industrial Gateway command shell, you can use the rci_request command to
trigger requests and see the corresponding replies.
The rci_request command takes one or more RCI request commands as parameters.
Some example commands include:

rci_request '<query_setting />'
rci_request '<query_state />'
rci_request '<set_setting><log_level><xbee>7</xbee></log_level></set_setting>'
rci_request '<do_command target="zigbee"><discover option="current" /></do_
command>'

Note Because the < and > characters are treated specially by the Linux command line shell (to
redirect data to/from files), you must put single quotes around the parameter(s). Double quotes may
also be used, however, since the RCI XML command may itself contain double quotes (around
attribute values), it is best practice to use single quotes.

Linux command: wancm
On cellular-enabled XBee Gateway and XBee Industrial Gateway devices, the wancm command is
available.
This command can be used to see the status of the cellular connection, and to perform certain
management activities.

Usage

Usage: wancm command [profile]

command:
connect Connect or reconnect to network
disconnect Disconnect from network
fw_update Device firmware update
exit Disconnect and exit
info Print information
power (on|off) Power device on or off
power suspend Wake on SMS received
prl_update CDMA PRL update
providers Get supported providers
provision CDMA provision
rci Get RCI information
reset Reset device and reconnect
scan GSM operator scan
sms_stats Print SMS statistics
sms_recvlog Print SMS received message log
sms_sentlog Print SMS sent message log
sms_clearlog Clear SMS received and sent message logs

profile: Profile index (0-3)
"first" for highest priority
"next" for next lower priority
Default is current profile

https://www.digi.com/resources/documentation/digidocs/90000569/default.htm
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Telit OTA firmware update: fw_update_ota [profile] param=value...
file File name on FTP server (required)
server FTP server name or IP address
port FTP server port number
user FTP server user name
password FTP server password
directory FTP server directory

Example:

$ wancm info

Device Type: LTE
Manufacturer: Telit

Model: LE910-NA1
Revision: 20.00.526.0

Serial number: 353535095837892
Phone number: 15888675309

SIM IMSI: 313460000000001
SIM ICCID: 89100123450004598765

SIM PIN status: READY
Signal strength: -79 dBm

Signal level: 3 of 3 bars
Signal quality: -3.5 dB

Registration status: Registered (Home Network)
Cell ID: 4E7B57E

Location area code: 4611
Mobile country code: 310
Mobile network code: 410

Operator name: AT&T
Service: LTE

Band: 2
Channel: 1000
Profile: 0

Connection state: Connected
Connection duration: 8 days 12:16:12

IP address: 192.0.2.156
DNS primary address: 192.0.2.62

DNS secondary address: 192.0.2.64
Receive idle time: 15
Transmit idle time: 15

Connections: 1
Connection errors: 0

Carrier loss: 0
LCP echo failed: 0

Idle timeout: 0
User disconnect: 0

Monitoring errors: 0
Device resets: 0
Received bytes: 1327535

Transmitted bytes: 6057077
Total received bytes: 1327535

Total transmitted bytes: 6057077
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XBee Industrial Gateway is designed to allow network communication with minimal configuration.
However, there are several configuration settings that you can adjust. This section covers the
configuration of these settings from Remote Manager and the XBee Industrial Gateway web interface.
After you configure XBee Industrial Gateway device, back up the configuration settings. See Back up
or restore the configuration for more information.
XBee Industrial Gateway uses the following configurable settings to start up the XBee Industrial
Gateway device and initiate communication.

Configure settings from Remote Manager 108
Configure settings from the XBee Industrial Gateway web interface 109
Ethernet IP network settings 111
Mobile connectivity settings 114
Digi Mobile SureLink™ settings 118
DNS settings 121
Mobile firewall settings 122
Autostart settings for the Python Program 123
Network services settings 124
Configure Remote Manager connectivity settings 126
Ethernet SureLink™ settings 133
GPS static position settings 135
Network Failover settings 136
Time settings 138

Digi XBee Industrial Gateway 107



Configure XBee Industrial Gateway Configure settings from Remote Manager

Digi XBee Industrial Gateway 108

In addition to the methods described in this section, you can perform configuration programmatically,
through Web Services, and natively using Python modules. See About programming for more
information.

Configure settings from Remote Manager
In Remote Manager, you can configure XBee Industrial Gateway device settings, such as network
connection, failover, and time settings. You can also monitor and manage XBee Industrial Gateway
device data.
Basic information about Remote Manager is in the Digi Remote Manager User Guide.
Before you can configure settings in Remote Manager, you must perform these prerequisites:

1. Set up a Remote Manager account. See Create a new account for instructions.

2. Log in to the Remote Manager account. See Log in to your Remote Manager account for
instructions.

3. Add XBee Industrial Gateway devices to the Remote Manager device list. See Add devices to
your inventory for instructions.

See Remote Manager interface for more basic information about Remote Manager.

Basic configuration settings
In Remote Manager, you can access basic configuration settings for XBee Industrial Gateway by
double-clicking on a device in the device list to display the Properties page. As an alternative, you can
right-click on a device and select the Properties option.
Some of the basic configuration settings located in this menu are:

n Ethernet IP network settings

n Mobile connectivity settings (for Cellular models only)

n Digi Mobile SureLink™ settings (for Cellular models only)

n DNS settings

n Autostart settings for the Python Program

n File Management page in Remote Manager

Advanced configuration settings
You can access advanced configuration settings for XBee Industrial Gateway by double-clicking on a
device in the device list to display the Properties page, and then selecting Advanced Configuration.
The settings available in this menu vary by model. Some of the settings are:

n Time settings

n Mobile firewall settings (for Cellular models only)

n Configure Remote Manager connectivity settings

n Ethernet SureLink™ settings

n GPS static position settings

n Network Failover settings

n Configure XBee network settings

https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#tasks/t_create_new_account.htm%3FTocPath%3DDigi%2520Remote%2520Manager%2520User%2520Guide|_____3
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#tasks/t_log_in.htm%3FTocPath%3DDigi%2520Remote%2520Manager%2520User%2520Guide|_____4
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#tasks/t_add_devices_manually.htm%3FTocPath%3DDevice%2520management|Adding%2520and%2520removing%2520devices|_____1
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#tasks/t_add_devices_manually.htm%3FTocPath%3DDevice%2520management|Adding%2520and%2520removing%2520devices|_____1
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Configure settings from the XBee Industrial Gateway web
interface

The XBee Industrial Gateway web interface allows you to configure critical network configuration
settings and other features. If you already know the IP address for the XBee Industrial Gateway
device, you can open a web browser and type the IP address in the address bar to open the XBee
Industrial Gateway web interface. If you do not know the IP address for the XBee Industrial Gateway
device, you can use the Digi Device Discovery utility to locate XBee Industrial Gateway on your
network.
The XBee Industrial Gateway web interface does not display every device setting. For more extensive
access to settings, use Remote Manager or a programmatic interface.

Access the XBee Industrial Gateway web interface
To access the XBee Industrial Gateway web interface, choose one of the following options:

If you know the XBee Industrial Gateway device's IP address
1. Open a web browser, type the IP address in the address bar, and press the Enter key. For

example: http://10.101.1.178.

2. The first time you attempt to access the XBee Industrial Gateway, a certificate management
prompt appears. Click Proceed Anyway or Advanced > Proceed Anyway.

3. A login screen appears. Enter the default user name and password:
n User name: python

n Password: The unique password printed on the device label. If the password is not on
the device label, the default password is dbps. If these defaults do not work, the
password may have been updated. Contact your system administrator for help.

4. The XBee Industrial Gateway web interface appears.

If you do not know the XBee Industrial Gateway device's IP address
If you already ran the Wireless Access Point wizard, you need the Digi Device Discovery Utility to
rediscover the device and open its web interface.

1. From a web browser, go to the Product Support Download page and click the Diagnostics,
Utilities & MIBs link from the Support Downloads section.

2. Select your product from the list, or a enter keywords to locate it.

3. Select your operating system from the drop-down list, then select the Device Discovery
Utility.

4. Follow the prompts to complete the installation of the Digi Device Discovery Utility.

5. To open the Digi Device Discovery on your computer, select Start > Digi > Digi Device
Discovery > Digi Device Discovery. The Digi Device Discovery window appears.

6. Locate your XBee Industrial Gateway in the list of devices by matching the Serial Number on
the XBee Industrial Gateway's label to the corresponding value in the MAC address column in
the Digi Device Discovery window.

http://www.digi.com/support/getasset?fn=40002265&tp=5
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7. Double-click the device to open the XBee Industrial Gateway web interface, or select the device
and click Open web interface under Device tasks in the Digi Device Discovery window.

8. A login screen appears. Enter the default user name and password:
n User name: python

n Password: The unique password printed on the device label. If the password is not on
the device label, the default password is dbps. If these defaults do not work, the
password may have been updated. Contact your system administrator for help.

9. To change a subset of configuration settings through Digi Device Discovery, click the Configure
Network Settings button. When you change configuration settings, you are prompted for a
password. Leave the Password field blank and click OK.

Note If your firmware version is 3.2.30.x or later, the Digi Device Discovery tool is by default not
allowed to change configuration of the XBee Gateway device. ADDP must have the Read-Write
mode enabled in order for the button on the XBee Gateway device to control this feature. See
Network services settings.

Home page
The Home page appears by default when you access the web interface for a Digi device. The
information listed on this page may vary based on product and supported features.

Home page section Description

Device Information The Device Information section of the Home page
summarizes current system parameters and
network connectivity status.

Network Connectivity Status LED The Network Connectivity Status LED and
displayed information indicates the readiness of
XBee Industrial Gateway to communicate in a
network and with the Remote Manager server. See
XBee Industrial Gateway LED descriptions for
descriptions of the status LEDs and the various
network connectivity status conditions listed.

Refresh button Clicking Refresh to update the Home page. This
refresh operation is necessary because items like
system time and network connectivity status are not
dynamically updated when the state changes on the
device. This refresh operation also updates device
status information.

Left pane The left side of the Home page displays a menu
consisting of configuration and administration tasks.
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Home page section Description

Configuration menu The options under Configuration in the menu allow
you to configure settings for various features. Some
of the configuration settings are organized on sets of
linked screens. The options in this menu may vary
based on product and supported features.

Administration menu The options under Administration in the menu allow
you to complete common device administration
tasks. See Administration and maintenance tasks for
more information.

Apply button The web interface runs locally on the device, which
means that the interface always maintains and
displays the latest settings in the Digi device. If you
make changes, click Apply to apply the changes to
the configuration settings to the Digi device.

Cancel changes to configuration settings To cancel changes to configuration settings, click
Refresh or Reload on the web browser. This causes
the web browser to reload the page. Any changes
made since the last time the you clicked Apply are
reset to their original values.

Ethernet IP network settings
The Ethernet Network settings display the current IP address and DHCP settings for Ethernet
network communications. You can change the IP address from the default either by obtaining a new
one through DHCP or by entering a static IP address, subnet mask, and default gateway, and Domain
Name System (DNS) servers.

Default Ethernet settings
For Ethernet networks, the default configuration for the Ethernet model of the XBee Industrial
Gateway allows you to power up the XBee device and join an Ethernet network without any additional
configuration. In this default configuration:

n XBee Industrial Gateway uses a DHCP server to obtain its IP address information. A DHCP
server needs to provide an IP address, subnet mask, default gateway, and Domain Name
System (DNS) server for the device. If you disable DHCP, you must set all of these IP address
settings yourself. In the absence of a DHCP server, you need to assign a static IP address using
the Digi Device Discovery Utility and changing the network settings through the web interface.

n The default behavior regarding NTP time server access, Configure Remote Manager
connectivity settings, and DNS server all proceed as described.

If your Ethernet network configuration does not match these default behaviors, you need to adjust
the Ethernet network configuration settings. See Configure Ethernet Settings for more information.

Configure Ethernet Settings
To configure Ethernet settings, choose one of the following options:
From Remote Manager
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1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Click the Ethernet (eth)0 properties. The Ethernet (etho) page appears.

4. Complete the fields and click Save to save your changes.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Select Configuration > Ethernet Network to access the Ethernet IP network settings.

3. Complete the fields and click Apply to save your changes.

Ethernet Configuration page
The following list describes the Ethernet network settings in the Ethernet (eth0) page:

IP Settings
You can set the IP address for XBee Industrial Gateway either automatically, using DHCP, or by
assigning a static IP address. You must enable either the Obtain an IP address automatically using
DHCP or the Use the following IP address option.

n Obtain an IP address automatically using DHCP: Select this option to enable DHCP to
assign an IP address to the gateway. XBee Industrial Gateway uses a DHCP server to obtain its
IP address information, by default. A DHCP server needs to provide an IP address, subnet
mask, default gateway, and Domain Name System (DNS) server for the device. If you disable
DHCP, you must select the Use the following IP address option and configure these settings
manually.

n Use the following IP address: Specify a static IP address for XBee Industrial Gateway,
consisting of the following:
l IP Address: The IP address assigned to network devices.

l Subnet Mask: The subnet mask assigned to the device. The subnet mask is combined with
the IP address to determine which network this Digi device is part of.

l Default Gateway: The IP address of the computer that enables this Digi device to access
other networks, such as the Internet.

Advanced Settings
n Interface enable: Enables or disables the Ethernet network interface.
n Auto IP enable: Enables or disables use of AutoIP address assignment. When AutoIP is

enabled, XBee Industrial Gateway automatically self-configures an IP address when an address
is not available from other methods. For example, when the Digi device is configured for DHCP
and a DHCP server is not currently available. For more information on AutoIP, see RFC 3927,
Dynamic Configuration of IPv4 Link-Local Addresses.

n Source route enable: Enables or disables source routing to specify a route through the
network.

http://tools.ietf.org/html/rfc3927
http://tools.ietf.org/html/rfc3927
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Ethernet Network Configuration page
The following list describes the Ethernet network settings the Ethernet Network page by section.

Note The Ethernet Network page is only available for Wi-Fi models.

Current IP Parameters
This section displays the active Ethernet IP parameters for XBee Industrial Gateway.

n IP Address: The IP address assigned to network devices.

n Subnet Mask: The subnet mask assigned to the device. The subnet mask is combined with the
IP address to determine which network this Digi device is part of.

n Default Gateway: The IP address of the computer that enables this Digi device to access other
networks, such as the Internet.

Interface Configuration
n Enable this network interface: Enables or disables the Ethernet network interface.

n Speed: The Ethernet speed that XBee Industrial Gateway uses on the Ethernet network.

l Automatic: The device senses the Ethernet speed of the network and adjusts
automatically. The default is Automatic. If one side of the Ethernet connection is using
auto (negotiating), the other side can set the Ethernet speed to whatever value is desired.
Or, if the other side is set for 100 Mbps, this side must use 100 Mbps.

10: The device operates at 10 megabits per second (Mbps) only.

l 100: The device operates at 100 Mbps only.

n Duplex Mode: The mode that XBee Industrial Gateway uses to communicate on the Ethernet
network. Specify one of the following options:

l Automatic: The device senses the mode used on the network and adjusts automatically.
The default is auto. If one side of the Ethernet connection is using auto, the other side can
set the duplex value to whatever is desired. If one side uses a fixed value (for example,
half-duplex), the other side has to use the same duplex mode.

Full Duplex: The device communicates in full-duplex mode.

Half Duplex: The device communicates in half-duplex mode.

Stored IP Configuration
You can set the IP address for XBee Industrial Gateway either automatically, using DHCP, or by
assigning a static IP address. You must enable either the DCHP or the Static IP option.

n DHCP: Select On to enable DHCP to assign an IP address to the gateway. XBee Industrial
Gateway uses a DHCP server to obtain its IP address information, by default. A DHCP server
needs to provide an IP address, subnet mask, default gateway, and Domain Name System
(DNS) server for the device. If you disable DHCP, you must enable the Static IP option and
configure these settings manually.
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In the absence of a DHCP server, you must assign a static IP address by accessing the Digi
Device Discovery tool and changing the network settings through that interface.

n AutoIP: Enables or disables use of AutoIP address assignment. When AutoIP is enabled, XBee
Industrial Gateway automatically self-configures an IP address when an address is not
available from other methods. For example, when the Digi device is configured for DHCP and a
DHCP server is not currently available. For more information on AutoIP, see RFC 3927, Dynamic
Configuration of IPv4 Link-Local Addresses.

n Static IP: Select ON to enable you to specify a static IP address for XBee Industrial Gateway.
You must specify the following:
l IP Address: The IP address assigned to network devices.

l Subnet Mask: The subnet mask assigned to the device. The subnet mask is combined with
the IP address to determine which network this Digi device is part of.

l Default Gateway: The IP address of the computer that enables this Digi device to access
other networks, such as the Internet.

Mobile connectivity settings
The mobile settings allow you to configure how to connect to mobile (cellular) networks using the
mobile connection, including the service provider, service plan, and settings used in connecting to the
mobile network. Additional settings configure the Digi SureLink™ feature.
The process for configuring your device and the settings displayed on the Mobile Configuration page
vary according to whether the mobile service provider network used with your Digi Cellular Family
product is based on GSM (Global System for Mobile communication) or LTE (Long-Term Evolution).
To configure the cellular interface for XBee Industrial Gateway, select the link below.

n Set up and configure a cellular device

There are several other related settings for cellular devices, including:
n Mobile Configuration page

n Digi Mobile SureLink™ settings

n Mobile firewall settings

Once the mobile settings have been configured, you can monitor the status of mobile connections by
going to Administration > Mobile Status. See Mobile device status for more information.

Default behavior with the cellular network
For cellular networks, the default behavior for XBee Industrial Gateway is as follows:

n The default behavior regarding NTP time server access, Configure Remote Manager
connectivity settings, and DNS server all proceed as described.

n You must connect XBee Industrial Gateway to the cellular network. How you connect XBee
Industrial Gateway to the cellular network depends on the type of cellular modem in the
device.

n Signal strength, account registration, and other issues can impact activation. For common
issues and resolutions, see Cellular connection issues.

http://tools.ietf.org/html/rfc3927
http://tools.ietf.org/html/rfc3927
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Set up and configure a cellular device
This task requires a small screwdriver and a SIM card for your device.

Note This process should be completed for both GSM and LTE devices.

1. Obtain an account with your carrier of choice. The carrier will provide a SIM card and account
information, such as the APN and possibly a user name and password for the account.

2. Install the SIM card in the device.

a. Using a small screwdriver, open the SIM door on the top of the device.

Note The device has two SIM card slots. Only the slot numbered "1" is supported.
The slot numbered "2" is not supported.

b. Insert the SIM card in slot numbered "1". Make sure card is firmly inserted into the
card cage.

c. Close the SIM door.

d. Using a small screwdriver, screw the SIM door shut.

3. Power on the device.

4. Go to the mobile connectivity page.
n For Remote Manager, access Remote Manager and log in. Click the Mobile link.

See Configure settings from Remote Manager for information about adding a device to
Remote Manager

n For the web interface, open a browser and go to the XBee Industrial Gateway web
interface. Click Configuration > Mobile Connectivity.

See Configure settings from the XBee Industrial Gateway web interface for information
about accessing the web interface

5. Enter the connection settings for the cellular modem in the device. You can get this information
from your service provider and the information varies by service provider. In some cases, a user
name, password, or PIN are not necessary. See Mobile Configuration page for more
information about the fields in this screen.

a. In the Username and Password fields, enter the user name and the password, if
provided.

b. In the Access Point Name (APN) field, enter the APN. Note that an APN may not be
required for Verizon.

c. In the SIM PIN field, enter the SIM PIN, if provided.

d. Click Apply to save the mobile connectivity information to XBee Industrial Gateway.

https://remotemanager.digi.com/
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6. For the web interface only: Go to the Administration > Mobile Status page to view the
mobile status information. You can refresh the page to see the latest status information.

The device should now be able to connect to the mobile network. The status fields on the
Administration > Mobile Status fields will change to reflect the connectivity status.

n If the device successfully connects to the networks, two key connectivity status fields
appear as follows: SIM Pin State: READY and Connection state: Connected.

n If the device does not connect to the network, you do not see SIM Pin State on the
Mobile Status page, and/or the Connection state field has a value other than
Connected, additional setup and troubleshooting is necessary. See Troubleshooting
XBee Industrial Gateway GSM and LTE devices.

Configure mobile settings
To configure mobile settings, choose one of the following options:
From Remote Manager

1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Click Mobile. The mobile connectivity settings identify the service provider to use when
connecting to the mobile network. Some values may be hidden, depending on your model.

4. Complete the fields and click Save to save your changes.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Click Configuration > Mobile Connectivity. The Mobile Connectivity settings identify the
service provider to use when connecting to the mobile network. Some values may be hidden,
depending on your model.

3. Complete the fields and click Apply to save your changes.

Mobile Configuration page
The Mobile settings on the Mobile page identify the service provider to use when connecting to the
mobile network.

n DNS server set by network: Select this option when you want to use the DNS server set by
the network.

n Username: The user name of the mobile connection needed to access the mobile network.
Depending on mobile service provider, this value may not be necessary.

n Password: The password of the mobile connection needed to access the mobile network.
Depending on mobile service provider, this value may not be necessary.

n Access Point Name (APN): The service plan or access point name (APN).
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n SIM PIN: A password that allows an administrator of the device to access information on the
SIM card. The password is usually between four and eight digits. SIM PINs act like ATM PINs in
that they require users to authenticate themselves as the true owner of the card before
information is released. Depending on mobile service provider, this value may not be necessary.

Mobile Connectivity Configuration page
The Mobile Connectivity settings identify the service provider to use when connecting to the mobile
network. The information that appears varies by product and whether the device is GSM- or CDMA-
based. In addition, you can enable and configure the Short Message Service (SMS) from this page. For
GSM-based devices, enter the information for your account after you receive it from the mobile service
provider.
The fields on the Mobile Connectivity Configuration page are described as follows:

Current Status
This field displays the current status of the cellular modem and mobile connection, including serial
number information, signal strength and quality, and connection state.

Current Settings
n Mobile APN: The service plan or access point name (APN).

n Username: The user name of the mobile connection needed to access the mobile network.
Depending on mobile service provider, this value may not be necessary.

n Password: The password of the mobile connection needed to access the mobile network.
Depending on mobile service provider, this value may not be necessary.

n SIM PIN: A password that allows an administrator of the device to access information on the
SIM card. The password is usually between four and eight digits. SIM PINs act like ATM PINs in
that they require users to authenticate themselves as the true owner of the card before
information is released. Depending on mobile service provider, this value may not be necessary.

Short Message Service (SMS) settings
The SMS settings options configure the cellular Short Message Service (SMS) capabilities of the
cellular modem.

n Enable cellular Short Message Service (SMS) services: Enables or disables SMS features on
this Digi device. When this option is enabled, the you can configure the remaining SMS options.
This option is enabled (on) by default. When you disable SMS services, all SMS-related menu
items in the web interface and Remote Manager are disabled.

Device Cloud SMS settings
These settings configure the Remote Manager-registered device to be managed by Remote Manager
via Short Message Service (SMS) messages.
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n Enable Device Cloud SMS: Enables or disables Remote Manager SMS support.

n Phone Number: The phone number or short code of the Remote Manager server. This is a
setting in the device that allows the device to send to Remote Manager, and possibly restrict
messages to those coming from Remote Manager. The default value phone number is 32075.

n Service Identifier: The Service Identifier (prefix) of Remote Manager. This field is an optional
setting. You can use it when there is a shared short code in use, and an identifier (prefix) is
required to redirect a message to a specific service under that short code. The default value is
idgp. Use of the Service Identifier idgp is mandatory when the Phone Number is 32075.

n Opt-in: : Enables or disables the Device Cloud SMS opt-in feature. By default, XBee Gateway
cellular models are configured to automatically register with the Remote Manager Technical
Support when you first power up your device. Activation with Remote Manager Technical
Support is free. The Remote Manager Technical Support team will only access your device upon
your approval. With your consent, the Remote Manager Technical Support team can view and
access your device to diagnose and resolve issues if you require assistance. In the automatic
registration process, XBee Gateway cellular models attempt to send a single SMS message
containing the device’s mobile phone number. Your cellular account must be set up to send and
receive SMS messages. Network costs associated with this single SMS transmission are the
customer’s responsibility. Any device information stored in the Remote Manager Technical
Account is secured with adherence to Remote Manager’s security and privacy procedures, and
will not be disclosed to, or accessible by third parties.

n Restrict Sender: Only process inbound messages for Remote Manager from the number
specified in the Phone Number setting. Messages from other phone numbers will be passed on
to other SMS Services on the device.

n Reply to Sender Phone Number: This is an advanced option that rarely needs to be changed.
This option directs Remote Manager command replies to be sent to the phone number of the
sender of the request. Clear this check box to force replies to be sent to the configured phone
number.

Digi Mobile SureLink™ settings
SureLink is an optional feature that monitors the integrity of an established network connection.
Currently only cellular communications support SureLink.
You can configure the Link Integrity Monitoring settings to run a test that examines the functional
integrity of the network connection, and take action to recover the connection in the event that the
connection is lost.

Configure Mobile SureLink settings
To configure SureLink settings, choose one of the following options:
From Remote Manager

1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.
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3. Click Mobile > SureLink.

4. Complete the fields and then click Save to save your changes.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Click Configuration > SureLink.

3. Click on the Mobile Link Integrity Monitoring section.

4. Complete the fields and then click Apply to save your changes.

Mobile SureLink integrity monitoring settings
Enable Link Integrity Monitoring using the test method selected below
Enables or disables the link integrity monitoring tests. If this setting is enabled, you can configure the
other Link Integrity Monitoring settings and use these settings to verify the functional integrity of the
mobile connection. The default is off (disabled).
Link Integrity Monitoring Method
Several tests are available. For details about each type, see Link integrity test options.

n Ping Test

n TCP Connection Test

n DNS Lookup Test

n Device Cloud Connection Test

Host Address
These settings apply to Ping, TCP Connection, and DNS Lookup tests only. Two hostnames may be
configured for the link integrity monitoring test. You can specify hostnames in the form of domain
names or IP addresses. If the first hostname fails to reply, the same test is sent to the second
hostname. The test fails if no reply is received for either hostname. The primary and secondary DNS
names must be fully qualified domain names. Note that the reverse lookup of an IP address is
possible, but that is usually unlikely to succeed in returning a name. You can still use a reverse lookup
to demonstrate the integrity of the mobile connection.
TCP Port
The TCP port number to connect to on the remote host. The default is 80.
Repeat the selected link integrity test every N seconds
Specifies the interval, in seconds, at which the selected test is initiated (repeated). A new test will be
started every N seconds while the mobile connection is established. This value must be between 10
and 65535. The default is 240. Only the Ping, TCP Connection Test, and DNS Lookup Test options
use this setting. The Device Cloud Connection Test option does not use this setting.
If the configured interval is less time than it takes a test to complete, the next test will not be
initiated until the previous (current) test has completed.
Test only when idle if no data is received for the above period of time
Repeats the test using the test repeat interval (above) after an idle period interval. That is, initiate the
selected link integrity test only after no data has been received for the specified interval of time. This
changes the behavior of the test in that the test interval varies according to the presence of other
data received from the mobile connection. Only the Ping, TCP Connection Test, and DNS Lookup
Test options use this setting. The Device Cloud Connection Test option does not use this setting.
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Although using this idle option may result in less data being exchanged over the mobile connection, it
also prevents the link integrity tests from running as often to verify the true bi-directional state of
that connection.
Reset the link after this many link integrity test failures
The mobile connection resets or reconnects after the specified number of consecutive line integrity
test failures. The mobile connection (reset or reconnect) is determined by the Link failure action
setting.
This value must be between 1 and 255. The default is 3. When the mobile connection is reestablished,
the “consecutive failures” counter is reset to zero.
If the mobile connection is disconnected for any reason (including not as a result of a link integrity test
failure), the consecutive failures count is reset to zero when the mobile connection is reestablished.
Link Failure Action
The action to be performed when a link failure is detected:

n No action: No action is performed.

n Reset device: Reset the cellular modem in the XBee Industrial Gateway device.

n Reconnect interface: Reconnect the cellular interface.

Link integrity test options
There are several link integrity tests available:

n Ping Test

n TCP Connection Test

n DNS Lookup Test

n Device Cloud Connection Test
You can use these tests to demonstrate that two-way communication is working over the mobile
connection. Several tests are provided because different mobile networks or firewalls may allow or
block Internet packets for various services. Select the appropriate test according to the mobile
network constraints and your preferences.
The link integrity tests are only performed while the mobile connection is established. If the mobile
connection is disconnected, the link integrity tests are suspended until the connection is established
again.
For the link integrity tests to provide meaningful results, the remote or target hosts must be
accessible over the mobile connection and not through the LAN interface of the device (if it has one).
That is, you should configure the settings to guarantee that the mobile connection is actually being
tested.
You can modify the link integrity test settings at any time. These changes go into effect at the start of
the next test interval.

Ping Test
Enables or disables the use of “ping” (ICMP) as a test to verify the integrity of the mobile connection.
The test is successful if a valid ping reply is received in response to the ping request sent. The ping
test sends 1 ping request and waits up to 30 pings for a reply. When a valid reply is received, the test
completes successfully and immediately.
You can configure destination hosts for this test. If the first host fails to reply to the ping request, the
same test is attempted to the second host. If neither host replies to any of the ping requests sent, the
test fails. The primary and secondary addresses may be either IP addresses or fully qualified domain
names.
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n Primary Address: First host to test.

n Secondary Address: Second host to test if the first host fails.

TCP Connection Test
Enables or disables the creation of a new TCP connection as a test to verify the integrity of the mobile
connection. A successful test establishes a TCP connection to a specified remote host and port
number. If the remote host actively refuses the connection request, the test fails. The TCP connection
test waits up to 30 seconds for the connection to be established or refused. When the TCP connection
is established, the test completes successfully, and the TCP connection is closed immediately.
You can configure two destination hosts for this test. If the first host fails to establish (or refuse) the
TCP connection, the same test is attempted to the second host. If neither host successfully
establishes (or refuses) the TCP connection, the test fails. The primary and secondary addresses may
be either IP addresses or fully qualified domain names.

n TCP Port: The TCP port number to connect to on the remote host. The default is 80.

DNS Lookup Test
nables or disables the use of a Domain Name Server (DNS) lookup as a test to verify the integrity of
the mobile connection. The test is successful if the DNS server sends valid reply. Typically, this means
the hostname is successfully “resolved” to an IP address by a DNS server. But even a reply such as
“not found” or “name does not exist” is acceptable as a successful test result, because that
demonstrates successful two-way communication over the mobile connection. When a valid reply is
received, the test completes successfully and immediately.
This test uses the primary and secondary DNS server obtained from the mobile network when the
PPP connection is first established. You can view these addresses on the Administration > Mobile
Status page.

Note The LTE modem does not use a PPP connection.

Device Cloud Connection Test
Enables or disables verification of the Remote Manager connection. The test is successful if you can
establish a connection to the configured Remote Manager server, and if you can exchange keep-alive
messages with the server. The test fails if you cannot establish a connection or if keep-alive messages
stop. You can configure the Remote Manager server on the Advanced Configuration > Device Cloud
Connectivity page.

DNS settings
These settings are the two Domain Name System servers to be used as static servers when dynamic
mechanisms do not supply enough DNS servers.
See Default behavior regarding DNS for more information about default behavior.

Configure Domain Name Server (DNS)
From Remote Manager

1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Click Domain Name Server (DNS).

4. Complete the fields and click Save to save your changes.
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Domain Name Server (DNS) Configuration page
In this page you can configure the Domain Name System servers to be used as static servers when
dynamic mechanisms do not supply enough DNS servers. The IP addresses of Domain Name Servers
(DNS) used to resolve computer host names to IP addresses. Static DNS servers are specified
independently of any network interface and its connection state. An IP address of 0.0.0.0 indicates no
server is specified.

n Primary DNS: The name of the primary DNS server.

n Secondary DNS: The second DNS server that is used if the primary DNS server fails to respond.

n Alternate DNS: A DNS server that is used if the primary or secondary DNS servers fail to
respond.

Mobile firewall settings
You can configure a network firewall for the XBee Industrial Gateway mobile network interface in the
firewall configuration page. This firewall reduces cellular traffic and cloaks the device, making it
harder to find and reduces the risk of unauthorized access and attacks. While this firewall does not
reduce the traffic sent to the device, it prevents the device from replying to it, because the firewall
discards the packets sent to it, unless the packets are associated with an established communication
(connection).

Note This is available for cellular models only.

See Firewalls and required open ports for more information.

Configure mobile firewall settings
To configure mobile firewall settings, choose one of the following options:
From Remote Manager

1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Select Advanced Settings > Firewall settings.

4. Complete the fields and click Save to save your changes.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Select Configuration > Mobile Firewall to access the mobile firewall settings.

3. Complete the fields and click Apply to save your changes.

Enable or Disable Mobile firewall settings
Firewall enable

n On: Enable the firewall for the mobile network interface. By default the firewall is on (enabled).

n Off: Disable the firewall for the mobile network interface.
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CAUTION! Disabling the mobile firewall may expose the device to attacks through the
mobile network.

Autostart settings for the Python Program
You can use the Python autostart settings to configure Python programs that are loaded on XBee
Industrial Gateway to automatically start when the device starts. These programs are executed
through the specified python commands.
See File management for details on loading files.
See Configure a Python application in the web interface for more information on managing application
files and their associated Python processes.

Configure Python settings
To configure Python settings, choose one of the following options:
From Remote Manager

1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Click Python.

4. Complete the fields and click Save to save your changes.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Click Configuration > Python to access the Python network settings.

3. Complete the fields and click Apply to save your changes.

Python settings
The Python Configuration page displays the following Python settings:

n Enable: Enables or disables the associated Python command for this Digi device. When you
select this check box, the associated Python program automatically starts on system startup.

n Command Line (with optional arguments): Type the name of the Python file, and any
program arguments, required to start on system startup.

n Active: When the icon is green, the Python program is running.

n On Program Exit: Select the action to be performed when the program exits. Your options are
as follows:

l No action taken: Continue device operation without doing anything about the program.

l Restart python program: Restart the Python program.

l Reboot the device: Reboot the device.
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Network services settings
You can use the Network Services settings to enable or disable common network services that are
available on XBee Industrial Gateway, and configure the network port on which the service is listening.
You can also disable certain services so the device runs only those services specifically needed and to
improve device security.

Note This is available for Cellular models only.

Configure network services settings
To configure network settings, choose one of the following options:
From Remote Manager

1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Click Network Services.

4. Complete the fields and click Save to save your changes.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Click Configuration > Network Services. The Network Service Configuration page appears.

3. Choose one of the following options:
n To enable a network service, select the check box next to the service and type a port

number in the TCP Port field.

n To disable a network service, clear the check box next to the service.

4. Select the one of the following modes from the Device Discovery Services ADDP Mode drop-
down list:

n Read-Write: Allows discovery of devices and the ability to change network settings
through the Digi Device Discovery utility. This is the default setting on firmware versions
3.2.29.x and earlier.

n Read-Only: Allows discovery of devices only. This is the default setting on firmware
versions 3.2.30.x and later.

n Off: Turns off the ADDP network service. This setting completely closes the network
port used for device discovery.

5. Click Apply to save your changes.

Network Services Configuration page
The Network Services Configuration page allows you to enable or disable the network services as
needed. It also allows you to control how Digi devices are discovered.
The following table describes each service and its default TCP port number.

Tip Use the default TCP port numbers for these services because they are well-known by most
applications.
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Setting Services provided

Default
TCP Port
Number

Enable Secure Shell
Server (SSH)

Secure Shell Server (SSH) allows users secure access to sign in
to the Digi device and access the command-line interface.
Essentially, pulling content from the XBee Industrial Gateway
web interface.

22

Enable Web Server
(HTTP)

HyperText Transfer Protocol (HTTP), also known as Web Server,
provides access to web pages for configuration and web
services. HTTP and HTTPS (see the Enable Secure Web Server
(HTTPS) definition) are also referred to as Web Server or
Secure Web Server. These services control the use of the web
interface. If HTTP and HTTPS are disabled, device users cannot
use the web interface to configure, monitor, and administer the
device.

80

Enable Secure Web
Server (HTTPS)

HyperText Transfer Protocol over Secure Socket Layer (HTTPS),
also known as Secure Web Server, uses encryption to improve
the security of web data transfers.

443

Device Discovery
Service (ADDP)
Mode

Device Discovery Service handles discovery of Digi devices on a
network, using a Digi-proprietary protocol called ADDP and the
Digi Device Discovery utility. See Access the XBee Industrial
Gateway web interface for more information. The Device
Discovery Service also allows you to change network settings.
The Device Discovery Service can also be completely disabled.
The settings for this network service are as follows:

n Read-Write: Allows you to discover devices and change
network settings through the Digi Device Discovery
utility. This is the default setting on firmware versions
3.2.29.x and earlier.

n Read-Only: Allows you to discover of devices only. This is
the default setting on firmware versions 3.2.30.x and
later.

n Off: Turns off the ADDP network service. This setting
completely closes the network port used for device
discovery.

2362
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Host Name Configuration
n Host Name: The host name to be placed in the DHCP Option 12 field. This is an optional setting

that is only used when DHCP is enabled.

The host name is validated and must contain only specific characters. These restrictions are as
defined in RFCs 952, 1035, 1123 and 2132. The following characters are allowed:
l Alphabetic: upper and lower case letters A through Z and a through z

l Numeric: digits 0 through 9

l Hyphen (dash): -

l Period (dot): .

You can specify a single name or a fully qualified domain name, whose parts are separated with
a period character, as the host name value. Each part must comply the following rules:
l Must begin with a letter or digit

l Must end with a letter or digit

l Interior characters may be a letter, digit or hyphen

l Each part of the name may be from 1 to 63 characters in length, and the full host name
may be up to 127 characters in length. An IP address is not permitted for use in this host
name setting.

Domain Name Service Configuration
These settings are the two Domain Name System servers to be used as static servers when dynamic
mechanisms do not supply enough DNS servers.
The IP addresses of Domain Name Servers (DNS) used to resolve computer host names to IP
addresses. Static DNS servers are specified independently of any network interface and its connection
state. An IP address of 0.0.0.0 indicates no server is specified.

n Primary DNS: The primary DNS server.

n Secondary DNS: The second DNS server to used if the primary DNS fails to respond.

Configure Remote Manager connectivity settings
XBee Industrial Gateway is compatible with the Remote Manager device and data management
platform. Remote Manager provides a mechanism to do more advanced device configuration than is
generally possible from the XBee Industrial Gateway web interface. Once the device has established
network connectivity to Remote Manager, you can manage the device remotely using the Remote
Manager interface.
Remote Manager connectivity is enabled by default. When you power on XBee Industrial Gateway in
any network, it attempts to connect to a Remote Manager server.
The only time you need to change any Remote Manager configuration settings are under the following
circumstances:

n You want to change the instance of Remote Manager to which XBee Industrial Gateway is
connected. See Connect to a different instance of Remote Manager.

n XBee Industrial Gateway operates in a network with firewalls. In this case, you will need to
configure a proxy server. See Configure a proxy server.
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The basic Device Cloud Configuration settings allow you to enable or disable the connection to the
Remote Manager server used for managing the XBee Industrial Gateway device, configure the
Remote Manager server, and configures the proxy server, if used. The Advanced Settings configure
additional behaviors for the Remote Manager connection, including connect and disconnect behaviors,
protocol details, and use of keepalives for the connection. The default settings for Remote Manager
remote management usually work for most situations.

Configure connectivity settings
To configure connectivity settings, choose one of the following options:
From Remote Manager

1. Access and log in to Remote Manager

2. Click the Device Management tab.

3. From the device list, double-click the device to display the device properties menu.

4. Click Advanced Configuration > Device Cloud client initiated connection. The Device
Cloud client initiated connection page appears.

a. For Connection enable, select the On option.

b. Determine the Connection reconnect timeout options. See Device Cloud client
initiated connection page for information about the settings.

c. Click Save to save the changes.

5. Click Advanced Configuration > Device Cloud configuration. The Device Cloud
configuration page appears.

a. The default settings for Remote Manager usually work for most situations. Only
change these settings when the defaults settings do not work properly. See Device
Cloud Configuration page for information about the settings.

b. Click Save to save the changes.

6. Click Advanced Configuration > Device Cloud network type. You can configure keep-alive
information for ethernet or mobile systems.

a. Click Device Cloud network type eth or Device Cloud network type mobile.

b. Configure keep-alive information. See Device Cloud network type page for
information about these settings.

c. Click Save to save the changes.

From the XBee Industrial Gateway web interface
1. Access the XBee Industrial Gateway web interface.

2. Select Configuration > Device Cloud Connectivity to access the connectivity settings. The
Device Cloud Configuration page displays the basic settings.

3. Complete the fields under basic settings. See Basic connectivity settings.

4. Click Advanced Settings. The Advanced Settings section on the Device Cloud Configuration
page appears.

5. Complete the fields under Advanced Settings. See Advanced connectivity settings for the web
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interface.

6. Click Apply to save your changes.

Device Cloud Configuration page
The default settings for Remote Manager usually work for most situations. You can configure the idle
timeout for the connection between XBee Industrial Gateway and Remote Manager, and the keep-
alive settings of the various interfaces (TCP and HTTP for mobile and Ethernet network connections).
Only change these settings when the defaults settings do not work properly.
Connection Type
Leave this set to SSL, which is the default option.
Server List
Up to four servers can be configured in the server list. The value for this setting is generally a Fully
Qualified Domain Name (FQDN) pointing to one of the Remote Manager servers. Obtain this value
from your Remote Manager server administrator. Typically this administrator is Digi.
The default value for Server List: 1 is my.devicecloud.com.
Server TCP Port
The network port number for the Remote Manager server. The default value is 3199.
Proxy server address
This setting specifies the URL of the system that provides network access.
The Proxy server address works in conjunction with the Proxy server TCP port field. These settings
configure XBee Industrial Gateway to connect to Remote Manager using HTTP over proxy. You can
create a path to a Remote Manager server through a local HTTP proxy, such as squid, provided that
you use the server to simply remap the target IP address and port number, without extra
authentication or other security measures.
Proxy server TCP port
The port number forwards network connection attempts to the Remote Manager server. Obtain
these values from your Remote Manager server administrator.
Connection idle timeout (seconds)
Enables or disables the idle timeout for the Remote Manager connection between device and server.
The idle timeout is enabled by default. Specifying Disabled disables the idle timeout. Specifying a
timeout value enables the idle timeout, which means the connection will be dropped after the
specified number of seconds. The minimum value is 300 and the maximum 43200.
Protocol compression enable
Configures whether RCI command and response text is compressed, when both are passed between
the Digi device and the Remote Manager server. This compression primarily affects the size of the
data passed when settings or state information are formatted as RCI and conveyed between device
and server. Using compression on this RCI text can reduce the size of passed data, and, for cellular
products, reduce the cost of reading and writing device settings. When you enable RCI compression,
the RCI command and response text is compressed using LIBZ compression when it is sent between
device and server. The protocol used to manage and pass data between devices and Remote
Manager, known as EDP, internally negotiates whether compression is applied. RCI compression is
enabled, or “on” by default to reduce byte count and cost of sending data. As an example of savings,
typical cellular router settings will compress to about 8% of its original size, which means that you can
send data in far fewer packets and less time, than an uncompressed version of the same data. Only
disable RCI compression for technical support and troubleshooting purposes. For example, if you want
to eliminate the possibility that this compression is causing some sort of problem.
TCP no delay enable

http://my.devicecloud.com/
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Configures whether use of the TCP no delay option is disabled by default for the Remote Manager
connection between device and server, when configuring the device's TCP socket endpoint for that
connection. The default is disabled. This default reduces the number of packets sent when the
Remote Manager connection is established between device and server. While there is a very slight
penalty in terms of added latency, that penalty is very small compared to the relative high latencies
for cellular network communications. Reducing the packet count reduces the number of bytes
exchanged over the cellular connection, which saves money. The typical start-up data count is reduced
from about 7 KB to 4 KB by disabling TCP no delay. The ability to turn on the TCP No delay option is
provided for technical support and troubleshooting purposes.
TCP keep alives enable
Enables or disables the ability to send TCP keep-alive packets over the client-initiated connection to
the Remote Manager server, and whether the device waits before dropping the connection. The
default is enabled.

Device Cloud client initiated connection page
You can use the settings on this page to enable Remote Manager and specify reconnect timeout
settings.
Connection enable
Enables or disables the connection from XBee Industrial Gateway to the Remote Manager server.
Disable this feature if you have no use for Remote Manager, and want to eliminate any Remote
Manager-related network traffic.
Connection reconnect timeout (seconds)
These settings control whether to automatically reconnect to Remote Manager after being
disconnected and waiting for the specified amount of time.
If you do not want to automatically reconnect to Remote Manager after a disconnect, choose Never
reconnect.

Note From the web interface, clear the Reconnection delay check box.

Device Cloud network type page

Keep-alive Ethernet and Keep-alive Mobile
These settings control how often keep-alive packets are sent over the device-initiated connection to
Remote Manager, and whether the Remote Manager-registered device waits before dropping the
connection. Keep-alives for the Remote Manager connection serve three basic purposes:

1. Keep the Remote Manager connection alive through network infrastructure such as routers,
NATs and firewalls.

2. Inform the other (remote) side of the Remote Manager connection that its peer is still active.
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3. Test the Remote Manager connection to verify whether or not it stopped responding and
should be abandoned. Recovery actions are taken as configured in other settings. The Remote
Manager-registered device and Remote Manager each perform their own independent
monitoring of the Remote Manager connection state (active, idle and missed keep-alives). If
Remote Manager protocol messages or data other than keepalives is exchanged over the
Remote Manager connection, the idle timers that trigger keep-alives are reset, and the
consecutive missed keep-alive counts are cleared to zero.

n Device send keep-alive interval: Specifies how frequently the device sends a keep-
alive packet to Remote Manager if the Remote Manager connection is idle. Remote
Manager expects to receive either Remote Manager protocol messages or keep-alive
packets from the device at this interval.

n Server Send Interval: Specifies how frequently the Remote Manager-registered device
sends a keep-alive packet to Remote Manager if the Remote Manager connection is
idle. Remote Manager expects to receive either Remote Manager protocol messages or
keep-alive packets from the Remote Manager-registered device at this interval.

n Maximum consecutive missed keep-alives: After missing the number of consecutive
expected keep-alives specified by this setting, according to the configured intervals, the
connection is considered lost and is closed by the device and Remote Manager.

Note The best practice is to set this interval value as long as your application can tolerate to reduce
the amount of data traffic.

Basic connectivity settings
n Enable Device Cloud Connectivity (Device Cloud)

Let my XBee Gateway connect to Device Cloud (web interface):

Enables or disables the connection from XBee Industrial Gateway to the Remote Manager
server. Disable this feature if you have no use for Remote Manager, and want to eliminate any
Remote Manager-related network traffic.

n Device Cloud Server (Remote Manager)
Server URL (web interface):

The value for this setting is generally a Fully Qualified Domain Name (FQDN) pointing to one of
the Remote Manager servers. Obtain this value from your Remote Manager server
administrator. Typically this administrator is Digi. The default value is my.devicecloud.com.

n Device Cloud Server Port (Remote Manager)
Server Port (web interface):

The network port number for the Remote Manager server. The default value is 3199.

http://my.devicecloud.com/
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n Proxy Server: The Proxy Server settings configure XBee Industrial Gateway to connect to
Remote Manager using HTTP over proxy. You can create a path to a Remote Manager server
through a local HTTP proxy, such as squid, provided that you use the server to simply remap
the target IP address and port number, without extra authentication or other security
measures. This setting specifies the URL of the system that provides network access.

n Proxy Server Port: The port number forwards network connection attempts to the Remote
Manager server. Obtain these values from your Remote Manager server administrator.

Advanced connectivity settings for the web interface
The default settings for Remote Manager usually work for most situations. The Advanced settings
configure the idle timeout for the connection between XBee Industrial Gateway and Remote Manager,
and the keep-alive settings of the various interfaces (TCP and HTTP for mobile and Ethernet network
connections). Only change these settings when the defaults settings do not work properly.

n Use an HTTP proxy to connect to Remote Manager (Web interface only): Configures XBee
Industrial Gateway to connect to Remote Manager using HTTP over proxy. You can create path
to a Remote Manager server through a local HTTP proxy, such as squid, provided that you use
the server to simply remap the target IP address and port number, without extra
authentication or other security measures.

n Proxy Server URL: The URL of the system that provides network access. Obtain this value
from your Remote Manager server administrator.

n Proxy Server Port: That port number forwards network connection attempts to the Remote
Manager server. Obtain this value from your Remote Manager server administrator.

n Protocol: The protocol used to configure several aspects of Remote Manager connection and
protocol management.

n Reconnection delay
Reconnection delay: n seconds:

These settings control whether to automatically reconnect to Remote Manager after being
disconnected and waiting for the specified amount of time.

If you do not want to automatically reconnect to Remote Manager after a disconnect:
l From Remote Manager, choose Never reconnect.

l From the web interface, clear the Reconnection delay check box.
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n Disconnect after inactivity period
Inactivity time: n seconds:

Enables or disables the idle timeout for the Remote Manager connection between device and
server. The idle timeout is enabled by default. Specifying “none” disables the idle timeout.
Specifying a timeout value enables the idle timeout, which means the connection will be
dropped after the specified number of seconds. The minimum value is 300 and the maximum
43200. In contrast to TCP keep-alives, the timeout managed by the “connidletimeout” option
is at the Remote Manager application level. The “connidletimeout” option provides a way to
close the connection to the Remote Manager server if no Remote Manager protocol data is
sent or received within a specified time frame. That is, the connection is idle with no traffic in
or out for that amount of time. This capability is particularly useful for server-initiated
connections. When a user on the server side requests a connection be established to a device,
that user needs to explicitly terminate the connection when they are done with the device. This
timeout allows you to configure the device so that a “forgetful user” does not inadvertently
leave the connection in place, which could cost money on a cellular connection if Connectware
or TCP keepalives are enabled and transferred needlessly between device and server.

n Enable protocol compression: Configures whether RCI command and response text is
compressed, when both are passed between the Digi device and the Remote Manager server.
This compression primarily affects the size of the data passed when settings or state
information are formatted as RCI and conveyed between device and server. Using compression
on this RCI text can reduce the size of passed data, and, for cellular products, reduce the cost
of reading and writing device settings. When you enable RCI compression, the RCI command
and response text is compressed using LIBZ compression when it is sent between device and
server. The protocol used to manage and pass data between devices and Remote Manager,
known as EDP, internally negotiates whether compression is applied. RCI compression is
enabled, or “on” by default to reduce byte count and cost of sending data. As an example of
savings, typical cellular router settings will compress to about 8% of its original size, which
means that you can send data in far fewer packets and less time, than an uncompressed
version of the same data. Only disable RCI compression for technical support and
troubleshooting purposes. For example, if you want to eliminate the possibility that this
compression is causing some sort of problem.
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n Socket: Configuration settings for the device's TCP socket.
l Enable TCP no delay: Configures whether use of the TCP no delay option is disabled by

default for the Remote Manager connection between device and server, when configuring
the device's TCP socket endpoint for that connection. The default is disabled. This default
reduces the number of packets sent when the Remote Manager connection is established
between device and server. While there is a very slight penalty in terms of added latency,
that penalty is very small compared to the relative high latencies for cellular network
communications. Reducing the packet count reduces the number of bytes exchanged over
the cellular connection, which saves money. The typical start-up data count is reduced from
about 7 KB to 4 KB by disabling TCP no delay. The ability to turn on the TCP No delay option
is provided for technical support and troubleshooting purposes.

l Enable TCP keep-alive: Enables or disables the ability to send TCP keep-alive packets
over the client-initiated connection to the Remote Manager server, and whether the device
waits before dropping the connection. The default is enabled.

Connect to a different instance of Remote Manager
To connect to a different instance of a Remote Manager:

1. Access the XBee Industrial Gateway web interface.

2. Click Configuration > Device Cloud Connectivity.

3.  On the Remote Manager Configuration page, in the Device Cloud Server setting, select
Other....

4. In the Server URL setting, type the name of the different instance of Remote Manager; for
example, remote-manager.example.com.

5. In the Server Port field, type the network port number to be used for this Remote Manager
instance.

6. Click Apply.

Configure a proxy server
To configure the proxy server:

1. Access the XBee Industrial Gateway web interface.

2. Click Configuration > Device Cloud Connectivity.

3. From the Device Cloud Configuration page, click Advanced Settings.

4. Select Use an HTTP proxy to connect to Remote Manager and complete the fields.

Tip Contact your network administrator for assistance in configuring a proxy server.

Ethernet SureLink™ settings
SureLink is an optional feature that monitors the integrity of an established Ethernet network
connection.
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Currently only cellular communications support SureLink.
You can configure the settings to run a test that examines the functional integrity of the Ethernet
network connection, and take action to recover the connection in the event that the connection is
lost.

Configure Ethernet SureLink settings
To configure Ethernet SureLink settings, choose one of the following options:
From Remote Manager

1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Complete the fields and then click Save to save your changes.

From the XBee Industrial Gateway web interface
1. From the XBee Industrial Gateway web interface, click SureLink under Configuration.

2. Click on the Ethernet Link Integrity Monitoring section.

3. Complete the fields and then click Apply to save your changes.

Ethernet SureLink settings
You can configure the SureLink settings to run a selected test that examines the functional integrity of
the network connection, and take action to recover the connection in the event that it is lost.
Link test enable
Enables or disables the SureLink feature and the specified link integrity monitoring tests. The default
is off (disabled).
Test interval
The interval, in seconds, when the selected test is initiated (repeated). A new test starts every N
seconds while the mobile connection is established. You must specify a valid value between 10 and
65535 seconds. The default is 240. Only the Ping, TCP Connection Test, and DNS Lookup Test
options use this setting. The Device Cloud Connection Test option does not use this setting.
If the configured interval is less time than it takes a test to complete, the next test will not be
initiated until the previous (current) test has completed.
Test only if link is idle
Use the test repeat interval (above) as an idle period interval. That is, initiate the selected link
integrity test only after receiving no data for the specified interval of time. This changes the behavior
of the test in that the test interval varies according to the presence of other data received from the
mobile connection. Only the Ping, TCP Connection Test, and DNS Lookup Test options use this
setting. The Device Cloud Connection Test option does not use this setting.
Although using this idle option may result in less data exchanged over the mobile connection, it also
prevents the link integrity tests from running as often to verify the true bi-directional state of that
connection.
Number of consecutive failures to cause recovery action
The mobile connection will be disconnected and reestablished after the configured number of
consecutive link integrity test failures. This value must be between 1 and 255. The default is 3. The
“consecutive failures” counter resets to zero when the mobile connection is reestablished.
If the mobile connection disconnects for any reason (including not as a result of a link integrity test
failure), the consecutive failures count resets to zero when the mobile connection is reestablished.
Host List
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These settings apply to Ping, TCP Connection, and DNS Lookup tests only. Two hostnames may be
configured for the link integrity monitoring test. You can specify hostnames in the form of domain
names or IP addresses. If the first hostname fails to reply, the same test is sent to the second
hostname. The test fails if no reply is received for either hostname. The primary and secondary DNS
names must be fully qualified domain names. Note that the reverse lookup of an IP address is
possible, but that is usually unlikely to succeed in returning a name. You can still use a reverse lookup
to demonstrate the integrity of the mobile connection.

n Host List 1: The first hostname to look up.

n Host List 2: The second hostname to look up if the first hostname fails to respond.

Test type
Several tests are available. For details about each type, see Link integrity test options.

n Ping Test

n TCP Connection Test

n DNS Lookup Test

n Device Cloud Connection Test

Link failure action
The action to be performed when a link failure is detected:

n Reset modem: Reset the cellular modem in the XBee Industrial Gateway device.

n Reconnect interface: Reconnect the cellular interface.

GPS static position settings
You can use the settings in the GPS status position page to configure GPS support for XBee Industrial
Gateway.

Configure GPS Static Position settings
To configure GPS Static Position settings, choose one of the following options:
From Remote Manager

1. Click the Device Management tab.

2. Select Advanced Configuration > GPS Static Position.

3. Complete the fields in the GPS Static Position page.

4. Click Save to save your changes.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Click Configuration > GPS Static Position.

3. Complete the fields under GPS Static Position.

4. Click Apply to save your changes.

GPS Static Position page
The GPS Static Position page allows you to configure the position of a Digi device.
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n Enable use of the static position: Enables or disables the position for a static XBee Industrial
Gateway.

n Latitude: Defines the latitude component of the Digi device, in degrees. The value can range
from -90.0 to 90.0 degrees.

n Longitude: Defines the longitude component of the Digi device, in degrees. The value can
range from -180.0 to 180.0 degrees.

Network Failover settings
You can use the network failover feature to configure a cellular data connection as a backup to an
Ethernet connection. An Ethernet connection is normally used to route Remote Manager connections
or other application data. If the Ethernet connection stops working, data is routed over the cellular
connection instead. A configurable link integrity test determines if Ethernet is functional.

n Configure network failover on the XBee Industrial Gateway web interface

n Configure network failover in Remote Manager

Configure network failover on the XBee Industrial Gateway web
interface
You can configure network failover in web interface.

1. Access the web interface. You must log in to the web interface.

2. From the XBee Industrial Gateway web interface, click Configuration > SureLink.

3. Determine the network priority. By default, the Ethernet option should be the first option on
the list. If it is not, follow the process below to move the Ethernet option to top priority.

a. In the Network priority window, click on the Ethernet option.

b. Click the up and down arrows next to the window to move the Ethernet option to
the top of the list. The Mobile option automatically becomes the second option in
the list.

4. Select the When a link integrity test fails, switch to the lower priority network option to
enable failover.

5. Click on the Ethernet Link Integrity Monitoring section.
a. Click the Enable option.

b. From the test type options, select the test type that you want to use.
o For information about the test type options, see Link integrity test options.

o For information about how these options work with failover, see Link
integrity test options and failover.

c. Enter a primary test host name in the Primary Test Hostname field.

d. Optionally, enter a secondary test host name in the Secondary Test Hostname
field.

6. Click Apply to save your changes.
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Configure network failover in Remote Manager
You can configure network failover in Remote Manager.

1. Access Remote Manager and log in.

2. Click the Device Management tab.

3. From the list of devices, double-click on an XBee Industrial Gateway Cellular model device.

4. Enable network failover.
a. Click Advanced Configuration > Network Failover. The Network Failover page

appears.

b. Click the Failover enable: On option.

c. Click Save to save your changes.

5.  Configure the Ethernet network connection.
a. Click Ethernet (eth0) to configure the Ethernet settings.

b. Complete the fields. See Ethernet Configuration page for information about the
fields.

c. Click Save to save your changes

6. Configure a link test for the Ethernet network connection.
a. Click Advanced Configuration > SureLink > SureLink eth0. The SureLink eth0

page appears.

b. Complete the fields. See Ethernet SureLink settings for information about the
fields.

Note When selecting the test type option, see Link integrity test options and failover for
information about how each option works with failover.

a. Click Save to save your changes.

7. Configure the network priority. The Ethernet connection should have a higher priority. The
cellular network connect is configured as a backup to an Ethernet connection.

a. Click Ethernet (eth0). The Ethernet (eth0) page displays.

b. In the Default route metric field, specify a metric.

c. Click Save to save your changes.

d. Click Mobile. The Mobile page displays.

e. In the Default route metric field, specify a metric. The metric must have a higher
value than the metric specified in the Ethernet (eth0) page to ensure that the
cellular connection has a lower priority.

f. Click Save to save your changes.

Link integrity test options and failover
When you configure failover, you must select a test type option, which is used to verify link integrity for
failover.

https://remotemanager.digi.com/
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n Ping

n TCP Connection

n DNS Lookup

n Device Cloud

Note For details about each option, see Link integrity test options.

Choose Ping, TCP Connection, or DNS Lookup
For these methods, when the device fails over from the primary to the secondary hostname, the
device continues to monitor the primary hostname. If a connection to the primary hostname is
established, the device disconnects from the secondary hostname and re-connects to the primary
hostname.
Choose Device Cloud
For the Device Cloud method, the device only switches between hostnames if the currently active
hostname becomes unresponsive.

Time settings
XBee Industrial Gateway uses Network Time Protocol (NTP) for time synchronization. Using NTP
requires an external NTP time server. Time synchronization is critical to the security of the device,
including validating the certificates that sign firmware update images, as well as to verify the server
certificate when connecting to Remote Manager. Steps are taken to preserve a sense of the time
across reboots, but the availability of an NTP server or servers is important to the long-term health of
the device.
In environments where the device cannot directly connect to the Internet, you need to configure the
time server setting to point to a local NTP server when accurate long-term time is required. Most
users do not need to change the time server setting. If the Digi device is already connected to Remote
Manager, you can adjust the time server configuration from Remote Manager.
The default time settings are sufficient for most users. See Default behavior regarding NTP time
server access for more information about default behavior.

Configure time settings
To configure time settings, choose one of the following options:
From Remote Manager

1. Click the Device Management tab.

2. From the device list, double-click the device to display the device properties menu.

3. Select Advanced Configuration > Time server.

4. Complete the fields and click Save to save your changes.

5. Select Advanced Configuration > Time zone.

6. Complete the fields and click Save to save your changes.

From the XBee Industrial Gateway web interface
1. Access and log into the web interface.

2. Click Configuration > Time to access the network services settings.

3. Complete the fields and click Apply to save your changes.
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Time Server Configuration page
n Time server synchronization enable: When you select this setting, XBee Industrial Gateway

uses the Network Time Protocol (NTP) to keep system time synchronized to specified time
servers.

n NTP Time Precision: Controls how often XBee Industrial Gateway updates time information
from its NTP servers. Options are:
l Standard NTP Time Precision: XBee Industrial Gateway only synchronizes time with the

servers once every 24 hours. This option trades time precision for network utilization and is
most appropriate for cellular or other bandwidth-constrained devices.

l High NTP Time Precision: XBee Industrial Gateway synchronizes time on a dynamic
schedule determined by the NTP client to maintain time precision compliant to the NTP
standards.

n NTP Server 1|2|3|4: These settings configure the various Network Time Protocol (NTP) servers
that XBee Industrial Gateway uses to obtain current date and time.

For XBee Industrial Gateway Ethernet models, you can specify up to four NTP server settings
to be used as upstream servers in synchronizing time.

The default settings for the four NTP server settings are as follows:
l NTP server 1: 0.time.digi.com

l NTP server 2: 1.time.pool.ntp.org

l NTP server 3: 1.idigi.pool.ntp.org

l NTP server 4: 2.idigi.pool.ntp.org

Configure the XBee Industrial Gateway cellular models to use the top NTP Server entry (NTP
Server 1) entry, and leave the others blank because XBee Industrial Gateway checks all NTP
servers that are configured for time-drift. Configuring four NTP time servers for an XBee
Industrial Gateway cellular device would result in excessive and unnecessary cellular usage.

Time Zone Configuration page
Timezone: Specify the times zone for the device. The default setting is Coordinated Universal Time
(UTC).

Time Configuration page

Network Time Protocol (NTP) settings
n Enable Time Server Synchronization: When you select this setting, XBee Industrial Gateway

uses the Network Time Protocol (NTP) to keep system time synchronized to specified time
servers.
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n NTP Time Precision: Controls how often XBee Industrial Gateway updates time information
from its NTP servers. Options are:
l Standard NTP Time Precision: XBee Industrial Gateway only synchronizes time with the

servers once every 24 hours. This option trades time precision for network utilization and is
most appropriate for cellular or other bandwidth-constrained devices.

l High NTP Time Precision: XBee Industrial Gateway synchronizes time on a dynamic
schedule determined by the NTP client to maintain time precision compliant to the NTP
standards.

n NTP Server 1|2|3|4: These settings configure the various Network Time Protocol (NTP) servers
that XBee Industrial Gateway uses to obtain current date and time.

For XBee Industrial Gateway Ethernet models, you can specify up to four NTP server settings
to be used as upstream servers in synchronizing time.

The default settings for the four NTP server settings are as follows:
l NTP server 1: 0.time.digi.com

l NTP server 2: 1.time.pool.ntp.org

l NTP server 3: 1.idigi.pool.ntp.org

l NTP server 4: 2.idigi.pool.ntp.org

Configure the XBee Industrial Gateway cellular models to use the top NTP Server entry (NTP
Server 1) entry, and leave the others blank because XBee Industrial Gateway checks all NTP
servers that are configured for time-drift. Configuring four NTP time servers for an XBee
Industrial Gateway cellular device would result in excessive and unnecessary cellular usage.

Time settings

Note To set the time, you must first disable Enable Time Server Synchronization setting.

Set Time: Configures the hours, minutes, seconds, month, day, and year on XBee Industrial Gateway.

Timezone settings
Timezone: The default setting is Coordinated Universal Time (UTC).



Configure XBee network settings

XBee Industrial Gateway provides a gateway between Internet Protocol (IP) network devices and a
network of ZigBee wireless devices (which includes Digi XBee modules). Typically, these wireless
devices are small sensors and controllers. Remote nodes in an XBee network can include other XBee
ZigBee nodes.
You can configure the XBee module as a coordinator or router in a ZigBee network. For complete XBee
module settings and their descriptions, and discussions of XBee network concepts, see the XBee/XBee-
PRO S2C ZigBee RF Module User Guide.
When working with XBee networks, the following related documents are helpful:

n For complete XBee module settings and their descriptions, and discussions of XBee network
concepts, see the XBee/XBee-PRO® ZB RF Modules User Guide.

n The Digi Remote Manager User Guide.

Configure XBee Networks page in Remote Manager
You can use the XBee Networks page in Remote Manager to manage all the XBee nodes in your
inventory.
The Digi Remote Manager User Guide describes the settings and operations that you can perform from
the XBee Networks pages and menus.

1. Log into Remote Manager.

2. Click the Device Management tab.

3. Click the XBee Networks menu. The XBee Networks page appears.

4. Display the Properties page for the selected XBee node using one of the following methods:
n Double-click an XBee node on the XBee Networks page.

n Right-click the node and then select Properties.

n Click the node and then click the Properties button on the toolbar. If you select multiple
devices, a Properties page opens for each device that you selected.

5. Click Basic and complete the fields. The basic settings control the basic operation of the XBee
module in the XBee network. See the AT commands topic in the XBee/XBee-PRO® S2C Zigbee®

RF Module User Guide for more information about the settings on this page.

6. Click Advanced and complete the fields. The advanced radio settings control the behavior of
the XBee module at a more detailed level. See the AT commands topic in the XBee/XBee-PRO®
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http://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
http://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
http://www.digi.com/resources/documentation/digidocs/PDFs/90000976.pdf
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://remotemanager.digi.com/
https://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm#Containers/cont_at_cmds.htm%3FTocPath%3DAT%2520commands|_____0
https://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
https://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
https://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm#Containers/cont_at_cmds.htm%3FTocPath%3DAT%2520commands|_____0
https://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
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S2C Zigbee® RF Module User Guide for more information about the settings on this page.

7. Complete the fields and click Save to save your changes.

Configure XBee network settings in the web interface
The XBee Configuration page in the XBee Industrial Gateway web interface allows you to configure
each of the XBee devices joined to your network.

1. Access and log into the web interface.

2. Click Configuration > XBee Network. The XBee Configuration page appears.

3. Click XBee Devices and complete the fields. See XBee Configuration page for more
information.

4. Click the Node ID, Network Address, or Extended Address field for an XBee node. The Device
Details page appears.

5. Complete the fields under each of the following sections on the Device Details page. See
Device Details page for more information.

o Addressing Settings

o Radio Settings

o Network Settings

o Serial Settings

o Input/Output Settings

6. Repeat steps 3 and 4 for each additional XBee node.

7. Complete the fields under Network Settings and click Apply to save your changes.

XBee Configuration page
The XBee Configuration page in the XBee Industrial Gateway web interface allows you to configure
each of the XBee devices joined to your network.

XBee Devices section
This section provides information on the XBee RF modules on your local XBee Industrial Gateway and
on remote XBee devices.

XBee Device on the Gateway section
This section shows current settings for the XBee RF module in XBee Industrial Gateway. The displayed
XBee RF module information includes:

n Node ID: A descriptive, user-friendly name of your choice for the device. The Node ID is a 20-
byte printable ASCII string that allows for referencing devices by names rather than their
physical addresses.

n Network Address: The 16-bit network address for the device.

n Extended Address: A unique static 64-bit address for the device.

n Node Type: The node type for the device, or role it plays in the XBee network. The possible
roles are coordinator, router, or end device.

https://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
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n Product Type: A description of the product type for the node, such as “XBee Industrial
Gateway.”

To display more information on the XBee RF module on XBee Industrial Gateway, click the Node ID,
Network Address, or Extended Address field. The Device Details page appears. See Device Details
page for more information.

Remote XBee Devices section
This section shows information on the remote XBee RF modules in your XBee network, or nodes. Each
node displays information on the Node ID, Network Address, Extended Address, Node Type, and
Product Type.
Devices that appear in the list that are known to the gateway. The list accumulates known devices
over time. To find new devices, click Discover XBee Devices. Devices that respond to this query will
appear in list as a known device.
To clear the list of known devices and discover new devices, click Clear list before discovery. In this
instance, only devices that responded to the active discovery will appear in the list on completion of
the device discovery operation.

OTA Firmware Update Setup section
This section displays settings for updating firmware on the XBee RF modules on remote XBee devices
or nodes. This type of firmware update is known as an OTA firmware update. For more information,
see XBee network OTA firmware updates.

OTA Firmware Update section
This section displays the status of the OTA firmware updates that were configured on the OTA
Firmware Update page. For more information, see OTA Firmware Update page.

Device Details page
To display the Device Details page, click the Node ID, Network Address, or Extended Address field
for an XBee node. The Device Details page displays configuration information for the XBee RF module
on the gateway or nodes.
The Return to Network View link in the upper-right corner of the page returns you to the XBee
Configuration page and displays the XBee Devices in a ZigBee network.
The Device Details page is organized by key groupings of parameters, or radio settings. The settings
and information displayed on the page can vary by XBee modules, whether the XBee modules are on
XBee Industrial Gateway or on nodes, and whether the XBee module supports various parameters.
Common parameters include the PAN ID, firmware and hardware versions, and the device type
identifier. In the XBee®/XBee-PRO® ZB RF Modules Product Manual, settings are referred to by their AT
command name, which is in parentheses on the settings on the following pages; for example, ID, SC,
NJ, EE, SP.
The details shown on Device Details page are similar to the configuration options you will find in
XCTU. XBee Industrial Gateway allows you to read and configure the settings of your XBee network
nodes remotely.

n Network Settings allows you to configure the basic elements of a ZigBee network, including
the Extended PAN ID used for starting or joining a network, and other parameters used for
starting or joining a network.

n Addressing Settings allows you to configure the addressing and routing behavior for the XBee
module in a ZigBee network.

https://www.digi.com/resources/documentation/digidocs/PDFs/90000976.pdf
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n Radio Settings allows you to control the security, sleep mode, and RF serial interfacing for the
XBee RF module.

n Serial Settings allows you to configure the serial interfacing parameters for the XBee RF
module. This section appears for remote nodes only. These settings must match the serial
interface for the device attached to the XBee serial port that you are configuring.

n Input/Output Settings allows you to configure the I/O parameters for the XBee RF module.
This section appears for remote nodes only. The I/O Pin Settings section shows the pin
settings for the XBee RF module. For detailed description of these pin settings, see the Product

Manual for the XBee or XBee-PRO RF module in your product.

n For the I/O Pin Settings, the Pull-up/down Direction (PD) parameter appears when the
device supports this feature. If the device has the Pull-up/down Direction (PD) parameter,
the title for the fifth table header in the display is Pull up/down, otherwise the title is Pull up.

Device Status page
The Device Status page displays status information for a node. The parameters displayed on the page
vary based on the capabilities supported by the node's XBee module. Common parameters include the
PAN ID, firmware and hardware versions, and the device type identifier. For a detailed description of
these parameters, see the XBee/XBee-PRO ZigBee RF Module User Guide for the XBee or XBee-PRO RF
module in your product. The Refresh button refreshes the display of status parameters.

Device Operations page
The Device Operations page allows you to perform several tasks on nodes. The operations displayed
depend on the network type and node type.
The Identify Device operation causes the node to flash its association LED for a specified amount of
time. Use this operation when locating a node among a large array of nodes. Specify the amount of
time and click Identify Device.
The Reset Device operation allows you to choose one of the reset device operations for all nodes
except the gateway:

n Software Reset: A software reset resets the device. If you modified the scan channels or PAN
ID since the last reset, a network reset occurs. The XBee module performs this operation by
executing the AT command FR.

n Network Reset: A network reset will cause the device to reset its network configuration
information, reset, and rejoin a network. This operation is performed in the XBee module by
executing the AT command NR=0.

CAUTION! The node may no longer be accessible from this gateway after a
network reset.

The Backup and Restore Configuration operation allows you to save a backup file of the XBee
RF module configuration settings for nodes and restore the configuration settings if the need arises.

https://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm


Configure XBee network settings XBee network OTA firmware updates

Digi XBee Industrial Gateway 145

n Backup: The Backup operation saves the node’s XBee RF module configuration settings to a
file. The resulting backup file is a .pro file that is compatible with the XCTU configuration tool.
This means that you can save or load backup files from the XBee RF module using XCTU as well
as the gateway’s command line or web interfaces.

n Choose File: Provide the path to the backup file with the .pro extension.

n Restore: The Restore operation sets the node’s XBee RF module configuration settings to
those in the specified .pro file.

CAUTION! A restore operation may cause the device to reset its network
information, reset, and rejoin a network. It may no longer be accessible from this
gateway.

XBee network OTA firmware updates
The XBee Industrial Gateway firmware supports an OTA (Over the Air) firmware update in the XBee
network nodes. As XBee networks can involve a large number of nodes, Digi provides a way to
automatically schedule XBee Industrial Gateway firmware updates and manage firmware files.
OTA firmware update files are available for downloading from the Digi Support site. Go to the
firmware update page for the type of XBee ZigBee modules that you want to update.

n XBee modules prior to XBee 3: The firmware files will have the .ebl extension.

n XBee 3 modules: The firmware files may have an .ota or .otb extension.

Note XBee 3 Zigbee OTA updates (firmware and filesystem) are supported only on XBee Gateway
firmware 3.2.30.9 and newer.

Update the XBee network node firmware (OTA updates) from
Remote Manager
You must enable OTA (Over the Air) firmware updates on the device and download the firmware
before you can apply the firmware update to the device.

Step 1: Download the firmware
Download the appropriate firmware from the XBee Industrial Gateway product support page.

Step 2: Disable OTA Firmware updates on a device
To ensure that the firmware completely loads onto the device, you should disable automatic
OTA updates.

1. Log in to Remote Manager.

2. Click the Device Management tab.

3. Select the device on which you want to disable OTA firmware updates and automatic firmware
updates.

4. Right-click on the selected device and choose Properties.

http://www.digi.com/support
https://www.digi.com/products/embedded-systems/digi-xbee/digi-xbee-gateways/xbee-industrial-gateway
https://remotemanager.digi.com/login.do
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5. Choose Advanced Configuration > XBee.

6. Disable the OTA firmware updates setting by selecting the Off option.

7. Disable the Automatic OTA updates setting by selecting the Off option.

8. Click Save to save the changes.

Step 3: Apply the firmware update
1. Log in to Remote Manager.

2. Click the Device Management tab.

3. Select one or more devices from the device list that you want to apply firmware updates to,
right-click, and select Firmware > Update XBee Node Firmware.

4. Type or browse to the file name containing the firmware update.

5. Click Update Firmware. The XBee Industrial Gateway or XBee node reboots automatically
after the firmware is downloaded to the device.

Step 4: Enable OTA Firmware updates on a device
Before you can perform an OTA firmware update, you must enable that option.

1. Log in to Remote Manager.

2. Click the Device Management tab.

3. Select the device on which you want to enable OTA firmware updates and automatic firmware
updates.

4. Right-click on the selected device and choose Properties.

5. Choose Advanced Configuration > XBee.

6. Enable the OTA firmware updates setting by selecting the On option.

7. Enable the Automatic OTA updates setting by selecting the On option.

8. Click Save to save the changes.

OTA Firmware Update Setup page
You can use the OTA Firmware Update Setup page in the web interface to enable automatic
firmware updates, uploading XBee Industrial Gateway firmware image files, and management of XBee
Industrial Gateway firmware files.
The settings in the following sections control how gateway XBee firmware updates are performed:
Update Settings section

n Enable over the air firmware updates: Enable firmware updates on remote nodes over the
XBee network. Firmware updates use a background process to query remote nodes for their
current firmware version, and update their firmware from files stored on the gateway. By
disabling this process, you can suspend firmware updates. You may want to suspend updates if
the update process interferes with applications using the network.

https://remotemanager.digi.com/login.do
https://remotemanager.digi.com/login.do
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n Automatically update nodes to the latest firmware version: When a node reports its
firmware version, and a newer version of firmware is available on the gateway, schedule a
firmware update without user action. Use this option to automatically update nodes as they
join the network. If you do not select this option, you can manually schedule firmware updates
from the Firmware Update Status page.

n Stop automatic updates if an update error occurs: If an error occurs while updating a node,
suspend further updates of other nodes. You can resume updates by clicking Apply on this
page.

Upload Files section
This section controls the upload XBee Industrial Gateway firmware files to the gateway. These files
contain the firmware image used to update nodes on the XBee network. You can upload multiple files,
where each contains a different firmware type and version. Firmware files may have the extension
.ebl, .ota or .otb depending on the type of node you're attempting to update.
Click Browse to select a firmware file and then click Upload.
Manage Files section
This section lists the firmware files uploaded to the Digi device, along with their type and version
number. You can remove these files from the gateway after all nodes have been updated. To delete
firmware files, select the check box next to each firmware file that you want to delete and then click
Delete.

OTA Firmware Update page
The OTA Firmware Update page in the web interface displays the status of XBee Industrial Gateway
firmware updates for nodes, and allows you to update selected nodes with a specified firmware file.
This page lists all nodes on the XBee network, along with their current firmware update status.
The gateway firmware update log is xbee.log.

n Show all | Coordinators | Routers | End devices filter buttons: Use these buttons to filter the
list of XBee nodes.

n Click to update buttons: Updates the selected XBee node with the selected firmware. Click
the UPDATE button to start the update process.

n XBee Node: The Extended Address for the XBee node.

n Current Firmware: The current firmware file level loaded on the XBee node.

n Target firmware: The firmware to be loaded on the XBee node.

n Role: The role of the XBee node in an XBee/ZigBee network.
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n Status: The firmware update status of the node. The possible values are as follows:
l Unknown: The current firmware version has not yet been read from the node, or cannot be

read from the node.

l Up to date: The node is running the latest firmware version available on the gateway.

l Available: A newer version of firmware is available on the gateway. Select the node and
click Update to schedule an update. Schedule an update using the XBee fw_update
command or the Configuration > XBee Network > OTA Firmware Update Status page on
the web interface.

l Scheduled: A firmware update is scheduled to be performed on this node.

l Updating: A firmware update is currently running on this node.

l Updated: A successful firmware update has been performed on this node.

l Complete: The node has rejoined the network after a successful firmware update.

l Canceled: A firmware update for this node was canceled by the user. Select the node and
click Update to restart the update.

l Error: A firmware update on this node has failed. Select the node and click Update to retry
the update. Schedule an update using the XBee fw_update command or the
Configuration > XBee Network > OTA Firmware Update Status page on the web
interface.

Update the XBee node firmware (OTA updates) from the web
interface
To perform OTA firmware updates from the web interface:

1. Download the appropriate firmware file from Digi.

2. Access and log into the web interface.

3. Click Configuration > XBee Network. The XBee Configuration page appears.

4. Click OTA Firmware Update Setup. The OTA Firmware Update Setup page appears.

5. Click Choose File and browse to the firmware update file. You can upload multiple files, each
containing a different firmware type needed by nodes on the network.

6. Click Upload.

Note For non-XBee 3 modules: The XBee network cannot access a remote node while the
remote node is updating its firmware. XBee Industrial Gateway cannot access the XBee
module while the XBee module is updating its firmware.

Note that you can also schedule and monitor updates of individual nodes on the OTA Firmware
Update Status page. Each scheduled update runs in the background on one node at a time.
See OTA Firmware Update Setup page for more information.
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OTA firmware update troubleshooting

XBee 3 Zigbee: Missed # replies in a row from client
The message "Missed # replies in a row from client" (or a similar one) appears in the xbee.log if an
attempt to update an XBee 3 Zigbee device fails.
Resolution

1. Verify that the link quality along the route between the gateway node and the client node is
good. If it is not good and multiple packets are dropped, the update process will fail.

2. Verify the client node is not configured for a very short awake time, or an asynchronous or
cyclic sleep with a sleep period longer than a few seconds. Sleep periods longer than 15
seconds or very short wake times may cause communication timeouts and failures.
Reconfigure the client node to either not sleep, or to use more update-friendly timings. See the
Digi XBee 3 Zigbee User Guide for more information.

XBee Industrial Gateway network Python log file
When you connect XBee node devices with your XBee Industrial Gateway using the XBee Industrial
Gateway Python application, device data for your XBee network is captured in the form of events in
one of the log files, python.log, for XBee Industrial Gateway.
You can access the python.log file through the web interface of your XBee Industrial Gateway or from
Remote Manager.
For more information, see View your device data.

XBee network troubleshooting resources
For help troubleshooting issues with your XBee network, see the following resources:

n See the XBee ZigBee Cloud Kit Getting Started Guide for general information about the XBee
network.

n See the Join your XBee node to your XBee Gateway section in the XBee ZigBee Cloud Kit Getting

Started Guide for specific information about joining an XBee node to the XBee Gateway.

https://www.digi.com/resources/documentation/digidocs/90001539/
http://www.digi.com/resources/documentation/Digidocs/90001503/Default.htm
https://www.digi.com/resources/documentation/Digidocs/90001503/Default.htm#concepts/c-joining-xbee-node-xbee-gateway.htm%3FTocPath%3DTroubleshoot%2520your%2520XBee%2520ZigBee%2520Cloud%2520Kit|Joining%2520your%2520XBee%2520node%2520to%2520your%2520XBee%2520Gateway|_____0
http://www.digi.com/resources/documentation/Digidocs/90001503/Default.htm
http://www.digi.com/resources/documentation/Digidocs/90001503/Default.htm


Learn more about XBee Industrial Gateway

This section walks you through the steps required to connect your XBee Industrial Gateway with XBee
hardware other than that in the XBee ZigBee Cloud Kit. The steps show you how to configure XBee
Industrial Gateway and XBee nodes, explore the use of data I/O in your network solution, and view
data from nodes.

Default startup and operation behaviors for XBee Industrial
Gateway

XBee Industrial Gateway has several default startup and operation behaviors that compare against
your own network's setup and operation. If these behaviors present any conflicts with your network's
configuration and operation, you may need to adjust the settings in either XBee Industrial Gateway or
you network.
Consider the following questions when deploying XBee Industrial Gateway in all types of networks:

n How many devices are you deploying, and for what purposes?

n Are you deploying one, several, or many devices over an Ethernet or cellular network?

Default behavior regarding NTP time server access
By default, XBee Industrial Gateway accesses an NTP time server to establish its date and time.
Access to an NTP server is required, and there is a default server.
The first time an XBee Industrial Gateway powers on and goes through its startup sequence, it needs
to access the NTP time server to set its time, and then attempt to connect to Remote Manager. This
first-time connection step could take up to five minutes or longer on cellular networks.
For XBee Industrial Gateway Ethernet models, you can specify up to four NTP servers to be used as
upstream servers in synchronizing time. The default settings for the four NTP server settings are as
follows:

NTP server 1: 0.time.devicecloud.com
NTP server 2: 0.time.devicecloud.com
NTP server 3: 0.idigi.pool.ntp.org
NTP server 4: 1.idigi.pool.ntp.org

XBee Industrial Gateway cellular models use the top NTP Server entry (NTP Server 1), and leave the
others blank. XBee Industrial Gateway checks all NTP servers that are configured for time-drift.
Having four NTP time servers configured for an XBee Industrial Gateway cellular device would result in
excessive and unnecessary cellular usage.
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Default behavior regarding DNS
A DNS (Domain Name System) server is an Internet service that resolves domain names into IP
addresses. Name resolution is important when connecting to Remote Manager, as the servers are
provided as fully-qualified domain names.
XBee Industrial Gateway is capable of using up to three DNS servers. Up to two of these slots may be
filled with DNS servers from dynamic IP assignment sources, leaving at least one slot always available
for static DNS server configuration. A reasonable default is supplied for one static DNS server, but this
default may not be appropriate for all customer networks.

Firewalls and required open ports
When you use a firewall to filter outbound traffic, XBee Industrial Gateway requires these network
ports to be open for proper operation:

n UDP port 53, for DNS

n UDP port 123, for NTP

n TCP port 3199, for Remote Manager

Deploying devices over a network
If deploying one to many XBee Industrial Gateway devices over a network, consider the network's
topology and behavior: Does the network's setup and any configuration in place present any barriers
to connectivity given the default behaviors listed above? Considerations for each supported network
type are in the following configuration settings topics. If you have a network that does not match the
default behaviors for supported network types stated below, you need to adjust settings as described
in Configure XBee Industrial Gateway.

Connect the XBee nodes to XBee Industrial Gateway
This section explains how to configure the parameters for forming XBee networks on both XBee
Industrial Gateway and XBee nodes. To connect XBee nodes to XBee Industrial Gateway:

1. Before you begin, download XCTU from www.digi.com/xctu. XCTU allows you to configure XBee
RF modules.

2. Configure XBee Industrial Gateway as a coordinator.

3. Join nodes to the coordinator.

4. Verify that XBee nodes are joined to the coordinator.

If you are unfamiliar with XBee networks, see XBee/XBee-PRO ZigBee RF Modules User Guide for
information about the key concepts.

Configure XBee Industrial Gateway as a coordinator
The first device to configure with a custom PAN ID is the coordinator, which in this case is XBee
Industrial Gateway. To change the PAN ID of your XBee Industrial Gateway:

1. From a web browser, open the Home page of your XBee Industrial Gateway ZigBee and go to
the XBee Network section from the left menu.

2. Select the local XBee device for XBee Industrial Gateway. The XBee Configuration page
appears.

http://www.digi.com/xctu
https://www.digi.com/resources/documentation/digidocs/PDFs/90000976.pdf
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3. From the XBee Configuration page, open the Network Settings section.

4. Type your custom PAN ID value in the Extended PAN ID (ID) field. Remember this value, as you
will configure the other ZigBee nodes on the network with the same one.

5. If XBee Industrial Gateway uses XBee security parameters, set the XBee security parameters
(EE, EO, NK, KY) as needed. The security parameters are as follows:

n EE: Enable or disable security in the network.

n EO: Set the security policy for the network.

n NK: Set the network security key for the network. If set to 0 (default), the device will
use a random network security key.

n KY: Set the trust center link key for the network. If set to 0 (default), the device will use
a random network security key.

For more information on these parameters, see the XBee/XBee-PRO® S2C Zigbee® RF Modules

User Guide.

6. Click Apply to save the changes in the device. After applying the changes, the coordinator
initializes the ZigBee network with the new PAN ID.

Join nodes to the coordinator
Use XCTU to set PAN ID and encryption settings to match those on the coordinator (XBee Industrial
Gateway).
Next, configure your ZigBee nodes to connect to XBee Industrial Gateway. To do this, you will set the
PAN ID for the ZigBee nodes to match the PAN ID you just set in XBee Industrial Gateway. Because the
ZigBee are not yet joined to the network that your XBee Industrial Gateway (coordinator) initialized,
you cannot configure them using the XBee Industrial Gateway web interface. Instead, you must use
the XCTU software.
You must install XCTU on your computer. If you do not have XCTU installed, go to www.digi.com/xctu
to download and install XCTU.
Once you have XCTU installed, follow these steps to change the PAN ID of an XBee ZigBee module:

1. Attach the XBee ZigBee node to an XBee development board, and connect it to your computer
using a USB cable.

2. Open XCTU and add the XBee node that is connected to your computer to the list of radio
modules.

3. Select the node and wait for the application to read all its settings.

4. Under the Networking category, replace the current PAN ID with your custom PAN ID in the ID
PAN ID field.

5. Once you have changed the setting, click the Write radio settings button to save the new PAN
ID in the XBee module.

http://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
http://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
https://www.digi.com/products/xbee-rf-solutions/xctu-software/xctu
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6. If XBee Industrial Gateway uses XBee security parameters, set the XBee security parameters
(EE, EO, NK, KY) as needed. The security parameters are as follows:

n EE: Enable or disable security in the network.

n EO: Set the security policy for the network.

n NK: Set the network security key for the network. If set to 0 (default), the device will
use a random network security key.

n KY: Set the trust center link key for the network. If set to 0 (default), the device will use
a random network security key.

For more information on these parameters, see the XBee/XBee-PRO® S2C Zigbee® RF Modules

User Guide.

7. Click the Write radio settings button to save the new security settings in the XBee module. As
soon as you save the new PAN ID in the XBee RF module, the module tries to connect to the
ZigBee network that has the PAN ID that you configured.

Verify that XBee nodes are joined to the coordinator
To verify that your XBee ZigBee module has successfully joined the ZigBee network:

1. Make sure XBee Industrial Gateway is powered on. Make sure the XBee ZigBee node is
mounted on the development board and that the development board is powered on.

2. From a web browser, open the Home page of your XBee Industrial Gateway.

3. Under Configuration, click XBee Network. The XBee Configuration page appears.

4. Below the Remote XBee Devices table, select the Clear list before discovery check box and
click the Discover XBee Devices button.

5. After some seconds the Remote XBee Devices table displays your XBee ZigBee node.

http://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
http://www.digi.com/resources/documentation/DigiDocs/90002002/default.htm
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6. If the XBee node does not appear in the Remote XBee Devices table, use XCTU to view the AI
(Association Indicator) for the node.

The Association Indicator is located under the Diagnostic Commands settings for the node. The
Association Indicator shows the node’s current association status, which points to the reason
the node is not connecting to the coordinator. There are several possible values for the
Association Indicator, all described in the XBee/XBee-PRO ZigBee RF Modules User Guide (Digi
part number 90000976). This document is available from the XBee/XBee-PRO S2C ZigBee
Modules page. A value of 0 means the node has successfully joined or started a network.

The following image shows an example of an Association indicator for a node:

Configure the ZigBee network addressing parameters for XBee
nodes

This section describes how to configure the ZigBee network addressing parameters for your XBee
nodes.
If you are unfamiliar with XBee networks, see XBee/XBee-PRO ZigBee RF Modules User Guide for
information about the key concepts.

Key addressing parameters
XBee RF modules have many parameters. In many cases, the default setting for a parameter is
sufficient. For successful transmission of data from XBee nodes and use with the XBee Industrial
Gateway Python application, there are several key addressing parameters that must be set on XBee
nodes:

n Destination Address (DH/DL): These parameters set the high and low portions of the
destination address for data.

n ZigBee Destination Endpoint (DE): This parameter sets the ZigBee Destination Endpoint. The
Python application running on XBee Industrial Gateway that interacts with XBee nodes
assumes a Destination Endpoint of 0xe8.

n ZigBee Cluster ID (Cl): Sets the ZigBee Cluster ID. The Python application running on XBee
Industrial Gateway that interacts with XBee nodes assumes a ZigBee Cluster ID of 0x11.

http://www.digi.com/support/productdetail?pid=4838
http://www.digi.com/support/productdetail?pid=4838
https://www.digi.com/resources/documentation/digidocs/PDFs/90000976.pdf
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Configure the network addressing parameters
To configure the network addressing parameters:

1. Access the XBee Industrial Gateway web interface.

2. Click XBee Configuration > Remote XBee Devices list.

3. Click a node under Remote XBee Devices. The XBee Configuration settings for the node
appear.

4. Click Addressing Settings.

5. In the Destination Address (DH/DL) field, set the destination address for the data to be sent
from the node.

6. Under ZigBee Addressing, set the ZigBee Destination Endpoint (DE) to 0xe8 and set the
ZigBee Cluster ID (CI) parameter to 0x11.

7. Click Apply to save your changes.

Explore serial I/O
If you want your XBee nodes to send data over a serial line, you must configure the XBee nodes for
your ZigBee network to transmit serial data.
If you are unfamiliar with I/O configuration, the following resources will help you understand key
concepts:

n Building Wireless Sensor Networks

n XBee/XBee-PRO ZB RF Modules User Guide

n About programming provides several examples of I/O configuration

Understand the process for configuring the serial I/O
The process for configuring the serial I/O requires that you:

1. Assess the device hardware connected to the XBee nodes. What kind of equipment is it? What
type of information is it measuring, collecting, and transmitting?

This assessment will help you identify the I/O connections and pins needed, and later to set
serial I/O parameters appropriate for the attached hardware.

2. Understand what must be configured for the XBee module on the XBee nodes and attached
hardware to work with the XBee Industrial Gateway Python application.

XBee RF modules have many parameters. In many cases, the default setting for a parameter is
sufficient. For successful serial transmission of data from XBee nodes and use with the XBee
Industrial Gateway Python application, the Serial settings for the XBee node must match the
serial settings for the device attached to the XBee serial port that you are configuring.

3. Configure XBee serial parameters.

http://shop.oreilly.com/product/9780596807740.do
http://www.digi.com/resources/documentation/digidocs/PDFs/90000976.pdf
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Example serial I/O configuration
The following example demonstrates the serial I/O configuration process, between an XBee RF
module and connected device.

n Serial data input uses pin 3 (DIN).

n serial data output uses pin 2 (DOUT).

n For this example, we assume that the hardware uses the default serial settings: 9600 bps, 8
data bits, no parity, 1 stop bit.

Configure the serial I/O
To configure the serial I/O:

1. Access the XBee Industrial Gateway web interface.

2. Click XBee Configuration > Remote XBee Devices.

3. Click a node under Remote XBee Devices. The XBee Configuration settings for the node
appear.

4. Click Serial Settings. These settings configure the serial connection between the XBee node
and attached hardware, that is, XBee pin 2 (DOUT) and pin 3 (DIN).

Note that the CTS Flow Control (D7) and RTS Flow Control (D6) and any changes to them are
also displayed on the I/O Pin Settings page under DIO6 and DIO7.

5. Make sure the serial settings displayed match those the hardware attached to the XBee node
through the serial port.

6. If changes are required, click Apply to save your changes. Note that the examples shown in
this task use the default serial settings. If the default serial settings match the hardware
connected to the XBee node, you can leave the page as-is.
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Explore digital and analog I/O
If you want your XBee nodes to transmit digital or analog data, you must configure the XBee nodes for
your ZigBee network to transmit digital or analog I/O.
If you are unfamiliar with I/O configuration, the following resources will help you understand key
concepts:

n Digi knowledge base article: Digital and analog sampling using XBee radios

n Building Wireless Sensor Networks by Rob Faludi

n XBee/XBee-PRO ZB RF Modules User Guide

n About programming provides several examples of I/O configuration

Understand the process for digital and analog I/O
The process for configuring digital or analog I/O requires that you:

1. Assess the device hardware connected to the XBee nodes. What kind of equipment is it? What
type of information is it measuring, collecting, and transmitting?

This assessment will help you identify the I/O connections and pins needed, and later to set
serial I/O parameters appropriate for the attached hardware.

http://knowledge.digi.com/articles/Knowledge_Base_Article/Digital-and-analog-sampling-using-XBee-radios
http://shop.oreilly.com/product/9780596807740.do
http://www.digi.com/resources/documentation/digidocs/PDFs/90000976.pdf
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2. Understand what must be configured for the XBee module on the XBee nodes and attached
hardware to work with the XBee Industrial Gateway Python application.

The XBee Industrial Gateway Python application resides on XBee Industrial Gateway. It allows
you to connect your XBee modules to Remote Manager, enabling them to upload data to
Remote Manager and receive remote text and commands. The XBee Industrial Gateway
Python application is already installed in your XBee Industrial Gateway device and
automatically starts when the gateway is initialized.

XBee RF modules have many parameters. In many cases, the default setting for a parameter is
sufficient. For successful transmission of data from XBee nodes and use with the XBee
Industrial Gateway Python application, there are several key parameters that must be set on
XBee nodes:

n Destination Address (DH/DL): These parameters set the high and low portions of the
destination address for data.

n ZigBee Destination Endpoint (DE): This parameter sets the ZigBee Destination
Endpoint. The Python application running on XBee Industrial Gateway that interacts
with XBee nodes assumes a Destination Endpoint of 0xe8.

n ZigBee Cluster ID (Cl): Sets the ZigBee Cluster ID. The Python application running on
XBee Industrial Gateway that interacts with XBee nodes assumes a ZigBee Cluster ID of
0x11.

n Serial settings: These settings must match those for the device attached to the XBee
serial port that you are configuring.

n Input/Output settings: These settings configure the input and output functions for
pins on the XBee RF module. These settings are known as I/O pin settings. XBee RF
module pins have fixed or reserved settings for many pins, and several user-
configurable pins.

There are additional I/O parameters that you can set for I/O, including the sampling
methods and sampling rates for digital and analog input.

3. Configure XBee addressing parameters on the XBee nodes.

4. If you are using a serial connection between the XBee nodes and their attached hardware,
configure XBee serial parameters.

5. Configure I/O settings for the pins of each node's XBee RF module. This step includes several
substeps:

a. Configure digital I/O.

b. Configure analog I/O.

c. Configure Parameters that set the I/O sampling rate. There are different
parameters for digital and analog I/O.
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Example digital or analog I/O configuration
The following example demonstrates the digital or analog I/O configuration process, between an XBee
RF module and connected device.

n Digital I/O: The following pins are used for digital I/O:
l Digital data input from the connected device uses Pin 19 (AD1 / DIO1). This digital input

uses the pullup resistor and change detection sampling.

l Digital data output to the connected device. uses Pin 18 (AD2 / DIO2).

n Analog I/O: 1 analog input from the connected device is on pin 17 (AD3 / DIO3), with a sampling
rate of every 30 seconds.

Configure the digital or analog I/O
To configure the digital or analog I/O:

1. Access the XBee Industrial Gateway web interface.

2. Click XBee Configuration > Remote XBee Devices.

3. Click a node under Remote XBee Devices. The XBee Configuration settings page for the
node appears.
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4. Click Input/Output Settings. The I/O Settings table displays the DIO settings for the pins on
the XBee node.

The fields in the I/O Settings table are as follows:
n DIO: Digital input/output.

n AT: The AT command associated with the DIO line.

n Functions: Additional functions associated with this DIO beyond digital I/O.

n Setting: The input or output function to be assigned to this DIO. The numbers in
parentheses (2, 4, 5, etc) represent the value for each setting on the AT command
associated with the setting.
l Disabled: I/O for this DIO is disabled.

l Analog Input: Sets the DIO to analog input.

l Digital Input: Sets the DIO to digital input.

l Digital Output, Low: Sets the DIO to digital output and outputs a low signal.

l Digital Output, High: Sets the DIO to digital output and outputs a high signal.

n The Pull up and Detect check boxes are used when a DIO line is set to Digital Input.
These settings are used to determine how sampling of digital input is handled.
l Pull up: Enables the pull-up resistor. Sets or clears the appropriate bit of the PR

parameter, described below.

l Detect: Sets or clears the appropriate bit of the IC parameter, described below.

5. Set DIO1 to Digital Input. Check both the Pullup and Detect check boxes. More information
on these options is in step 5.

6. Set DIO3 to Set DIO3 to Analog Input.



Learn more about XBee Industrial Gateway View your device data

Digi XBee Industrial Gateway 161

7. Configure the settings for sampling. There are several parameters for sampling methods and
rates:

Pull up Resistor Enable (PR) / Pull up check box for each DIO:

DIO Change Detect (IC) / Detect check box for each DIO: For digital input, the DIO Change
Detect (IC) parameter configures the pin for digital sampling. You can configure modules to
transmit a data sample immediately whenever a monitored digital IO pin changes state. The IC
command is a bitmask that you can use to set which digital IO lines should be monitored for a
state change. If one or more bits in IC is set, an IO sample will be transmitted as soon as a
state change is observed in one of the monitored digital IO lines. Change detection samples
are transmitted to the 64-bit address specified by the Destination Address (DH/DL)
parameters.

Set this parameter to 0x2 to use. Each time the value of the specified DIO changes, the XBee
module sends an XBee packet with the new value of the DIO to XBee Industrial Gateway.
Another way to enable the IC parameter is to enable the Detect check box for a DIO set to
digital input.

I/O Sampling Rate (IR): For analog input, the I/O Sampling Rate (IR) parameter sets the
sampling rate, in milliseconds.

Periodic sampling allows an XBee/XBee-PRO module to take an IO sample and transmit it to a
remote device at a periodic rate. If IR is set to 0, periodic sampling is disabled. For all other
values of IR, data will be sampled after the number of milliseconds set by the IR parameter
have elapsed and then transmitted to a remote device. The Destination Address (DH/DL)
parameters determine the destination address of the IO samples. You can set DH and DL set to
0 to transmit to the coordinator, or to the 64-bit address of the remote device (SH and SL
parameters). Only devices running API firmware can send IO data samples out their UART.
Devices running AT firmware will discard received IO data samples. A sleeping end device will
transmit periodic IO samples at the IR rate until the ST timer expires and the device can
resume sleeping.

The sampling setting for analog input must be configured. We want to sample the analog input
every 30 minutes, or 30000 milliseconds. Under I/O settings, in the I/O Sampling Rate (IR)
setting, type 30000.

8. Click Apply to save your changes.

View your device data
After you configure the I/O for your XBee nodes, you can view the data from the nodes. The device
data is available for viewing from the following locations:

n View device data from Remote Manager

n View device data and events in the Python log file for XBee Industrial Gateway
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View device data from Remote Manager
The nodes in your XBee network report data back to the gateway. This information appears on the
Data Services tab in Remote Manager.

1. From Remote Manager, go to Data Services > Data Files > Data Streams. If you completed the
steps in Set up XBee Industrial Gateway summary, several data streams are available. The
data streams of your XBee ZigBee will be similar to:

00000000-00000000-00409DFF-FF123456/xbee.digitalIn/

[00:13:A2:00:11:22:33:44]!/DIO4

2. Type the device ID for your XBee Industrial Gateway in the data stream search box in the
upper-right side of the data stream view to locate the data streams for your XBee Industrial
Gateway. For example:

00000000-00000000-00409DFF-FF123456

View device data and events in the Python log file for XBee
Industrial Gateway
The XBee Industrial Gateway Python application resides on XBee Industrial Gateway. Its key functions
include connecting your XBee modules to Remote Manager, enabling uploads of data to Remote
Manager, and receiving remote text and commands. The XBee Industrial Gateway Python application
is installed in your XBee Industrial Gateway device and automatically starts when the gateway
initializes. When you use the XBee Industrial Gateway Python application, device data for your XBee
network is captured in the form of events in one of the XBee Industrial Gateway log files, python.log.
Events that may be of note include:

n Serial or I/O data arriving from an XBee node on your RF network

n An RCI command received from Remote Manager

n Attempts to upload data to Data Streams in Remote Manager

n Errors and warnings during execution for debugging and diagnostics

The python.log file may be accessed through the XBee Industrial Gateway web interface or from
Remote Manager.
See XBee Industrial Gateway Python application and Remote Manager for more information.

View the Python log file
To view the log file, choose one of the following options:

n From Remote Manager, the system log is a file maintained in the file system of the device. To
retrieve it, use the File Management capabilities in Remote Manager. See the Digi Remote

Manager User Guide if you need help.

https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
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n From the XBee Industrial Gateway web interface:

1. Access the XBee Industrial Gateway web interface.

2. Click Administration > System Log.

3. Select python.log from the Select Log File menu and click the Get File button.

4. Click the Refresh button to ensure the data is up to date.

System message Python log file example
The following example shows a python.log file for an XBee Industrial Gateway with an XBee node
configured for digital and analog I/O:

In this log file excerpt:

n These lines show that the XBee Industrial Gateway Python application has started up
successfully:

Aug 4 19:44:06 (none) local7.info pylog: 2014-08-04 19:44:06,804 INFO

root: XBGW App Version: 1.1.0b2

Aug 4 19:44:06 (none) local7.info pylog: 2014-08-04 19:44:06,860 INFO

xbgw.xbee.manager: Initializing XBeeEventManager

Aug 4 19:44:06 (none) local7.info pylog: 2014-08-04 19:44:06,934 INFO

xbgw.xbee.ddo_manager: Initializing DDOEventManager

Aug 4 19:44:07 (none) local7.info pylog: 2014-08-04 19:44:07,030 INFO

xbgw.reporting.device_cloud: Initializing DeviceCloudReporter

Aug 4 19:44:07 (none) local7.info pylog: 2014-08-04 19:44:07,072 INFO

xbgw.command.rci: RCICommandProcessor initialized
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n These lines show that the XBee Industrial Gateway Python application received a digital I/O
reading:

Aug 4 19:47:38 (none) local7.info pylog: 2014-08-04 19:47:38,524 DEBUG

xbgw.xbee.manager: Received frame from ('[00:13:A2:00:40:9F:6F:CB]!', 0xe8,

0xc105, 0x92, 0x1, 0x0)

Aug 4 19:47:38 (none) local7.info pylog: 2014-08-04 19:47:38,542 DEBUG

xbgw.xbee.manager: Processing IO sample from pin DIO12

Aug 4 19:47:38 (none) local7.info pylog: 2014-08-04 19:47:38,554 DEBUG

xbgw.xbee.manager: Digital reading: 0

n These lines show that the XBee Industrial Gateway Python application received an analog I/O
reading:

Aug 4 19:47:38 (none) local7.info pylog: 2014-08-04 19:47:38,610 DEBUG

xbgw.xbee.manager: Processing IO sample from pin AD3

Aug 4 19:47:38 (none) local7.info pylog: 2014-08-04 19:47:38,620 DEBUG

xbgw.xbee.manager: Analog data: 780
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n These lines show that data points, in this case, six data points, were uploaded to Remote
Manager:

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,207 INFO

xbgw.reporting.device_cloud: Uploading data to DataPoint/upload.csv

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,220 DEBUG

xbgw.reporting.device_cloud: stream_id: xbee.analog/

[00:13:A2:00:40:9F:6F:CB]!/AD1

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,230 DEBUG

xbgw.reporting.device_cloud: data: ('xbee.analog/

[00:13:A2:00:40:9F:6F:CB]!/AD1', 426, {})

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,238 DEBUG

xbgw.reporting.device_cloud: stream_id: xbee.digitalIn/

[00:13:A2:00:40:9F:6F:CB]!/DIO4

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,245 DEBUG

xbgw.reporting.device_cloud: data: ('xbee.digitalIn/

[00:13:A2:00:40:9F:6F:CB]!/DIO4', True, {})

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,263 DEBUG

xbgw.reporting.device_cloud: stream_id: xbee.digitalIn/

[00:13:A2:00:40:9F:6F:CB]!/DIO6

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,280 DEBUG

xbgw.reporting.device_cloud: data: ('xbee.digitalIn/

[00:13:A2:00:40:9F:6F:CB]!/DIO6', True, {})

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,288 DEBUG

xbgw.reporting.device_cloud: stream_id: xbee.digitalIn/

[00:13:A2:00:40:9F:6F:CB]!/DIO7

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,300 DEBUG

xbgw.reporting.device_cloud: data: ('xbee.digitalIn/

[00:13:A2:00:40:9F:6F:CB]!/DIO7', False, {})

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,308 DEBUG

xbgw.reporting.device_cloud: stream_id: xbee.digitalIn/

[00:13:A2:00:40:9F:6F:CB]!/DIO0

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,324 DEBUG

xbgw.reporting.device_cloud: data: ('xbee.digitalIn/

[00:13:A2:00:40:9F:6F:CB]!/DIO0', True, {})

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,332 DEBUG

xbgw.reporting.device_cloud: stream_id: xbee.analog/

[00:13:A2:00:40:9F:6F:CB]!/AD2

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,337 DEBUG

xbgw.reporting.device_cloud: data: ('xbee.analog/

[00:13:A2:00:40:9F:6F:CB]!/AD2', 780, {})

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,354 INFO
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xbgw.reporting.device_cloud: Upload contains 6 datapoints

Aug 4 19:47:44 (none) local7.info pylog: 2014-08-04 19:47:44,526 INFO

xbgw.reporting.device_cloud: Upload successful



Hardware

This section provides hardware information for XBee Industrial Gateway.
For hardware specifications, refer to the XBee Industrial Gateway data sheet.

Ethernet model

Item Description More information

1 Power supply Connect the power supply to the gateway. See
Connect the Ethernet hardware.

2 Ethernet connector f you are using an Ethernet connection in
addition to the cellular, connect one end of the
Ethernet cable to your gateway and the other
to a live Ethernet jack. See Connect the
Ethernet hardware.

3 XBee antenna See XBee Industrial Gateway antennas.

4 LED status indicators See XBee Industrial Gateway LED descriptions.
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https://www.digi.com/products/networking/gateways/xbee-industrial-gateway#specifications
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Cellular model

Item Description More information

1 Power supply Connect the power supply to the gateway. See
Connect the cellular hardware.

2 Ethernet connector If you are using an Ethernet connection in
addition to the cellular, connect one end of the
Ethernet cable to your gateway and the other
to a live Ethernet jack. See Connect the cellular
hardware.

3 XBee antenna See see the Digi XBee antenna product page.

4 Antenna See XBee Industrial Gateway antennas.

5 SIM card installation See Set up and configure a cellular device.

6 LED status indicators See XBee Industrial Gateway LED descriptions.

XBee Industrial Gateway antennas
The XBee Industrial Gateway device uses only external antennas. Connecting antenna(s) to the device
is required.

Note The XBee Industrial Gateway does not have internal antennas.

n Ethernet model: Requires one external XBee antenna.
l For information about purchasing an XBee antenna, see the Digi XBee antenna product

page.

n Cellular model: Requires one external XBee and, depending on the device variant, either one
or two external Cellular antennas.
l For information about purchasing an XBee antenna, see the Digi XBee antenna product

page.

l For information about purchasing a Cellular antenna, see the Digi Cellular antenna product
page.

https://www.digi.com/products/models/a24-hasm-450
https://www.digi.com/products/models/a24-hasm-450
https://www.digi.com/products/models/a24-hasm-450
https://www.digi.com/products/models/a24-hasm-450
https://www.digi.com/products/models/a24-hasm-450
https://www.digi.com/products/models/76000926
https://www.digi.com/products/models/76000926
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XBee Industrial Gateway LED descriptions
XBee Industrial Gateway has several LEDs. See the sections below for a description of the LEDs and
their default behavior.

n Signal strength LED (cellular models only)

n Network LED

n XBee LED

n Power LED

You can control some of the LEDs programmatically. See LED control for a description of how to
control the LEDs on XBee Industrial Gateway.
See Troubleshooting LEDs for troubleshooting information.

LEDs for the Cellular model LEDs for the Ethernet model

Signal strength LED (cellular models only)
The signal strength LED is identified by this icon:

Color and blink
pattern Description

OFF (dark) No (or very poor) cellular signal. Moving device to a better location is
recommended.

Solid yellow Adequate cellular signal. This signal strength works for most applications.

Solid green Good cellular signal.

Network LED
The signal strength LED is identified by this icon:
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Note The Network LED remains dark during the initial boot of the device. All diagnosis related to this
LED must be done after the device has been running for at least 60 seconds.

Color and blink
pattern Description

OFF XBee Industrial Gateway operating system is not yet running.

Blinking yellow, slow Operating system is running, but no network link is established or IP
address assigned.

Solid yellow An IP address has been assigned to XBee Industrial Gateway.

Blinking yellow - fast
(1 blink per second)

A network issue has occurred. The two most common Remote Manager
connectivity-related reasons for this state are:

1. XBee Industrial Gateway cannot connect to a DNS server to resolve
the Remote Manager server address. See Cannot connect to DNS
server to resolve the Remote Manager server address.

2. XBee Industrial Gateway cannot connect to an NTP time server to
get the correct time. See Cannot connect to NTP time server to get
correct time.

Solid yellow to
blinking green

XBee Industrial Gateway is attempting a connection to a Remote Manager
server.

Blinking green - fast
(1 blink per second)

Remote Manager server found and XBee Industrial Gateway is undergoing
authentication.

Solid green XBee Industrial Gateway is connected to the Remote Manager server.

XBee LED
The XBee LED indicates the network connection status of the XBee RF module in XBee Industrial
Gateway to a ZigBee wireless network. At startup, if you are not yet deploying your device in a ZigBee
network, you can ignore this LED and its states. Once XBee Industrial Gateway is deployed in a ZigBee
network, the XBee LED behavior varies depending on whether XBee Industrial Gateway acts as a
coordinator or a router. For information on changing XBee Industrial Gateway from a coordinator to a
router, see the topic Join XBee Industrial Gateway to an existing ZigBee network.
The Power LED is identified by this icon:
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Note The XBee LED remains dark during the initial boot of the device. All diagnosis related to this LED
must be done after the device has been running for at least 60 seconds.

Color and blink pattern Description

Solid green The XBee RF module has not started or joined a network.

Blinking green The XBee RF module has started or joined a network.

Power LED
The Power LED is identified by this icon:

Color and blink
pattern Description

OFF (dark) No power.

Solid blue Device is powered. This state does not indicate that the device is fully
operational. The Network LED and its states convey such information.

Restore XBee Industrial Gateway factory defaults
You can restore the device to its factory default configuration. This action clears any configuration
settings you may have entered through the supported device interfaces.
On the front of the XBee Industrial Gateway device, press the pin in the pin hole for ten seconds to
return the device settings to factory defaults.

Maximum power and frequency bands
This section contains the maximum power and frequency bands for the XBee Industrial Gateway.



Hardware Maximum power and frequency bands

Digi XBee Industrial Gateway 172

XBee Industrial Gateway: Cellular

Maximum power Operating mode

Up to 2 W GSM/GPRS

Up to 0.5 W WCDMA/EDGE/LTE

Up to 6.3 mW XBee

Up to 63 mW XBee-Pro

XBee Industrial Gateway: Ethernet

Maximum power Associated frequencies

6.3 mW 5 MHz channel spacing, beginning at 2405 MHz and ending at
2480 MHz



Troubleshoot your XBee Industrial Gateway

This section covers common issues and troubleshooting information for your XBee Industrial Gateway.

XBee Industrial Gateway system log
The System Message Log File Browser is a diagnostic tool that allows you to view entries in a system
log file. The default log that appears in the System Message Log File Browser is eventlog.txt. This file
is the primary message log for informational notices.
Logging is always enabled and is not user-configurable. When the Digi device operates in an
unexpected manner, you can send the log entries to Digi for analysis by Technical Support and
Engineers. The event log cannot be turned off, so that Digi receives an accurate view of all aspects of
the operation of the device.
For information about how to access the System Message Log File Browser, see Display the system
log.

XBee Industrial Gateway log files and contents
By default, logging on XBee Industrial Gateway is always enabled and is not user-configurable. When a
Digi device operates in an unexpected manner, you can send the log entries to Digi for analysis by
Technical Support and Engineers. The event log cannot be turned off, so that Digi receives an accurate
view of all aspects of the operation of the device.
The Message Filters for Displayed Log File section on the System Message Log File Browser page
in the web interface displays available message filters for each log file type. These message filters
allow Digi Technical Support to quickly find areas of interest in the log file when working with
customers on troubleshooting issues.
Use the available XBee Industrial Gateway system log files to debugging specific parts of the system.
These log files have a fixed size and roll over when they reach their maximum size. When the file rolls
over, a single secondary file is created with the extension .0. For example, when eventlog.txt rolls
over, the older data will be stored in eventlog.txt.0. When both files reach their maximum size, the
older file will be overwritten. Also note that many of the log files are stored in persistent memory
(flash) and will contain data from multiple boots. The only exception is xbee.log, which is stored in a
RAM disk.

Log File Contents

eventlog.txt
eventlog.txt.0

High-level system messages.
For more information, see XBee Industrial Gateway system log.
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Log File Contents

python.log
python.log.0

Captures any output of Python programs that were started with the
Python auto-start feature.
For more information, see XBee Industrial Gateway network Python log
file.

xbee.log
xbee.log.0

A non-persistent log file that records all XBee traffic.

digi.log
digi.log.0

For internal use only. This file may be requested by the Digi technical
support group.
For more information, see OTA Firmware Update page.

sef.log
sef.log.0

For internal use only.

messages.log
messages.log.0

For internal use only.

cherokee.log
cherokee.log.0

For internal use only. This log contains a line for each request handled
by the Cherokee web server in XBee Industrial Gateway.

Display the system log
To display the system log, choose one of the following options:
From Remote Manager

Note There is no browser interface for system logs in the Remote Manager interface. The following
instructions explain how to navigate from the Remote Manager interface to the WEB/logging
directory on the XBee Industrial Gateway system to access the system logs.

1. Click File Management under Administration. The File Management page appears.

2. Click /WEB and go to the WEB/logging directory on the XBee Industrial Gateway system.

3. Select the log files (for example, digi.log, xbee.log, python.log, and so on) and then click the
Download button to download the logs to your computer.

Note that the downloaded files are read-only. For more information on log files, see XBee
Industrial Gateway log files and contents.

From the XBee Industrial Gateway web interface

Note The System Message Log File Browser is a diagnostic tool that allows you to view entries in a
system log file. The default log that appears in the System Message Log File Browser is eventlog.txt.
This file is the primary message log for informational notices.

1. Access the XBee Industrial Gateway web interface

2. Click Administration > System Log. The System Message Log File Browser appears.

3. Type the name of the log file in the Select Log File field or select a log file from the Select Log
File drop-down list and click Get File. The contents of the log file appear under Messages in
Log File.
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4. To filter the contents of the log file under Messages in Log File, select the check box next
message filter that you want to use under Message Filters for Displayed Log File.

Cellular connection issues
This information in this section covers common issues and troubleshooting information for your
cellular connection.

Common configuring issues
Some common causes for XBee Industrial Gateway failing to connect include:

Probable cause Resolution

No or poor cellular signal. Check signal strength in the Signal strength, Signal level, and Signal
quality fields.

n In Remote Manager, click System information > Mobile
information.

n In the web interface, click Administration > Mobile Status.
Move the device to a different location and recheck the signal quality.

n Placement can drastically increase the signal strength of a
cellular connection. Often times, moving the gateway closer to
an exterior window or to another location within the facility can
result in optimum reception. Another way of increasing
throughput is by physically placing the gateway on the roof of
the building, in an environmentally safe enclosure with proper
moisture and lightning protection.

n If you are unable to relocate the gateway, note that the
optimum physical orientation is for the gateway to be standing
on its edge, with the Ethernet port and power plug pointing
towards the nearest cell tower.

SIM is not properly
installed.

Check the following pages of the web interface for the following fields
and messages:

n The Configuration > Mobile Connectivity page SIM PIN
status, the SIM IMSI, and SIM ICCID. If these items are blank,
the SIM is not properly installed.

n On the Administration > Mobile Status page: SIM not ready.

n On the Administration > System Log > Event Log, the message
Connection error: SIM not ready.

Ensure that a SIM is properly installed.
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Probable cause Resolution

Unit does not have proper
APN entered

If the proper APN is not entered, the device will not receive a Mobile IP
Address. On the Administration > Mobile Status page, the following
status information displays:

n Mobile IP Address is blank.

n SIM IMSI, SIM ICCID and SIM PIN status fields will display
values.

n Signal strength is good.

n Connection error displays Not registered. For LTE, the error
may be Not registered or Network call error.

n Disconnect reason displays as Carrier loss for GSM. For LTE,
the Carrier loss reason may not display.

n Connections and Connection errors are incrementing.
Ensure that the proper APN is entered by verifying the name entered
under Configuration > Mobile Connectivity and possibly verifying with
the provider. Also, the provider may require a user name and password.

Troubleshooting XBee Industrial Gateway GSM and LTE devices
If your device fails to connect to the cellular network, log in to the XBee Industrial Gateway web
interface, and click Mobile Status under Administration. From the Mobile Status page, you can
examine the connection status.
Following are some key fields on the Mobile Status page. For a description of all status fields, see
Mobile Status page.

n SIM PIN status

n SIM slot index

n Signal strength

n Signal level

n Signal quality

n Registration status

n Mobile network code

n Mobile country code

n Connection state

n Connection error

n Disconnect reason

n IP address

n DNS primary address



Troubleshoot your XBee Industrial Gateway Python error: “certificate verify failed”

Digi XBee Industrial Gateway 177

Python error: “certificate verify failed”
XBee Industrial Gateway firmware with version 3.2.32 or later includes an updated version of Python
2.7 (version 2.7.18), which has changed the default behavior of the ssl module to be more strict in
verifying the authenticity of server certificates in SSL/TLS connections. This change improves security
for applications. An explanation of this change can be found in PEP 476.
Due to filesystem space limitations, XBee Industrial Gateway does not ship with a built-in set of known
CA certificates (otherwise known as a “trust store”). As a result, when a Python application running on
firmware version 3.2.32 or newer attempts to establish an SSL/TLS connection, a “certificate verify
failed” error may be generated.

Solutions
There are two ways to avoid this error:
Option 1: Load and use a Certificate Authority for the host you are connecting to
This method updates your Python application code to validate the identity of the remote server.

1. Identify and download the public CA signing certificate associated with the SSL/TLS server that
your application connects to.

n For public IoT “cloud” services, information about this certificate is typically provided by
the service vendor.

n For non-public hosts, such as services running only locally on your network, contact your
network administrator for assistance.

2. Load the CA signing certificate file onto the XBee Industrial Gateway’s filesystem, at a location
such as /WEB/python/ca.crt.

3. Update your Python application code to use that CA certificate to verify the authenticity of the
server certificate.

n Example code for doing this with a bare SSL/TLS connection can be found in the Python
ssl module documentation.

n For other libraries, check the library documentation for information on specifying a
server certificate.

4. Deploy the updated Python application code to the XBee Industrial Gateway.

Option 2: Use the older, more permissive behavior

This option is NOT RECOMMENDED for security reasons.
Do not follow these instructions unless you fully understand the security implications.

This method reverts the Python application process to the older, more permissive behavior of Python
2.7.8 and earlier, where server certificates are not verified by default. Using this option means you
are choosing to make your application less secure, and vulnerable to connecting to malicious
hosts.
To revert to the more permissive SSL/TLS behavior, add the following lines of code to your
application’s primary file:

ssl._https_verify_certificates(False)

Or, if your application has only one SSL/TLS connection, an SSLContext which does not perform server
verification can be created using:

https://www.python.org/dev/peps/pep-0476
https://docs.python.org/2.7/library/ssl.html#client-side-operation
https://docs.python.org/2.7/library/ssl.html#client-side-operation
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ssl._create_unverified_context()

How to make use of this context is dependent on the application code or libraries being used.

Device Discovery troubleshooting tips
If your device does not appear in the list of devices after using the Digi Device Discovery utility,
consider the following tips.

n Firewalls: Verify that any software firewalls (common examples are Windows Firewall and
most popular Anti-Virus software) are disabled. These can block the discovery process. Also,
any physical firewall will almost certainly block the discovery process as well.

n Routers or switches: Is there a router between the computer running the discovery utility and
the Digi device itself? Normally, routers will block the discovery process. If possible remove
them and use a hub instead. If there is a switch in between this may or may not be a problem.
Occasionally they are configured to block the discovery traffic. If you are unsure use a hub or a
direct Ethernet cable connection. If the port on your Router/Switch/Hub is bad, try a different
port.

n Cabling: If nothing else works, try using a direct crossover Ethernet cable directly between the
computer and the Digi device. Another option is to try another Ethernet cable.

n Ethernet LED: Check the Ethernet Link LED on the Digi device. Is the light solid? If not, there is
not a valid network connection and it will not be possible to discover the device.

n Network adapters: Verify that you enabled the correct network adapter and disabled all other
network adapters. If more than one network adapter is enabled, the discovery process will fail.

n Change Digi device: If you have second Digi device, try discovering it instead to see if you have
the same problem. Though it may not solve your original discovery problem, it should provide
you with some additional troubleshooting clues.

Rebooting XBee Industrial Gateway
You can reboot XBee Industrial Gateway as needed. Note that XBee Industrial Gateway reboots itself
if you make changes to the configuration that require a reboot to activate those changes.
To reboot XBee Industrial Gateway, choose one of the following options:

n From Remote Manager, right-click the XBee Industrial Gateway device and select More >
Reboot.

n From the web interface, click Administration > Reboot.

Wait approximately one minute for the reboot to complete.

Troubleshooting LEDs
The table below contains troubleshooting information for the LEDs on the device.
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Symptom Potential Cause Resolution

Power LED is not lit. Power is not applied. Ensure that the power supply is properly
connected to a power source and the device.

Hardware failure. In the unlikely case of hardware failure, first
physically remove power and reconnect. If the
LEDs remain dark, return the device to Digi for
RMA.

XBee LED is not lit.1 If device is configured
as a coordinator, this
may indicate a
coordinator hardware
failure

Return the device to Digi for RMA.

Network LED is not lit.2 Hardware failure. Return the device to Digi for RMA.

Network LED is flashing
yellow slower than once
per second.

No Ethernet link. Attach an Ethernet cable.

Network LED is flashing
yellow faster than twice
per second.

DHCP server not
responding.

If no DHCP server is present on the network,
use a tool with integrated Digi Device Discovery
to assign a static IP address.

Device may not have network connectivity to
the DHCP server, despite having link to a hub or
switch. Check with network administrator.

1XBee LEDs remain dark during the initial boot of the device. All diagnosis related to these LEDs must be done
after the device has been running for at least 60 seconds.
2Network LEDs remain dark during the initial boot of the device. All diagnosis related to these LEDs must be
done after the device has been running for at least 60 seconds.
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Symptom Potential Cause Resolution

Network LED alternates
between yellow and
green.

Unable to resolve
Remote Manager
server name. Verify
DNS server settings
with network
administrator.

Network failure between the device and the
DNS server. Check with network administrator.
See additional information on resolving this
issue below.

Unable to contact
Remote Manager
server.

Verify Remote Manager server name in
settings.

Verify proxy settings with device and with your
network administrator.

Network failure
between the device
and the Remote
Manager server.

Check with your network administrator.

Device unable to
authenticate Remote
Manager server.

Verify NTP server settings with network
administrator. The device must have the
correct time in order to verify the security
certificate presented by the Remote Manager
server. The supported means to synchronize
time in the device is via NTP. See Cannot
connect to NTP time server to get correct time
for additional information on resolving this
issue.

Verify Remote Manager server name in
settings.

Firewalls and required open ports
When you use a firewall to filter outbound traffic, XBee Industrial Gateway requires these network
ports to be open for proper operation:

n UDP port 53, for DNS

n UDP port 123, for NTP

n TCP port 3199, for Remote Manager

Cannot connect to NTP time server to get correct time
XBee Industrial Gateway requires access to an NTP server to set its date and time. Normally the
device receives the date and time automatically from the Remote Manager server.
Contact your network administrator or ISP to find out if they have blocked access or have set up other
NTP servers on their network. To change the NTP server through the web interface, go to Time
settings.
For NTP to operate correctly, UDP port 123 needs to be open.
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Cannot connect to DNS server to resolve the Remote Manager
server address

XBee Industrial Gateway requires a DNS server to resolve the Remote Manager server IP address.
Normally the device receives the DNS server information automatically from the DHCP server on your
Internet router, but if your router does not provide the information, you may need to set it manually.
When this error occurs, the system log will display the following message:

Error resolving 'fully qualified domain name': No address associated with
nodename (EAI_NODATA)

The device usually gets the DNS server from the DHCP server. If a DNS server is not supplied from
your DHCP server, usually because it is not configured to supply it, XBee Industrial Gateway uses the
default Google Public DNS server (address 8.8.8.8). If use of this default DNS server is not desired, you
can manually configure a DNS server using the XBee Industrial Gateway web interface or RCI
configuration interface.
It is most effective to fix the DHCP server to provide the correct networking parameters to the device.
Otherwise, you can manually set the device's network configuration. To set the DNS server manually,
go to Ethernet IP network settings. Contact your network administrator or ISP to get the DNS server
information.
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